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1 Program Installation

1.1 Introduction

 

Welcome to Consultant Front Office, the revolutionary software for building and organizing your direct
sales business. It combines state-of-the-art technologies for strengthening customer follow-up, with
streamlined financial recordkeeping and tax preparation, all tailored specifically to the direct selling
business model. Whether you're tracking customers, or crunching tax forms, this program will save
you time and make you money - we guarantee it.

 

The pictures contained in this User Guide generally reflect the Professional Edition of the program. If
you have either the Basic or Standard Edition, some of the features you see in these pictures may
not appear in your program. Whenever possible, the applicability of different features to the different
editions of the program is stated in the accompanying text.

 

Main Toolbar

The main navigation toolbar in the program contains the following buttons:
Home
Contacts
Calendar (Standard and Professional Editions only)
Tasks (Standard and Professional Editions only)
Team (Standard and Professional Editions only)
Goals (Professional Editions only)
Income and Expenses
Sales
Purchases
Vehicles (Standard and Professional Editions only)
Home Office (Professional Editions only)
Taxes
Reports

These buttons are used to move between the different program modules. All of the financial
functions should be thought of from your personal perspective, so that

Sales = Your Sales (use this screen when you sell to one of your customers)
Purchases = Your Purchases (use this screen when you purchase from your company)

Using "Help"

You can learn a lot about the program using the extensive built-in Help files. Keep in mind that
you can get "context-sensitive" Help on many specific items while the program is running,

simply by clicking on the Help buttons  found throughout the program.

Training

We offer video tutorials as well as free teleconference and webinar trainings. Click on the 
Training option on the Help menu to see all of our training options.

 

Technical Support
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We have an extensive online Knowledgebase and a ticket support system that allows you to
view all of your previous tickets and our responses. Click on the Support option on the Help
menu to access our online Support Center.

 

Thanks!

MLM Software Solutions Inc. thanks you for your support and wishes you incredible success in your
business.

1.2 License Agreement

 

Software License Agreement

This is a legal document, which is an agreement between you, the end user, and MLM Software
Solutions Inc. By installing, copying, or otherwise using the Software, you agree to be bound by the
terms of this Software License Agreement.

MLM Software Solutions Inc. retains title to and ownership of all proprietary rights with respect to the
Software, and all copies and portions thereof. This License does not constitute a sale of the Software
or any portion or copy of it.
 

Software License

This License allows you, the end-user, to install and use the Software on one, two or three computers
that are under your direct personal control, so long as the Software is used only for your business:

by you

by your spouse

by your employees

by a member of a legal business partnership of which you are a member

You are allowed to make a single copy of the Software media for backup purposes only. The Software
and all printed material accompanying the Software are protected by United States and International
copyright laws and treaties. If you copy the Software for backup purposes you must reproduce the
trademark and copyright notices that were on the original copy.
 

Restrictions

You may not distribute copies of the Software to others. You may not reverse engineer, de-compile,
disassemble or otherwise change and / or reduce the Software to any other form.
 

Technical Support

All registered users of the Software are entitled to complimentary technical support via the Internet
provided that:

it has been one year or less since they originally purchased a License to the software OR
it has been one year or less since they purchased a License to a newer version of the software

License upgrades that do not result in a change in the major version number of the program do not
entitle the purchaser to an additional period of technical support. Transfers of ownership do not result
in an additional period of technical support and are also subject to the additional restrictions listed
below.
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Transferring Ownership

The license for your most recent version of Consultant Front Office may be permanently transferred
(given or sold) to another person, as long as you delete the program from your computer and destroy
any copies of the installation media that you have made for backup purposes. Only the license for
your most recent version can be transferred. Transfer privileges for each software License terminate
upon your purchase of a newer version of the software. MLM Software Solutions, Inc. reserves the
right to charge a fee for registering users who obtain their License by transfer from another License
owner.
 

Termination

This License is effective until terminated. This License will terminate immediately without notice from
MLM Software Solutions Inc. if you fail to comply with any provision of this License. Upon termination
you must destroy the Software and all copies thereof. You may terminate this License at any time by
destroying the Software and all copies thereof.
 

Limited Warranty

MLM Software Solutions Inc. will replace defective media or fully refund your purchase price for the
Software for a period of thirty (30) days from the date of purchase. Refunds and replacement media
may be obtained by sending an email to service@mlmsoftwaresolutions.com

The Software is provided "as is" without warranty of any kind, express or implied, by statute or
otherwise, regarding its fitness for any purpose, its quality, its merchantability, or otherwise. In no
event shall MLM Software Solutions Inc. or its developers, directors, officers, employees, or affiliates
be liable for direct, incidental, indirect, special or consequential damages (including damages for loss
of business profits, business interruption, loss of business information and the like) resulting from any
defect in the Software or its documentation or arising out of the use of or inability to use the Software,
even if MLM Software Solutions Inc. or a MLM Software Solutions Inc. affiliate has been advised of the
possibility of such damage.
 

Copyright

The Software and all printed material accompanying the Software are copyrighted with all rights
reserved by MLM Software Solutions Inc. Under United States copyright laws, the Software and its
accompanying documentation may not be copied, in whole or in part, except in the normal use of the
Software or to make a copy for backup purposes only. Duplication of this Software for any other
reason is a federal crime and is hereby expressly forbidden.

1.3 System Requirements

 
Windows 98 or higher (Windows XP or higher recommended - the software is fully compatible with
Windows Vista and Windows 7)
Pentium 133 / AMD K-6 or higher (Pentium III or higher recommended)
100 MB of hard drive space
512 MB of RAM (1024 MB recommended)
1024 x 768 screen resolution or higher
Email requires Internet Explorer 6.0 or higher

1.4 Installation and Startup

 

The software can usually be installed by simply inserting the CD into your CD drive and then following

mailto:service@mlmsoftwaresolutions.com
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the on-screen prompts. In general, it is recommended that you accept the default installation
settings, unless you are an advanced user. For Windows 2000 and Windows XP installations it is
highly recommended that the program be installed using an account which has administrative
privileges. Administrative privileges are required when installing on Windows Vista, Windows 7 (or
higher).
 

BASIC INSTALLATION

To install the program using an installation CD just do the following.
1. Close down all applications that are currently open on your computer. These applications

generally have icons in the system tray next to the Windows Start button. Simply select
each icon one at a time, save your work, and then close the application.

2. Insert the Consultant Front Office CD into your computer’s CD drive. The installation
program should start automatically. If it does not, click on the Windows Start button and
then on Run. Use the Browse button to locate the file "Setup.exe" on the CD then click on
OK.

3. Once the installation process is complete, use the Desktop icon or the Consultant Front
Office 10.0 option on the Start button Programs menu to start the program.

UPGRADING FROM AN EARLIER VERSION

To upgrade from an earlier version of the software follow the steps shown above under BASIC
INSTALLATION. It is not necessary for the earlier version to be installed on the computer where
you are installing the upgrade. If an earlier version is present when the upgrade is installed, all
of your data will be copied into the newer program and will be present the first time you open it.
If the earlier version is not installed on the same computer where you are installing the upgrade,
use the Backup and Restore functions on the File menu (Backing Up Your Data) to bring your
data into the new installation.

Once you have opened the new program and confirmed that your data was properly transferred,
you should delete the icon on your Windows Desktop that was used to open the older version, if
it was not deleted automatically during the upgrade process. This will ensure that you don’t
accidentally go into the older program and make additional entries. If you choose, you can use
Windows Add/Remove programs to remove the older version from your computer. Removing a
previous version can sometimes remove system files that are needed by the newer version as
well. If this happens, you will generally encounter an Error 339 message when trying to start the
program. In this event, just reinstall the newer version using your installation CD to restore the
missing files. Reinstalling the program will not harm your data and will ensure that all of the files
needed by the program are correctly installed and registered. 

WHAT TO DO IF… THE PROGRAM EXTENDS BEYOND THE EDGE OF THE SCREEN

Consultant Front Office requires a minimum screen resolution of 1024 x 768. If the program
is not completely visible on the screen when running, first try double clicking on the border
at the top to "maximize" the program so that it fills your entire screen. If it is still not completely
visible then do the following:

1. Place your mouse over a spot on your Windows Desktop where there are no program icons
and right click.

2. Left click on Properties to open the Display Properties window.
3. Click on the Settings tab in the Display Properties window.
4. Look near the bottom of the Display Properties window for either "Screen Area" or "Screen

Resolution". If this setting says "640 x 480" or "800 x 600", move the slider to the right until
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it says "1024 x 768" or higher.
5. Click on OK to save this change.
6. Windows will then ask you to confirm that you want to keep this setting. Click on Yes and

wait while your screen finishes adjusting to the new setting.

WHAT TO DO IF… THE PROGRAM APPEARS FUZZY AND THE TEXT IS HARD TO READ

1. Place your mouse over a spot on your Windows Desktop where there are no program icons and
right click.

2. Left click on Properties to open the Display Properties window.
3. Click on the Settings tab in the Display Properties window.
4. Look near the bottom of the Display Properties window for either "Colors" or "Color quality". If

this setting says "256 colors" or "Medium (16 bit)" change it to "High color (16 bit)" or "Highest
(32 bit)".

5. Click on the Advanced button and make sure that your font size is set to "96 dpi".
6. Click on OK (twice) to save any changes.

 

HOW TO… ELIMINATE A "READ-ONLY" WARNING ON WINDOWS XP

The software is designed to offer "read-only" status to additional users if the program’s
database is already in use in a networked setting, however, if you have Windows XP and get
this warning every time you try to start the program, check the following setting:

1. Right click on the icon you use to start the program.
2. Left click on Properties.
3. Left click on the Shortcut tab.
4. Left click on Advanced.
5. Un-check the box that reads Run with different credentials.
6. Click on OK to save the change.

1.5 Operating the Demo Version

 

If you are operating the demo version of the program, you will be presented with the following choices
each time you start the program:
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Run Demo Click on this button to run whichever Demo Type you have
selected in the Demo Type portion of the Program Licensing
window. Selecting different Demo Type options allows you to
compare the capabilities of the different editions of the program.
Click on the "More info..." link to view a feature-by-feature
comparison of the different program editions.

All demo programs are limited to 25 entries of each type (e.g.
Contacts, Income / Expenses, Sales etc.). Any entries made in
the demo program can be saved if you later choose to purchase
the software.
 

Purchase or
License

Click on this button to display the Program Licensing window
with links to our online ordering and Key Code request pages.
 

 

1.6 Business Setup

 

The first time you start the program after installing you will be presented with some or all of the
following windows. Whether or not these windows are displayed depends on how you are installing
the software (CD vs download) and the presence of company-specific information.

Upgrade Notification

This box is only displayed if there is an earlier version of the program installed on your
computer. Click OK to import the earlier version’s data or Cancel to proceed with a "clean"
installation.
 

Company-Specific Importing

Select the name of the company you distribute products for then click on OK to import product
and business information. If your company's name is not listed put a check in the "My
company is not listed here" checkbox and click on OK. To temporarily skip this option click on
Cancel. 

This option will continue to appear each time you start the program until you import a
company's information, check the "My company is not listed here" checkbox and click on OK,
or manually enter one or more products into the program. You can verify that company-specific
importing was successful by checking for your company's name next to the "Custom Edition"



Consultant Front Office Version 1118

© 2011 MLM Software Solutions, Inc.

entry in the About option on the Help menu.
 

Business Setup

Enter the name of the company you distribute products for then click on Done. If you are
installing from a CD containing company-specific business information, this box should already
contain the name of the company you distribute products for.

This entry can be changed from within the program using the Rename Business option on the
File menu. The program can keep records for up to three different companies. To start a new
"business" once your first business is set up, use the New Business option on the File menu.
 

Setup Wizard

The Setup Wizard assists you in setting your freight, tax and preference settings and in
entering your personal contact information. The wizard can be rerun at any time by clicking on
the Setup Wizard option on the Help menu.

 

 

Freight and Tax

For more information on freight and tax settings see your "ReadMe" file (if one is
available) or use the Help button in the Sales Settings window.
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Program Preferences

Select from the program's various preference options. For more information use the Help
button in the Preferences window.
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Owner Information

Enter your personal contact information. This program is not transmitted to MLM
Software Solutions but is used throughout the program and particularly when creating
invoices (see also Owner Information).
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1.7 Reinstalling the Software

 

Installing or uninstalling another Windows program from your computer can sometimes inadvertently
disturb a file that is required for Consultant Front Office to function properly. If you encounter Error
339 at program startup, saying that one or more files are "Missing or incorrectly registered", try
reinstalling Consultant Front Office using your installation CD. Reinstalling the program will not
disturb your data and should replace and re-register any missing file(s). You will also need to reinstall
the software if you upgrade from Windows 98 or ME to Windows XP and encounter an Error 7 –
Memory conflict problem.

 

In some cases users who have encountered Error 372 while trying to run the program have been able
to correct the problem by reinstalling the program and then rebooting their computer.



Part

II

Good Things to Know
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2 Good Things to Know

2.1 Viruses and Hard Drive Problems

 

If your computer catches a virus, has hard-drive problems, or has a software malfunction that cannot
be corrected, it is likely that you will be told to reformat your hard drive and reinstall Windows. Before
reformatting your hard drive and before you send it back to the manufacturer for repairs,
follow these instructions to make sure your data will be intact once you get your computer
problems resolved:

If your computer can still be started and if you can still get into Consultant Front Office, open the
program and perform a backup (Backup option on the File menu) onto a USB memory stick, or
back up to your hard drive and then copy the backup file onto a CD. For added protection when
using a CD, or if Consultant Front Office can no longer be started, make a copy of the entire
folder where the program is installed. The default installation folder for the program is:
 

Default installation folder:  C:\Program Files\CFO11.or C:\Program Files (x86)\CFO11
 

If your computer can no longer be started, locate a computer specialist in your area who knows
how to extract data from a hard drive, even if the hard drive is damaged or corrupted. This process
may cost you $100 or so but will save you much more than that in lost information and time. Have
the specialist extract the entire folder where the program is installed, which is typically:
C:\Program Files\CFO11. This will give you access to all of the program’s automatic backup files,
any of which can be used to restore your data onto a new or rebuilt computer. Automatic backup
files created by the program are stored in the following directory:
 

Automatic backup files:  C:\Program Files\CFO11\Backup Auto.or C:\Program Files (x86)\CFO11
\Backup Auto

 

Following these steps could well mean the difference between having all of your data and having to re-
enter all of your data. We have had several instances where hard drives were reformatted before the
owner realized that they had not gotten everything they needed off of it. Once the hard drive has been
reformatted, there is nothing we can do to help you if you do not have a valid backup file or a copy of
the folder in which the program is installed.

 

If you know that you will need to reformat your hard drive or send your computer back to
the manufacturer for repairs, please contact us first so we can help make sure you have
what you need before the drive gets reformatted. The best way to contact us is by clicking on
the Support option on the Help menu and submitting a support request ticket.

2.2 Program Updates

 

Program updates for each major version are available free of charge via the Updates option on the
Help menu. If this option does not work for you try using the Updates Link option on the Help menu
instead. To view a list of what  was changed in a program update click on the Release Notes option
on the Help menu.
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If you would like the program to automatically check for updates each time it’s started, click on the 
Preferences option on the Settings menu, and check the box that reads "Check for program
updates at startup".

 

You can determine exactly what version of the program you have installed by clicking on the About
option on the Help menu.

2.3 Program Customization

 

The program offers a number of customization options.

Most of the drop-down selection boxes in the program can be modified using the various options
on the Categories menu.

User-preferences can be specified using the Preferences option on the Settings menu.

"Grid" displays throughout the program, where data is presented in a table or tabular format, can
be sorted simply by clicking on a column heading in the display. Column sizes can be adjusted by
hovering over a column heading border until a split arrow cursor appears, then holding your mouse
button down and dragging the column to the desired width. Changes to these settings will be
remembered each time you close a window.

Options and Settings buttons on many of the main program screens allow you to edit settings
specifically related to that part of the program.

2.4 Backing Up Your Data

 

All of your data can be easily backed up using the Backup option on the File menu. Frequent
backups help to ensure the integrity of your data in the event of a virus, hard disk failure, or other
hardware or software problem. It is highly recommended that you perform backups regularly,
and particularly whenever you’ve made a significant number of new entries. The program will
automatically remind you to perform a backup each time you exit, if the Preferences option "Display
backup prompt when closing"  has been selected.
 

The Backup option on the File menu backs up all of the data in all of your active businesses, no
matter which business you have open when you perform the backup operation.
 

Data saved in a backup file can be restored back into the program using the Restore option on the
File menu. Using the Restore option replaces all of the data in the program with the data
contained in the backup file, overwriting any changes you may have made since the backup
file was created.

 
 

How To Have The Program Back Up Your Data Automatically

You can have the program create backup files for you automatically the first time it’s opened
each day using the Auto Backup Path option on the File menu. Set this path to a location
that is not on your main hard drive so that the backup files it contains will still be accessible if
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your hard drive fails. An external hard drive, secondary hard drive or a USB memory stick all will
work well with the Auto Backup Path function.

Each day when the program is first opened, it automatically creates a backup file containing all
of your data. When the Auto Backup Path option has been set, the program makes a copy of
the backup file and saves it to the location you have specified. This creates a comprehensive
library of daily backup files for you to use in the event that your computer or main hard drive
experiences a problem.
 

Tip: Windows does not generally allow programs to write data directly to a CD. If you
would like to back up to a CD, first perform a backup to your Windows Desktop,
then use your CD-writing software to copy the backup file from there onto the CD.
Alternatively, consider using a USB memory stick instead of a CD for storing your
data backup files since Windows can write directly to a memory stick.
 

Importa
nt:

Before relying on a backup file as your only means of restoring data it’s
recommended that you use the Verify Backup function on the File menu to
confirm the backup file’s integrity.

2.5 Transferring Data Between Computers

 To transfer all of your data from one computer to another, use the Backup and Restore functions on
the File menu as described below:

1. Perform a backup onto a USB memory stick or other removable media, using the Backup option
on the File menu on the first computer. You can also back up to your computer’s hard drive and
then email the backup file to the second computer.

2. Perform a restore, using the Restore option on the File menu on the second computer along with
the backup file created in Step 1.

The Restore function completely replaces all of the data in the program with the data in the backup
file, so be sure that you only make changes on one computer at a time when using this approach to
transfer your data. If your program is set up to sync to a handheld organizer make sure that you leave
the program open and perform a sync operation immediately after restoring data.

For information on the best way to handle reformatting of your computer after a virus or other problem
please see Viruses and Hard Drive Problems.

Data synchronization, which allows you to merge contact, team, income, expense, sale and
purchase information between two computers is available in the Professional Edition of the program.

2.6 What To Do If Your Spouse Is Also A Consultant

 

If you and your spouse are both distributors for the same company you will need to decide whether to
set up a single business for both of you or to set up separate businesses for each of you.
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If you are using the "Full-Inventory" edition of Consultant Front Office, it is strongly recommended
that you set up only one business to avoid having to keep the inventory from each of your businesses
completely separate.

If you are not using the "Full Inventory" edition of the program, then the decision hinges on your desire
to track contacts and finances separately. You may want to consult your tax advisor regarding this
before making a decision.

2.7 Networked Computers

 

Consultant Front Office is not "multi-user" software and should generally not be accessed by
multiple computers over a network. Opening the database from more than one computer at a
time will result in "read-only" status and the data seen by the "read-only" computers will not be
updated when changes are made on the primary machine.



Part
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3 Getting Started

3.1 How To Get Started

 

 In most cases, your motivation to learn the software will be:
Your wish to grow your business more quickly and efficiently AND / OR
Your desire to get paperwork organized and get your recordkeeping in shape

Here are some steps to help you get started with either (or both) of these objectives!

Building Your Business – Overview

1. Contact groups:  The key to setting up your contact database is to decide what Contact
Groups make the most sense for your business. Setting up your list of Groups before you
begin entering people into your software will make your database more useful along the
way. Decide what "groups" you would like to use to divide up your contact database, then
create those groups using the Contacts option on the Categories menu.

2. Entering contacts: Click on the Contacts button on the main toolbar then click on New.
Enter or import the people you would like to begin contacting on a regular basis (e.g.
prospects, reorder customers and potential hosts).

3. Targeting: Use the Filter, Search and Select buttons on the Contacts screen to target
specific groups of contacts for phone calls, mail-merge emails, printed communications and
address labels.

4. Communicating: Click on the mail-merge Email or Letters buttons on the Contacts
screen to create personalized templates for staying in touch with your various groups of
contacts.

5. Scheduling: Click on the Calendar and Tasks buttons on the main toolbar to schedule
your business activities. You can also keep track of the next appointment and task you
have for each of your contacts by entering them at the bottom of the Notes tab on the
Contacts screen.

6. Staying personal: As you connect with people, be sure to enter a few Notes on the
Contacts screen. This allows you to connect with people more personally the next time you
email or call.

Setting up Recordkeeping - Overview

See also - IRS Small Business Resources

                                  
1. Customers: Customer contact information can be entered in one of two ways. To add

contacts to your database without entering any sales information, click on the Contacts
button on the main toolbar then click on New. To enter customer information at the same
time you’re entering what they purchased (often the case) click on the Sales button on the
main toolbar then click on New, then click on the second ellipsis (…) button to the right of
the Customer box to display a "mini" Contacts screen.
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2. Events: Most financial transactions and any of your contact can be linked to an "event" for
filtering and reporting purposes. Events can be parties, craft shows, fundraisers etc., or any
other "connection" that exists between customers and their purchases. Linking entries to 
Events allows you to filter your database for customers and activities associated with that
Event. To create an Event, click on the Events option on the Categories menu then click
on New. To select an Event throughout the program click on the ellipis (…) button to the
right of the Event boxes, then highlight the Event and click on Select.

3. Purchases: Before entering your first purchase, click on the Contacts button on the main
toolbar, then click on New, and enter the company you sell products for into your contact
database so that you can select them as the Vendor in the Purchases window.
Purchases: Before entering your first purchase, click on the Contacts button on the main
toolbar, then click on New, and enter the company you sell products for into your contact
database so that you can select them as the Vendor in the Edit Purchases window.

4. Sales: If you’re entering sales from a party, fundraiser, craft show or other "event" that you
would like to be able to get reports on, you will want to create that Event in the program
prior to recording the sales. Customer information can be entered directly from the Edit
Sales screen using the second ellipsis (…) button to the right of the Customer box.
Checking the "Potential Host", "Booked Event" or "Potential Recruit" checkboxes on the 
Edit Sales screen automatically adds the customer to those contact Groups when the sale
is saved. If you use ProPay™ for credit card processing, you can upload your customers'
credit card payments to ProPay directly from this software, without ever having to go to the
ProPay website.

5. Income / Expenses: To enter income and expenses not directly tied to the purchase or
sale of products click on the Income / Expenses button on the main toolbar then click on
the Income or Expense button to add a new income or expense record.

Income: Your main source of income will be commissions, bonuses etc. that you
receive from the company you work with. If your company provides you with a 1099 at
the end of the year, you can enter the exact amount of income shown on the 1099 as a
single entry each year.  If you prefer, you can make an entry for each check or payment
you receive from your company throughout the year.

Expenses: The fastest and easiest way to enter your expenses (office supplies,
software etc.) is to put all of your business purchases on a dedicated credit card, then
enter those expenses directly from your statement at the end of each month. 

6. Personal Use, Product Samples, Product Loans and Product Trades: Personal use,
product samples, product loans and products trades can be entered using the menus at the
top of the program (Loans and Trades can only be found in the Standard and Professional
Editions). These menus are provided for your convenience to help you determine what
products you used for these purposes at the end of the year. The only entry you will be
required to make to complete your business taxes will be to estimate the cost of items
used for your personal use, since these items are not deductible. This entry will be made on
the Taxes screen at the end of each year but it may be easier to estimate this number if
you have kept track of your personal use via the Personal Use menu in the program.

7. Car and Truck: In the Standard and Professional Editions, car and truck business
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expenses are entered on the Vehicles screen. The IRS allows you to deduct vehicle
expenses using one of two methods. The "Actual expenses" method allows you to deduct a
portion of all of your vehicle expenses based on the percentage of business use. The
"Standard mileage rate" method allows you to deduct a specific dollar amount for each
business mile you drive. Check out IRS Resources for more information on deducting car
expenses.

8. Home Office: In the Professional Edition, home office expenses can be entered on the
Home Office screen. All of the categories of deductible expenses are listed on the screen
to help prevent overlooked deductions. Categories in the "Monthly Expenses" section of this
screen are of two different types. For categories labeled "(house)" you will want to enter the
total amount your household spent each month. These expenses will be prorated based on
the percentage of your house actually used for business. For categories labeled "(office)",
enter only those amounts spent directly on your home office. These expenses will
completely deductible. Check out IRS Resources for more information on deducting home
office expenses.

3.2 IRS Small Business Resources

 

The following IRS resources may be useful to you in understanding what you can deduct in the
course of doing business and how your deductions should be documented.

Starting a Business and Keeping Records (Publication 583)
Travel, Entertainment, Gift and Car Expenses (Publication 463)
Business Use Of Your Home (Publication 587)
How To Depreciate Property (Publication 946)
Tax Guide For Small Business (Publication 334)
Tax Withholding and Estimated Tax (Publication 505)
Self-Employment Tax (Publication 533)
Witholding Calculator
Retirement Solutions
Tax Information for Retirement Plans
Small Business Federal Tax Responsibilities
Small Business Resources

 

3.3 Using Help

 

There are several ways to access online Help. The best method is to click on any of the Help  
buttons that can be found throughout the program. This will bring up context-sensitive help that is
specific to the area of the program you are working in. Context-sensitive help can also be accessed
at any time by pressing your F1 key. You can also activate Help by clicking on the Help Topics
option on the Help menu or by clicking on the yellow question mark just above the left side of the
main program toolbar.

 

The Help system has three views. The Contents organizes the help information according to the

http://www.unclefed.com/IRS-Forms/2001/p583.pdf
http://www.unclefed.com/IRS-Forms/2001/p463.pdf
http://www.unclefed.com/IRS-Forms/2001/p587.pdf
http://www.irs.gov/pub/irs-pdf/p946.pdf
http://www.unclefed.com/IRS-Forms/2001/p334.pdf
http://www.unclefed.com/IRS-Forms/2001/p505.pdf
http://www.unclefed.com/IRS-Forms/2001/p533.pdf
http://www.irs.gov/individuals/article/0,,id=96196,00.html
http://www.irs.gov/pub/irs-pdf/p3998.pdf
http://www.irs.gov/retirement/index.html
http://www.irs.gov/pub/irs-pdf/p4591.pdf
http://www.irs.gov/businesses/small/content/0,,id=98864,00.html
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different screens in the program. The Index and Search tabs allow you to search the Help system
for keywords or phrases pertaining to a specific topic.

 

Please remember that our website and online Knowledgebase have additional information that may be
helpful. To access the Training page on our website, click on the Training option on the Help menu.
To check our Knowledgebase or submit a support request ticket, click on the Support option on the
Help menu.



Part
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4 Home

4.1 Overview - Home

(The program opens to the Home screen by default each time you start it. If you would like to change
the starting screen for your program, click on the Preferences option on the Settings menu and
select an alternate starting screen.)

The Home screen offers two different views, depending on which of the following two options is
selected in the lower left corner of the screen.

Show "Getting Started"

By default, the program will open to the "Getting Started" view and display instructions for building
your business and organizing your paperwork. These same instructions can be viewed with active

links by clicking on the  button in the lower left corner of the Home screen.

Show "Today's Activities", "Tomorrow's Activities" or "Activities by Date"

Once you've printed out the instructions for getting started and are familiar with the program, you
will want to switch over to one of the "Activities" views, using the option buttons at the bottom of
the Home screen. These views provide a summary of your appointments, tasks, birthdays and
anniversaries for today, tomorrow, or any day you choose. This summary can be easily printed out
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and taken with you wherever you go.

If you would like to have the quote at the top of the page included in your "Activities" printout,
check the box at the bottom of the Home screen that reads "Include quote". 

If you would like to have a year-to-date financial summary included in your "Activities" printout,
check the box at the bottom of the Home screen that reads "Include YTD". 

Tip: When using the "Show Activities for" option, you will either need to set the date using the
pop-up calendar OR click somewhere outside of the date entry box after setting your date, to tell
the program to refresh the "Activities" display. Remember that Up and Dn arrow keys can be
used to change the date one day at a time and that PgUp and PgDn keys can be used to
change the date one week at a time.

 

 

 

4.2 Quotes
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Clicking on the Quotes button on the Home screen displays the Edit Quotes window. This window
allows you to add to, edit or delete from the list of quotes that are displayed on the Home page.

 

To add a new quote to the list

1. Click on the New button in the Edit Quotes window.
2. Type the quote into the box on the right side of the Edit Quotes window.
3. Click on Save to add your new quote at the bottom of the list on the left.

To edit a quote in the list

1. Click on the quote you would like to edit in the list on the left. This will cause the full quotation
to be displayed in the box on the right.

2. Make the desired changes in the box on the right.
3. Click on Save to save your changes.

 

To delete a quote from the list

1. Click on the quote you would like to delete in the list on the left.
2. Click on Delete.
3. Click on Yes when prompted to confirm the deletion or on No if you change your mind and do

not want to delete the quote.



Part
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5 Contact Management

5.1 Overview

 

The program is designed to handle all of your contact management needs and support you in
customer follow-up and in building a re-order business. The contact management section of the
program consists of four main screens as follows:

 

Contacts: used to add people or make changes to your contact database

Calendar: used to create, edit and view your appointment calendar

(Standard and Professional Editions only)

Tasks: used to keep a running list of tasks you need to complete

(Standard and Professional Editions only)

Team: used to view your team genealogy

(Professional Edition only)

 
 

Detailed information for all of these screens can be found by locating the appropriate topic in the main
Table of Contents or by clicking on the links above.

5.2 Contacts

5.2.1 Overview

 

The Contacts screen is used to keep track of everyone involved in your business. It’s also used to
organize address information, keep notes, broadcast mail-merge emails, write mail-merge letters, and
print address labels. All of the names entered on this screen appear throughout the program wherever
a contact entry is required.

 

All businesses being tracked in the program share the same contact information. Business filters can
be used to allow you to temporarily view only contacts associated with a single business. These
filters can be applied automatically each time you change from one business to another using the 
Options button on the Contacts screen.

 

The Contacts screen is accessed by clicking on the Contacts button at the far left of the main
program toolbar.
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5.2.2 View Options

 
 
All of your contact viewing options can be set by clicking on the Options button in the main Contacts
screen or in  the Edit Contacts window. Some of these options pertain to the main screen while
some of them pertain to the editing window as described below.
 

Main Contacts Screen Options
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Selecting the "Columns" tab allows you to specify which columns should be visible and which
should be hidden in the display. Columns can be resized by hovering over the line between
columns in the top row of the display. The display can also be sorted by clicking on any of the
column headings. Column widths and sorting order are automatically saved whenever changes
are made.

   

Edit Contacts Window Options

Tab order
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Selecting the "Tab Order" tab in the Contact Options window allows you to specify
which fields you would like to skip when using your TAB key to navigate through the Edit
Contacts window. For example, if you seldom enter a Salutation or Middle Initial for your
contacts, you would probably choose to skip those fields to make it quicker and easier to
get to the fields you use most often.
 

 Miscellaneous Options
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Selecting the "Misc" tab in the Contact Options window allows you to specify a variety
of options as follows:
 
 

Check for
duplicate …

Causes the program to prompt you if the First and Last name or
the Home phone number of the listing being saved are the same
as the First and Last name or Home phone in another listing

Use reverse scroll
…

Instructs the program to position the cursor above any existing
entries in the Notes field when a listing is first selected and
whenever the Enter key is pushed

Include time of
day …

Causes the program to include the time as well as the date when
using the Date button in the Notes field on the Contacts screen

Create Calendar
…

Causes the program to automatically create appointments in the
Calendar for all birthdays entered and saved on the Contacts
screen

Show Rank tab … Makes the Rank tab available whenever you go to the Contacts
screen

Show Process tab
…

Makes the Process tab available whenever you go to the
Contacts screen

Filter contacts … Causes the program to automatically apply an Business filter
whenever you change from one business to another using the 
Change Business option on the File menu

Date merge
format

Allows you to specify the format you would the program to use
when merging contact date information (e.g. birthdays,
anniversaries etc.) into emails and letters.

Offset for "hours" Allows you to add or subtract one or more hours to the program’s
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… normal hours (time difference) calculation. Time difference values
displayed on the Contacts screen are based on the contact’s
state of residence relative to the state of residence of the
registered user. If the default value is usually an hour too high or
low, you can use this feature to increase or decrease the
calculated values. You can also override the program’s default
entries at anytime by typing directly into the (hours) box on the
Contacts screen.

 

 Notification Options

 

Select the "Notifications" tab in the Contact Options window allows you to turn on
automatic birthday, anniversary and renewal notifications as follows:
 

Show birthday … Causes the program to display a list of upcoming
birthdays at startup.

Show anniversary… Causes the program to display a list of upcoming
anniversaries at startup.

Show renewal… Causes the program to display a list of upcoming team
renewals at startup.

Caller ID…

(Professional only)

Causes the program to "listen" for incoming Caller ID
signals on your phone line. If Caller ID information is
detected, the program searches for the phone number
in your contact database. If the number is found, the
program asks if you would like to switch to that listing.
If not found, you are given an option to start a new
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listing.

This feature requires that you subscribe to a Caller ID
service from your phone service company. It also
requires that your computer’s modem be compatible
with Caller ID and able to detect Caller ID information
when your phone rings. To have the program
automatically detect the best Modem String to use
leave this box blank. Put a check in the box that reads 
Listen for Caller ID… and click on the Find button to
have the program locate your modem. Then click on OK
to have the program test different strings and pick the
best one to work with your modem.

 

Depending on your selections in the Contact Options window and on the options available for
the company you sell products for, you will see between 2 and 5 tabs on the right side of the 
Edit Contacts window. Here is a brief description of the purpose of each of those tabs.
 

Listing: This view allows you to enter and view detailed contact information for any
contact.

Notes: This view allows you to keep notes and quickly identify, create or edit the
next scheduled appointment and task for the selected contact.

Profile: This view allows you to track client responses to preloaded questions and
to print or email product recommendations based on those responses.
This view is only available in certain custom editions of the program.

Rank: This view allows you to define up to eight ranking criteria for each of your
contact Groups. For example, you might choose to rank prospects on
their entrepreneurial desire or capabilities. You can then assign a numeric
level to each person for any or all of these criteria. The Filter button can
then be used to find contacts based on a specified Rank (e.g. all
Prospects who have a Rank of 75 or above). This view is only available if
the "Show Rank tab" option has been selected using the Options button
on the Contacts screen.
 

Process: This view allows you to define up to eight steps or milestones for each of
your contact Groups. For example, you might choose to keep track of
each team member’s progress in meeting training and business goals.
The Filter button can then be used to target communications based on a
specified position in the process (e.g. all Event Hosts who haven’t yet
shadowed a party). This view is only available if the "Show Process tab"
option has been selected using the Options button on the Contacts
screen.

 

5.2.3 Contacts Top Toolbar
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(Standard and Professional Editions only except for Labels)

 

Filter: This button displays the Filter Contacts window allowing you to temporarily reload
the Contacts screen with specific groups of contacts. Groups can be "filtered"
based on categories you select when you enter each person, on previous
purchasing history, on attendance at specific events, and on their Rank and
Process status.

Search: This button displays the Search Contacts window allowing you to temporarily
reload the Contacts screen with contacts whose entered information contains, or
doesn’t contain, specific text or characters.

Select: This button displays the Select Contacts window allowing you to temporarily
reload the Contacts screen with only those contacts you select before closing the
window. Using the Change button immediately after selecting contacts allows
you:

To quickly create new contact groups, by assigning a new Additional Group
to all Target Listings or
To delete a large number of contacts without having to remove them one by
one.

Restore: This button cancels the effect of any Filter, Search or Select operations and
reloads the Contacts screen with all of your saved contacts.

This button displays the Contact Group Changes window allowing you to make
group-level changes to your contact database. It is generally a good idea to
perform a backup of your data prior to mak ing group-level changes. Back ing up
your data prior to mak ing changes allows you to revert back to your pre-change
status in the event that the changes you make do not work  out as intended.

Email: This button displays the Email History window containing a list of all of the emails
sent out using the program. The Email History window also contains buttons for
creating new mail-merge email and for resending or forwarding a previously sent
email message.

Letters: This button displays the Letters window allowing you to create mail-merge
documents and letters.

Labels: This button displays the Address Labels window allowing you to preview or print
standard or custom address labels for select groups of contacts.

 

5.2.4 Contacts Bottom Toolbar

 

 

This button opens the Follow-Up Schedules window allowing to create or
edit activity schedules containing appointments, emails and tasks.
 

This button opens the Recurring Email Setup window allowing you to
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create birthday, anniversary, renewal and tickler emails to be sent
automatically by the program.

This button opens the All Activities window allowing you to view a list of all
appointments, tasks and scheduled emails that are currently in the system.
This window is also available via the binoculars icon on the Edit Contacts
screen, where it displays only those activities relating to the currently
selected contact.

Right clicking in either the All Activities window or in the Activities window
for a specific contact allows offers a menu with options for creating, editing
and deleting appointments and tasks and for deleting scheduled emails.
 

Options: This button opens the Contact Options window allowing you to customize
the Contacts screen to your liking.
 

Print: This button prints what is currently displayed on the Contacts screen (other
contact reporting options, including user-defined contact reports in the
Professional Edition, are available on the Reports screen).

  

Copy: This button copies an entire listing into a new record, which can then be
modified without affecting the original listing. This feature is useful for
duplicating address information when entering members of the same family.

  

Merge: This button allows you to merge information for two contacts, thereby
eliminating one of the contacts, while retaining associations that exist
between both contacts and other records in the program. To merge two
contacts, first select the contact that you want to eliminate, then click on 
Merge and select the contact you want to keep. Then set the various
Merge Options and click on Merge.
 

New: This button displays and / or clears the Edit Contacts screen and places
the cursor in the Salutation or First Name entry box, depending on the
"Tab" options selected using the Options button on the Contacts screen.
This button and the New button in the Edit Contacts window both clear the
Edit Contacts window and may be used interchangeably.
 

Delete: This button deletes all of the currently selected contacts and clears the Edit
Contacts screen if it is currently displayed. The program will prompt you to
confirm before deleting.

  

5.2.5 Creating Contact Groups

 
 

The key to organizing your contact database can be found in the Business and Group boxes on the
Edit Contacts screen. These selection boxes allow you to group your contacts in any way you
choose. Contact groups can then be selected individually or in combination with one another, using
the Filter  button on the top toolbar of the Contacts screen.
 



Contact Management 49

© 2011 MLM Software Solutions, Inc.

 

Business

If you are only keeping track of one business in the software then you do not need to worry about the 
Business setting. The Business selection for all of the contacts you enter will be identical to the
business name you entered in the Business Setup window when you first started the program. If
you're  tracking more than one business in the software, the Business selection box on the Edit
Contacts screen can be used to identify and separate contacts based on the business with which
they are associated. In this case, the Business selection box will contain the names of all of your
active businesses. Changing the name of your business using the Rename Business option on the
File menu will simultaneously change the Business entry for all of that business’s contacts. To
select contacts based on their Business, use the Filter button on the top toolbar. Contacts can be
automatically filtered whenever you change from one business to another if the "Filter contacts when
changing businesses" option is selected under the Options – Misc button on the Contacts or Edit
Contacts screen.

 

Groups

Groups refer to the relationships that exist between you and the people in your database as follows:

The Primary Group box (furthest to the left) is used to specify the primary relationship you have
with the person being entered. Typical examples might be "Customer", "Prospect" or "Past Host".
Specifying a Primary Group (required entry) for one or more contacts allows you to find them by
filtering on that Group.
 

The Subgroup box just to the right of the hyphen is used to break a primary Group into subsets.
For example, someone with a Primary Group of "Team" might have a Subgroup of "Business
Builder". Specifying a Subgroup for one or more contacts allows you to target them separately
from other people in the same Primary Group using the Filter button on the Contacts screen.
 

The Addl… button to the far right of the the two Group boxes is used to specify additional groups
for the person being entered. For example, someone with a Primary Group of "Customer" might
also be a "Friend", a "Relative" or one of the people on your "Christmas Card List". Specifying
these Additional Primary Groups for one or more contacts allows you to find them by filtering
on any one of these Groups.
 

New Groups can be added by right clicking on either Group box, using the Contacts option on the
Categories menu or using the Edit List button in the Additional Primary Groups window.
 

Several Group categories have special significance. Assigning a primary or additional primary Group
of  Crossline or Upline allows you to make entries in the Title, I.D. # and Anniversary boxes in the
lower right corner of the  Edit Contacts screen. Assigning a primary or additional primary Group of
Downline allows you to access these three boxes and also the Upline selection box. Assigning
members of your team to their immediate upline by selecting the upline’s name in the Upline box,
allows you to Filter on specific segments of your team. In the Professional Edition, It also allows you
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to view and print your team using the Team screen, or to view and print indented reports using the
Team (genealogy) option on the Reports screen.

5.2.6 Entering Contacts

 

 

Tip: The Options button on the Edit Contacts screen contains settings that allow you to
customize and simplify the way contact information is entered. You may want to
click on this button and look over the settings it contains before beginning to build
your contact database.

 

To enter a new contact into your contact database, just do the following:
1. Click on the Contacts button to go to the Contacts screen.
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2. Click on the New button on the bottom toolbar of the Contacts screen to open the Edit Contacts
window.

3. Name:  Enter a first (optional) and last name. (You can also enter a salutation and middle initial
as well as a second person’s name information if you choose.)

4. Primary Group:  Select the category that best describes your primary relationship with this
person from the list in the first Group box. The primary Group entry is used to separate out
groups of contacts using the Filter button. If the contact being entered is a member of your team
please see these special instructions for entering team members.

The above entries are the only entries that are required to save a new contact listing.

 

If you are done entering information for this person, click on the Save button on the
bottom toolbar of the Edit Contacts screen to save your entries, otherwise, continue with
the next step.

5. Subgroup:  Select a category from the second Group box (just to the right of the hyphen) if you
would like to specify a subgroup that this person should be a member of (e.g. Primary Group:
Team, Subgroup: Business Builder). Do not use this box to add people to more than one contact
group. Filtering using a Subgroup requires a match on both the primary Group and the Subgroup.
To add a contact to more than one group use the Addl button to the right of the Subgroup box.

6. Addl Groups:  Click on the button that reads "Addl…" to the far right of both Group boxes to
open the Additional Primary Group window. You may select as many Additional Primary
Groups for a person as you like. Additional Primary Groups allow you to associate a person
with multiple groups for use with the Filter function.

7. Addresses:  Enter this person’s main address into the Address boxes on the Contacts screen. If
you would also like to enter a secondary address, click on the "open book" icon to the right of the 
Address boxes to display the Secondary Address window. Clicking on the Switch button in the
Secondary Address window causes the window to exchange entries with the corresponding
boxes on the Contacts screen. Checking the box that reads "Use this address for labels" causes
the program to use the Secondary Address entries whenever a label is created for this person.
Checking this box affects only the listing that is being edited and will not affect which address is
used for any of your other contacts.

8. Email:   Enter this person’s primary email address in the first Email entry box. A second email
address can also be entered into the second Email entry box. The program defaults to the first
email entry when a person’s name is selected in the Email window. If two email addresses have
been entered on the Contacts screen, a double arrow will be displayed to the right of the two
Email entry boxes allowing you to quickly switch their contents. The "envelope" icon that appears
to the right of either Email box when a valid email address has been entered, can be used to
quickly send an email to that person using the selected email address.

5. Phones:   Enter phone or fax information into any of the four pre-defined phone fields. Do not
attempt to format the numbers as you enter them. Just type the numbers in and the program will
format them for you. There is one user-defined phone field to the right of the Work and Ext boxes.
The heading for this field can be set by clicking directly on the box label and entering a new
heading.

6. Birthdays:  Enter a Birthday for one or both of the people associated with this listing. Options to
have an appointment created and to have the program display a birthday notification can be set
using the Options button on the Contacts screen. 

7. Anniversary:  Enter this person’s wedding anniversary. If you are using the Standard or
Professional Edition, options to have the program display an anniversary notification can be set
using the Options button on the Contacts screen. 

8. Schedule:  If you are using the Professional Edition, select one or two pre-defined schedules of
activities for this person in the two Schedule boxes and enter or select a date on which each
schedule should become active. Creating and assigning schedules allows you to quickly apply a
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consistent set of follow-up activities to one or more of the people in your database. Clicking on the
"binoculars" icon to the right of the Schedule boxes displays the Activities window, containing a
list of all of that person’s appointments, tasks and scheduled emails. Right clicking in the 
Activities window allows you to create appointments and tasks or to delete any of the listed
activities.

9. Wish List:   Clicking on the heart icon to the right of the Wish List box allows you to select any
number of items from your list of products to add to a contact’s "wish list". In the Standard and
Professional Editions, Wish List products can be searched on using the Search button on the
Contacts screen.

10.User-definable fields:  Enter information into the four custom (user-definable fields) at the top
right hand side of the Listings tab in the Edit Contacts screen. The names of these four fields can
be changed by clicking directly on the label in front of any one of the boxes and then entering the
new name(s) in the pop-up window.

11.Credit Card:  Enter this person’s default credit card number and card expiration date. The entries
in the Credit Card box on the Contacts screen are used by the program in two ways:
Credit Card information gets pulled into the Payment History window whenever you select a
name from your list of contacts in conjunction with a Credit payment. This can be useful if several
people are contributing payments towards a single purchase or sale. The Payment History
window can be accessed by clicking on the ellipsis (…) button to the right of the Balance Due
box on the Purchases and Sales screens
Credit card information is pulled by the Upload Invoices window whenever you upload payment
information to ProPay  for automatic credit card processing.

In the Professional Edition, clicking on the "credit card" icon to the right of the Credit
Card boxes displays the Credit Cards window, allowing you to store information for up
to three additional credit cards. The default card shown on the Edit Contacts screen
can be selected in this window by clicking on the selection button in front of any of the
four credit card numbers.

 

NOTE: All credit card information stored in the software is encrypted using AES-
256 bit encryption.

12.Last Order:  The Last Order date and amount get filled in automatically whenever you enter a
transaction on the Sales screen and select one of your contacts as the Customer. These
automatic entries can be overridden by checking the box in front of the Last Order date box, in
case you would like to track a drop ship or Internet order that was not entered on the Sales
screen. Clicking on the "spreadsheet" icon to the right of the Last Order box displays the
Purchase History window, containing a list of all of that person’s previous purchases that have
been entered on the Sales screen.

13.Last Event / Last Host:  These boxes contain Event and Host information based on the most
recent Sales screen entry for this contact. The information in these boxes can be used to locate
all of your contacts who attended certain events using the Filter button on the Contacts screen.
Clicking on the firecracker icon to the right of the Last Event entry box displays the Event
History window, containing a list of all Events with which this person is associated. Contacts get
associated to Events whenever they are selected as the Customer for a sale that’s linked to that
Event or when you choose to add them to the Event using the Add button in the Event History
window.

14.Next Event / Next Host: These boxes contain Event and Host information based on a contact
having been added to an Event that has not yet occurred. The information in these boxes can be
used to locate all of your contacts who have been invited to attend certain events using the Filter
button on the Contacts screen, allowing you to send out invitations, email them reminders or just
give them a call. Clicking on the firecracker icon to the right of the Next Event entry box displays
the Event History window, containing a list of all Events with which this person is associated.
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15.Booked Event: These boxes contain Event information for this contact’s next event. Clicking on
the bell icon to the right of the Booked Event boxes allows you to add or edit this contact’s event
directly from the Edit Contacts screen.

16.Notes: Click on the Notes tab and add any notes to the listing that are appropriate. The Notes
box can be scrolled from bottom to top, so that your most recent notes are at the top of the box, if
that option is selected using the Options button on the Contacts screen. The maximum number
of characters that can be entered into the Notes field is 8000.

17.Profile: This tab will only be available in certain custom editions of the program. If appropriate,
click on the Profile tab and select this person’s responses to the questions that are displayed
there.

18.Rank: If appropriate, click on the Rank tab and enter numerical rankings for each of your defined
criteria.

19.Process: If appropriate, click on the Process tab and check off any prospecting steps this person
has already completed.

20.Click on the Save button on the bottom toolbar of the Edit Contacts screen to save your entries.

NOTE: A contact listing can also be created or edited from other screens in the program
(e.g. Sales, Purchases, Events, Loans, Trades) using the screen below. The entries on
this "mini" Contacts screen follow the same descriptions as their corresponding fields on
the main Edit Contacts screen.

 

5.2.7 Entering Your Team

 

Team members are entered like any other contact except that they must be assigned a Primary
Group of "Downline".
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Your team must be entered from the top down, starting with one or more of your immediate frontline
members and building all the way down their leg. The registered owner’s name appears
automatically in the Upline box on the Contacts screen, so you do not need to enter yourself
in order to start entering your team. The registered owner’s name is the name you entered when
you first installed the program. You will use this name as the starting point for entering your team (the
registered owner’s name can be changed using the Owner Info option on the Settings menu).
 

 

The Upline entry box is the key to entering your team correctly. This box is where you specify the
immediate upline (that is, who the person being entered is directly under). Each team member
you enter is automatically added to the Upline selection list.

 

To begin entering your team, do the following.

1. Click on the Contacts button on the main toolbar to go to the Contacts screen.

2. Click on the New button on the bottom toolbar of the Contacts screen to open the Edit Contacts
window.

3. Enter one of your front-line member’s first and last names in the boxes provided (e.g. Susan
Smith).

4. Skip down to the left-most (primary) Group box and select Downline from the list provided.

5. Skip down to the lower right corner of the Edit Contacts screen to the section labeled Team
Information and select your name in the Upline box, using the button on the right side of the
box.

6. If this team member was sponsored by someone other than their immediate upline, enter the
sponsor’s name into the Sponsor box.

7. Select the appropriate Title for this person in the Title box. Also enter their ID# and Renewal
date. The list of "Titles" can be edited by clicking on the ellipsis (…) button to the right of the Title
 box.

8. Click on the Save button on the bottom toolbar of the Edit Contacts screen. Note that the
program automatically sets the Level box entry to "1".

9. Click on the New button on the bottom toolbar of the Edit Contacts screen.

10.Enter one of Susan Smith’s front-line member’s first and last names.

11.Skip down to the left-most (primary) Group box and select Downline from the list provided.
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12.Select "Smith, Susan" in the Upline box using the button on the right side of the box.

13.Click on the Save button on the bottom toolbar of the Contacts screen. Note that the program
automatically sets the Level box entry to "2".

 

Repeat Steps 9 through 13 for each successive member in that leg of your team. Then return to Step
3 and enter your next front-line member’s first and last names.

5.2.8 Selecting a Contact

 

An existing contact can be selected in one of three ways.

1. By clicking into the Contact box on the Contacts or Edit Contacts screen and typing the first few
letters of the contact’s last name, then pressing Enter. Pressing Enter twice in the the Contact
box on the main Contacts screen will select the contact and also display the Edit Contacts
screen.

2. By clicking on the ellipsis (…) button on the right-hand side of the Contact box on the Contacts
or Edit Contacts screen. This opens a window listing all of your contacts where you can type or
use your mouse to select a name.

3. By clicking directly on that contact’s record on the main Contacts screen. To select more than
one contact at a time, hold down your CTRL key and select each contact on the main Contacts
screen.

 

The Up and Down arrow keys and the PgUp and PgDn keys can be used to scroll through your list
of contacts when the cursor is in the Contact box on the Contacts or Edit Contacts screen. The first
two methods shown above are available everywhere throughout the program whenever you need to
select a contact’s name.

 

You can also use the white arrows next to the bottom toolbar on the Edit Contacts screen to scroll
through your contacts one at a time.

5.2.9 Editing a Contact

 

An existing contact’s information can be edited in the following manner:

1. Select the contact you would like to edit.

2. Press your Enter key or double click in the Contact selection box or double click on a contact’s
record on the main Contacts screen to display the Edit Contacts window.

3. Make changes by typing directly into the entry boxes on the Edit Contacts screen.

4. Click on the Save button on the bottom toolbar of the Edit Contacts screen to save your
changes.
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A contact’s information can also be edited from other screens throughout the program (e.g. 
Purchases, Sales and Event).

5.2.10 Deleting a Contact

 

Existing contacts can be deleted in the following manner:

1. Select the contact(s) you want to delete. To select more than one contact at a time, hold down
your CTRL key and select each contact on the main Contacts screen.

2. Click on the Delete button on the bottom toolbar of the Contacts screen.

3. Click on Yes when prompted to confirm the operation and finish deleting the contact(s).

 

If the contact that is deleted has a Primary Group of Downline, all of your team  members who
were under that person will be "rolled up" and will now appear directly under the deleted person’s
former Upline.

5.2.11 Filtering Contacts
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The Filter button on the Contacts screen displays the Filter Contacts window, allowing you to
temporarily target a group of contacts based on their:

Business
Group(s)
Sales history
Event history
Team position, title, renewal date or volume
Rank settings
Process status

Filter results persist until a subsequent Filter, Search, Select or Restore operation occurs. This
means that the contact names available for selection in the Email, Letters and Labels windows
always reflect the results of your last Filter, Search, Select or Restore operation, allowing you to send
highly targeted communications by mail-merge email or letter, simply by filtering, searching or
selecting contacts prior to clicking on the Email, Letters or Labels buttons. The "Target" number of
currently filtered, searched or selected contacts and the "Total" number of contacts in your database
are always visible in the space immediately above the Contact box on the Contacts and Edit
Contacts screens.

 

To perform a Filter operation, just do the following:
 

1. Click on the Filter button on the Contacts screen. This will display the Filter Contacts window.
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2. Business Filter:   If you have more than one active business select the Business(es) you wish to
include in the filtered results, by clicking on the checkboxes in the upper left of the Filter
Contacts window. If you have only one active business, skip to the next step.

3. Primary Group Filter:  Click on one or more of the Group categories in the Primary Group
Filter box. In order to be found by a Primary Group Filter, a person’s Primary Group setting,
or one of that person’s Additional Primary Group settings, must exactly match one of the
selections in the Primary Group Filter box.

4. Subgroup Filter:   If you choose, activate the Subgroup Filter by clicking the checkbox that
reads "Activate Subgroup Filter" directly beneath the Primary Group Filter selection box.
Checking this checkbox enables the Subgroup Filter selection box, allowing you to specify one
or more subgroups to further refine the filtered results. In order to be found by a Subgroup Filter,
a person’s Primary Group setting must exactly match one or more of the selections in the
Primary Group Filter and their Subgroup setting must exactly match one or more of the
selections in the Subgroup Filter.

5. Special Filters:   The Sales, Events and Rank and Process buttons in the Special Filters area
of the Filter Contacts window will only be enabled if you have selected at least one item in the
Primary Group Filter selection box. The Team filter button will only be enabled if Team is
selected in the Primary Group Filter selection box.

5.a.Sales:    Click on the Sales button to display the Sales Filter window. This window contains
five options, selectable by checkbox, allowing you to set filters based on what products your
contacts have purchased, how much they’ve spent, when they purchased, how many times
they have purchased and whether or not they have paid for all of their purchases. The results
obtained using these filters are based on all of your sales entries in the program and are not
affected by the Current Time Period setting. Selecting multiple products in the first sales filter
option causes the program to find everyone who has purchased any of the selected products.
Entering a dollar amount in the second filter option causes the program to find everyone whose 
total purchases are more or less than the amount entered, depending on which condition has
been selected. When using more than one sales filter condition all of the imposed conditions
must be met for a listing to be selected.

5.b.Events:    Click on the Events button to display the Event Filter window. This window allows
you to set a filter based on specific events or on specific event hosts. The results obtained
using these filters are based on all of your sales entries in the program and are not affected by
the Current Time Period setting. Selecting one or more events in the first filter option causes
the program to find everyone who attended any of the selected events. Selecting one or more
hosts in the second filter option causes the program to find everyone who attended an event that
was hosted by any of the selected hosts.

5.c.Team:    Click on the Team button to display the Team Filter window. This window allows
you to set filters based on hierarchical position, title, renewal date or personal volume, as
displayed on the Activity tab of the Team screen.

5.d.Rank and Process:  Click on the Rank & Process button to display the Rank and Process
Filter window. This window contains three options, selectable by checkbox, allowing you to set
filters based on a minimum Rank and / or Process status that contacts must meet in order to
be included in the filtered results. The Rank and Process Filter conditions you specify will only
be applied to the first selected Group, no matter how many relations are selected in the
Primary Group Filter selection box.
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6. Determine whether you want to include or exclude contacts that match your filter criteria using the
"Include contacts that meet the filter criteria" or "Exclude contacts that meet the filter criteria"
checkboxes.

7. If desired, check the box that reads "Filter Target contacts only", to continue filtering from where
your last Filter, Search or Select operation left off. Checking this box allows you to combine
Filter and Search operations to apply successively more restrictive conditions to your contact
database. Leave this box un-checked if you want the Filter operation to test all of your contacts
against the specified Filter criteria.

8. If you have archived data in the past and would like your filter to search those archived records in
addition to your current business records, check the box that reads "Filter archived records".

9. Click on Apply Filter to close the Filter Contacts window and temporarily reload the Contacts
screen with only those people who meet the specified filter criteria. To undo the results of a
filtering operation click on the Restore button on the Contacts screen.

Filtering can also be done prior to exporting contact information allowing you to create personalized
documents using other applications if you choose. Use the Restore button on the Contacts screen
to reload the Contacts screen with all of the contacts in your database once you're done working with
a filtered group.

5.2.12 Searching Contacts

 

 

 

 

The Search button on the Contacts screen displays the Search Contacts window allowing you to
search for contacts based on any of your contact fields. Search results persist until a subsequent
Filter, Search, Select or Restore operation occurs. This means that the contact names available for
selection in the Email, Letters and Labels windows always reflect the results of your last Filter,
Search, Select or Restore operation, allowing you to send highly targeted communications by mail-
merge email or letter, simply by simply by filtering, searching or selecting Contacts prior to clicking
on the Email, Letters or Labels buttons. The "Target" number of currently filtered, searched or
selected contacts and the "Total" number of contacts in your database are always visible in the
space immediately above the Contact box on the Contacts and Edit Contacts screens.

 

To perform a Search operation, do the following:
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1. Click on the Search button on the Contacts screen. This will display the Search Contacts
window.

2. Select a field to search on from the selection box entitled Field to search.

3. Enter one or more characters to search for in the entry box titled Characters to search for. An
asterisk (*) can be used as a wildcard if you like. This is particularly useful when searching a date
field, where for example, searching for "11/*" will find everyone with a November date entry.

4. If desired, check the box entitled Search Target contacts only"  to continue searching from where
your last Filter, Search or Select operation left off. Checking this box allows you to combine
Filter and Search operations to apply successively more restrictive conditions to your contact
database. Leave this box un-checked, if you want the Search operation to test all of your
contacts against the specified search criteria.

5. Click on Search. This will close the Search Contacts window and temporarily reload the
Contacts screen with only those people who meet the specified search criteria.

Searching can also be done prior to exporting contact information  allowing you to create
personalized documents using other applications if you choose. Use the Restore button on the
Contacts screen to reload the Contacts screen with all of the contacts in your database once you're
done working with a "searched" group.

5.2.13 Selecting Contacts

 

The Select button on the Contacts screen allows you to target a group of contacts by simply
selecting them on the Contacts screen (to select multiple contacts hold down your CTRL key and
click on each contact’s record). Select results persist until a subsequent Filter, Search, Select or
Restore operation occurs. This means that the contact names available for selection in the Email,
Letters and Labels windows always reflect the results of your last Filter, Search, Select or Restore
operation, allowing you to send highly targeted communications by mail-merge email or letter, simply
by filtering, searching or selecting Contacts prior to clicking on the Email, Letters or Labels
buttons. The "Target" number of currently filtered, searched or selected listings and the "Total"
number of contacts in your database are always visible in the space immediately above the Contact
box on the Contacts and Edit Contacts screens. 

 

To perform a Select operation, do the following:

1. Hold down your CTRL key while clicking on individual rows on the Contacts screen.

2. Click on the Select button on the Contacts screen. This will temporarily reload the Contacts
screen with only the selected contacts..

Selecting can also be done prior to exporting contact information allowing you to use your contact
information with other applications if you choose. Use the Restore button on the Contacts screen to
reload the Contacts screen with all of the contacts in your database once you're done working with a
selected group.
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5.2.14 Incremental Filtering and Searching

 
 

Incremental filtering and searching allows you to combine filter and search operations, by applying
successively more restrictive conditions to your contact database. It does this by applying the new 
Filter or Search operation only to the group of previously filtered, searched or selected contacts
instead of starting over with your entire contact database. Incremental filtering and searching is
accomplished by checking the box that reads "Filter Target contacts only" or "Search Target
contacts only" checkbox in the Filter and Search windows respectively.

 

Say, for example, that you would like to find all of your customers in the city of San Francisco who
have purchased a certain product.
 

1. Use the Filter button to display the Filter Contacts window and find all of your contacts with a
primary Group of "Customer", who also have purchased the specified product. Use the Sales
button in the Filter Contacts window to specify the product you want to require your customers to
have purchased.

2. Open the Search Contacts window by clicking on the Search button on the Contacts screen.

3. Check the box that reads "Search Target contacts only".

4. Search the City field, entering "San Francisco" in the Characters to search for entry box.

5.2.15 Email Setup

 
Opens the Email Setup Options window allowing you to choose whether to use your own email
provider's settings for sending email from the program or to use our built-in "Easy Mail" service. The
"Easy Mail" option is a subscription service allowing you to send a large number of emails per hour
without the restrictions imposed by most standard email providers. For more information on this
service, or to sign up for "Easy Mail" account, please click on the More info... button in the Email
Setup Options window.

 

  

Using the Program's Built-In Email Settings (Easy Mail)
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If you have purchased a subscription to our "Easy Mail" email service, select the second option
in this window, then enter the "Account name" given to you by MLM Software Solutions into
the Account name entry box. Next, enter a primary and (optional) secondary reply-to address
in the two boxes provided. The Reply-to addresses specify where responses to the emails you
send out from the program will come back to and can be any valid email address. You will able
to choose between these two reply-to addresses in the Email window each time you send an
email.

Sending email using the "Easy Mail" option requires only that you:

sign up for the "Easy Mail" service and enter your Account name in the box provided

enter the email address(es) where you would like to receive responses

make sure  any firewall software running on your computer is set to allow Consultant Front
Office Queued Email System (SMTP_v10.exe) to access the Internet.

have Internet Explorer 6.0 or higher installed on your computer

Click on Save to test the system and confirm that you are ready to send emails. When using
the "Easy Mail" service, you do not need to read the remainder of this Help topic.

 

Using Your Own Email Settings

If you would like to use your own email provider's settings to send email, select the first option
in this window, then click on Save to open the Email Setup window (see below).
 

Email Requirements

In order to use the Email function in the program, you must

have an SMTP/POP3 email account (these are available from virtually every Internet
Service Provider)

make sure any firewall software running on your computer is set to allow Consultant
Front Office (CFO_v11.exe) to access the Internet (when sending in Immediate
Mode)

make sure  any firewall software running on your computer is set to allow Consultant
Front Office Queued Email System (SMTP_v10.exe) to access the Internet (when
sending in Queued Mode)

have Internet Explorer 6.0 or higher installed on your computer.
 

Email Setup
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The settings to be entered in this window are unique for each person and must be
obtained from your email provider as described below. To set up the email system in the
program, you must enter your email account information using the Setup button in the
Email History window or using the Settings option on the Edit menu in the Email
window.

 

Every email provider requires different email settings making it impossible to include
detailed setup instructions in this guide. The best strategy for setting up email is to have
your Internet Service Provider (ISP) assist you in setting up Microsoft Outlook Express to
send and receive email, then use the Search for Settings button to transfer these
settings into Consultant Front Office. Once this is done, you will only need to enter
your Password. The Password you enter must be the password given to you by your
email provider. Password are always "case-sensitive", so make sure you don’t have the
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CAPS LOCK key on when making this entry.

 

This method of setting up email avoids most typographical errors and ensures that the
settings being entered are the correct settings for your specific provider. All of the "reply-
to" addresses (top 3 entry boxes) can generally be set to whatever email address you
would like to use to receive replies to emails sent out using the program.

 

It’s typically best to use your ISP’s email settings, even if you manage your email using
another system (e.g. Hotmail, Yahoo or Gmail). All ISPs we are aware of at this time offer
email service that is compatible with Consultant Front Office and using their service
usually results in the easiest setup and most reliable operation.
 
 

Entries in the Email Setup window are as follows:
 

Send emails immediately Instructs the program to send emails
immediately when you clidk on the Send button
in the Email window
 

Queue emails for background
delivery

Instructs the program to place "sent" emails in
a queue when you click on the Send button in
the Email window for delivery at a specified rate
(see below - "Maximum number of queued…").

(Professional Edition only)
 

Primary reply-to address Your default reply-to email address (see below)
 

Secondary reply-to address Your alternative reply-to email address (see
below)
 

Scheduled email reply-to
address

Reply-to address for all emails sent out as part
of a Schedule (Professional Editions only)
 

From address Typically the same as your reply-to address but
may be set differently if required by your email
provider for authentication purpose
 

Account name The account name or user name assigned to
you by your email provider (typically just the
email address assigned to you by your Internet
provider)
 

Password The password assigned to you by your email
provider (case-sensitive)
 

Incoming mail server (POP3) Your email provider’s POP3 server address
(typically something like pop3.charter.net).
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Outgoing mail server Your email provider’s SMTP server address
(typically something like smtp.charter.net.
 

Outgoing port The SMTP port used by your email provider
(typically 25).
 

Server requires authentication Indicates that your email provider
"authenticates" email senders.
 

Server requires a secure
connection (SSL)

This setting is not common and is not the same
as standard "authentication" (see previous
setting).
 

Log on using Secure Password
Authentication (SPA / NTLM)

This setting is not common and is not the same
as standard "authentication" (see above). At
present, only MSN is known to sometimes
require this setting.
 

Seconds to wait before… The number of seconds the program should wait
before reconnecting if it gets disconnected while
broadcasting emails.
 

Maximum number of queued… The maximum number of emails to be sent
each minute when operating in "queued" mode.

 

Entering different email addresses in any of the three reply-to address fields allows you to
select from these reply-to addresses in the Email window each time you send an email.

 
 Testing Your Email Settings

You can use the Test Connection button in the Email Setup window to check your
settings and to make sure the program is being allowed to access the Internet. If your
connection does not test out successfully using this button then either:

the firewall software on your computer is preventing Consultant Front Office from
accessing the Internet OR

there is an error in one or more of the settings you have entered

 

The message that is returned after clicking the Test Connection button will either
confirm that a test email was successfully sent, or it will tell you which of the above two
causes is most likely the problem.

 

Web-based Email Providers
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Web-based email systems, such as Yahoo (premium accounts are ok), Hotmail,
Juno and others do not generally support SMTP/POP3 access and therefore may not be
compatible with the email sending function in the program. You can still set your return
email address to a web -based email provider (e.g. jeff@juno.com), so that
responses to emails you send using the program come back to your web-based
email account. You just can’t use web-based email providers to send emails out
unless they also offer SMTP email service.

5.2.16 Email

 

 

The Email function allows you to quickly and easily broadcast individual, mail-merged emails to any
filterable, searchable or selectable contact group. Emails may be sent immediately or they may be
queued for delivery at a specified rate.
 

Email Setup

Your email account information is entered using the Setup button in the Email History window
or using the Settings option on the Edit menu in the Email window. For more information on
setting up email please see Email Setup.

 

Email History Window

The Email button on the Contacts screen displays the Email History window, showing a
complete history of all of your previously-sent emails. The upper portion of the window contains
the history information. The lower portion of the window displays the contents of whichever
email is currently selected in the upper portion of the window. The status bar at the bottom of
the window shows the total number of queued emails waiting to be sent. The Email History
window will refresh it’s status automatically every 30 seconds whenever there are emails
remaining in the queue, but you can force the window to refresh at any time by clicking on the
queued email label. Next to the queued email label is a button allowing you to restart the
queued email system. This button will only be enabled if there are queued emails waiting to be
sent out. Whenever the button is enabled there will be a colored box immediately to the right of
the button indicating the queued email system’s current status. Red indicates that the queued
email system is not currently connected to your email provider, green indicates that it is.

 

In general, you will not need to use the Restart Queue button since the queued email system
runs automatically whenever there are queued emails to be sent out.
 

(Standard and Professional Editions only)
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The first five columns in the history display contain special information regarding each email as
detailed below.
 

P L, M or H Indicates this email’s priority setting (Low, Medium, High)

I checkmar
k

Indicates whether the Individual option was selected

S checkmar
k

Indicates whether this email was sent as part of a Schedule

A … Indicates that this email included attachments (double click to view a list)

U … Indicates that queued emails have not yet been sent (double click to view a
list)

  If this cell is yellow the program has not yet finished trying to send these
email(s)

  If this cell is red the program was unable to complete sending of the
selected email(s)

 

The remaining columns contain general information about each email. If an ellipsis (…) is visible
in any of the recipient columns (To, CC or BCC), double clicking on the ellipsis will display a
list of all of the recipients of that type (direct recipient, copied recipient, blind-copied recipient).
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The toolbar at the top of the Email History window allows you to create and send or resend
emails as follows.
 

New Opens the Email window allowing you to create and send a new email.

Forward Opens the Email window and then opens the currently selected file, just as though
you had clicked on New and then opened the file yourself using the Open option on
the File menu in the Email window.

Resend Same as Forward except that the original recipients’ names and addresses are
entered into the To, CC and BCC boxes in the Email window.

Delete Deletes the currently selected email.

Print Prints the currently selected email.

Setup Opens the Email Setup window.

Close Closes the Email History window.

 

The buttons at the bottom of the Email History window do the following:
 

Check Queue: Updates the queued email count.

Restart Queue: Restarts the queued email sending system.

Clear Queue: Clears all unsent emails from the email queue.

Scheduled: Tells the program to check for Scheduled emails that are due.

 

In general, you should not need to use any of these buttons. The email "queue" should take
care of sending and clearing emails automatically and "scheduled" emails should be sent out
automatically the first time the program is opened each day, assuming that the option that
reads "Check for scheduled emails at startup" is selected in the Preferences window (
Preferences option on the Settings menu). The Scheduled button can come in handy if you
retroactively assign a Schedule to one or more of your contacts using a Start Date in the past,
and would like the emails that are already due to be sent out immediately.

 

Email Window

The Email window is used to create and send emails. It contains a number of powerful features
that make it easy for you to stay in touch with all of your contacts with a minimum of time and
effort.
 



Contact Management 69

© 2011 MLM Software Solutions, Inc.

 

Reply-To Address

If you have entered more than one "reply-to" address in the Email Setup window then a
selection box will be visible in the upper right corner of the Email window allowing you to
select which return address to use when sending emails. The selection box will not be
visible if you have entered only one address or if all "reply-to" entries in the Email Setup
window are the same.

 

Selecting Recipients

The three Contacts buttons in the Email window each display the Email Recipients
window. The Email Recipients window always reflects the most recent Filter, Search
and Select results allowing you to easily target email campaigns to specific groups of
contacts. By selecting individual or multiple names (hold down the CTRL or SHIFT key
while clicking), then clicking on the down arrow, you can have the names and associated
email addresses automatically entered into the To, CC and BCC sections of the Email
window. The up and down double arrow buttons can be used to move all of the names in
the Target Contacts box into the Recipients box and back again. Names can also be
moved between the two boxes by double-clicking directly on an individual name.
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Ti
p:

Contacts will not appear in the Email Recipients window if their contact
information does not include a valid entry in the Email field. Contacts that do not
have an email address entry can be found by excluding all contacts with an "@"
sign in the Email field, using the Search button on the Contacts screen.

 

Individual Emails

Checking the Individual box immediately below the first Contacts button (checked by
default), causes the program to send an individual email to each of the recipients in the 
To box, just as though you actually wrote and sent the emails separately to each person.
Each of the recipients receives the exact same email, except for any personal contact
information you may have merged into the email text. The email received by each person
is addressed specifically to them using only their name and email address, so there is no
way for them to tell that the email may have been broadcast to a larger group of
recipients. Unchecking the Individual box causes the program to send a single email to
all of the recipients in the To box, with everyone receiving everyone else’s email address
in addition to their own.

 

Attaching Documents

To attach one or more documents or files to your email, use the Attach button, located
next to the Attachments box, or just right click on the Attachments box and select Add
. To remove an attachment, select the item in the Attachments box, then right click and
select Remove. To view an attached file using its associated application, right click on it
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and select View. Emails containing attachments typically take longer to send than ones
without attachments. A progress bar, located in the lower left corner of the Email
window, indicates the percentage complete when sending lengthy emails or emails with
large attachments.

 

Merging Contact Information

In addition to conventional emails, you can also create and send mail-merge emails from
the program. To add a merge field to an email being created, use the Merge Field option
on the Insert menu or just click on the Insert Merge Field icon (freeway on ramp) on
the Email window toolbar. Merged fields are encased in double angle brackets to help
distinguish them from the regular text in your emails. You can leave the Merge Fields
window open and move freely back and forth between it and the main Email window while
composing an email.

If the custom edition for your company includes contact Profile information, the last
merge field selection will read "Recommended products". Inserting this merge field into
an email causes the program to read each recipient’s Profile settings and insert the
appropriate recommended products, prior to sending the email. Creating an email
"template" using this merge field allows you to use that template directly from the Profile
tab on the Contacts screen, to send a client their Profile information.

Merged emails are always sent individually, with the individual contact’s information being
merged into the letter just before it is sent. If the Individual box is not checked when
you click on the Send button with a merged email, the program will check the box
automatically before the email is actually sent. 

 

Inserting Images into Emails

Images can be inserted using the Picture option on the Insert menu in the Email
window or by clicking on the "camera" icon on the editing toolbar.

Many images can also be copied and pasted into the Email window including web page
content and images from Microsoft Word documents. Email content received in Microsoft
Outlook Express can also usually be copied and pasted directly into the Email window,
however, if images do not show up when you paste them into the program, try this
approach instead:

1. Open Outlook Express and save the email to a location somewhere on your computer
(e.g. your Desktop)

2. Go into the Email window in Consultant Front Office and use the Open option on
the File menu to open the saved email (.eml) file. To locate the file, you will need to
set the Files of type selection to Outlook Express Email Files (*.eml).

The images should then show up just as they looked in the original email.

 Setting a Default Font

To set default characteristics click on Options on the Tools menu then click on the
General tab. Click on the ellipsis (…) button to the right of the Default Font box to
select new font settings.

 

Setting a Default Template
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To set up a default email template, first create the template in the Email window and
save it to a known location on your computer’s hard drive. Then click on Options on the
Tools menu and use the ellipsis (…) button in the "Default Template" section of the
"General" tab to locate the saved template. Options in the "Default Template" section can
also be used to specify whether the program prompts you before using the template and
to turn template use completely off.
 

Email Spam Checking

The email function in the program has a built-in ability to help you reduce the likelihood
that emails you send will be blocked by a recipient ISP’s spam filters. To set up spam
checking in the Email window, click on Options on the Tools menu then click on the
Spam Detection tab. To check an email using your selected criteria prior to sending
click on the Spam Check option on the Tools menu.
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 Signature - Saving and Inserting

The program allows you to save and recall as many personal HTML "signatures" as you
choose. Because of the flexibility provided in this function it can also be used for inserting
any type of HTML content, regardless of whether it’s truly a "signature" or not.

To save a "signature" or other HTML content for use in the Email window just do the
following:

1. Enter and format the text you would like to save in the message section of the Email
window.

2. Highlight the text.

3. Click on the Save Selection As Signature option on the File menu.

4. Enter a name that you will remember this signature by and click on Save.

 

To insert a "signature" or other saved HTML content into an email either:

Click on the Signature option on the Insert menu OR

Click on the "pen" icon on the message toolbar
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Either of these will open the signatures window that will be positioned directly below the
toolbar in the lower half of the Email window. Double clicking on a signature or selecting
and clicking on Insert will insert the HTML content associated with that signature into
the Email window.
 

Ti
p:

The Save Selection as Signature option will not be available if you have not
selected at least one character of text in the message section of the Email
window. The Signature option on the Insert menu and the "pen" icon on the
message box toolbar will not be available if your have not yet saved at least one
signature.

 Email Address Syntax Checking

All recipient email addresses are automatically checked for correct syntax when the 
Send button is clicked. This validation process occurs prior to any emails being sent. If
an incorrectly formatted email address is found in the list of recipients, sending is halted
and the incorrectly formatted email address is displayed. Syntax checking does not verify
that an email address is valid and does not guarantee that the intended recipients will
actually receive all of the emails you send.

 

Recovering From Errors While Sending

If an error occurs while broadcasting an email to a group of contacts the program will display
the name of the current recipient, and will ask you if you would like to try to continue from
where the point where the error occurred. Selecting Yes causes the program to refill the To box
with the names and email addresses of only those recipients who have not yet received the
email, and then continue trying to send the email.
 

Emails Not Received by Recipient(s)

If the program displays Message(s) sent after clicking on the Send button, then your email(s)
has been successfully "handed off" to your email provider for attempted delivery. This does not
guarantee that the emails will in fact be delivered to the intended recipient, but it does indicate
that the program has done its part in the email delivery process. Please click on the 
Knowledgebase option on the Help menu for up-to-date information regarding email errors or
problems.
 

Email Errors

Email errors can be difficult to translate and oftentimes mean different things at different times
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and with different email providers. Please consult our Knowledgebase for the most current
information on this topic. To access our Knowledgebase click on the Support option on the
Help menu.

Automatic Notes Updating

The Preferences window (Preferences option on the Settings menu) has an option that reads
"Enter email subjects into Contact Notes". When this option is selected, the subject line from
every email you send is automatically entered into the recipient’s Notes field on the Contacts
screen.

5.2.17 Letters

 

The Letters function allows you to easily create personalized, mail-merge documents, for any
filterable, searchable or selectable group of contacts.
 

 

 

The Letters button on the Contacts screen displays the Letters window. This window combines word
processing capabilities with integrated mail-merge functionality, allowing you to create individualized
letters, newsletters or other documents that include each recipient’s personal contact information.
Any of the listing fields found on the Contacts screen can be merged into a document. Which
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contacts are available for merging into a document when you preview or print it, depends on the most
recent Filter, Search and Select operations. If no filtering, searching or selecting operations precede
merging then all of your contacts will be available for merging.

To create a mail-merge document, do the following:
1. Click on the Letters button on the top toolbar of the Contacts screen. This will display the Letters

window.
2. Prepare to insert a merge field by clicking on the Insert Merge Field toolbar icon or by selecting

the Merge Field option on the Insert menu. This will display the Merge Fields window.
3. Select a field from the Merge Fields window to be inserted into your document then click on

Insert. This will insert the selected field name into the current document and encase it in double
brackets (e.g. <<First Name>>) to indicate that this is a merge field. Merge fields can also be
inserted by simply double clicking in the Merge Fields window.

4. Repeat Step 3 as desired. Note that the Merge Fields window can be left open while editing the
actual document.

5. Finish creating the current document then close the Merge Fields window.
6. Save the document using either the Save option or the Save As option on the File menu.
7. Select the desired recipients for this document using the Select Recipients option on the File

menu or the corresponding toolbar icon.
8. Preview or print the document using the Preview or Print option on the File menu or the

corresponding toolbar icons.

 

Signature - Saving and Inserting

To save your personal signature for use in the Letters window just do the following:
1. Enter and format the text you would like to save as your signature in the message section of the 

Letters window.
2. Click on the Save Selection as Signature option on the File menu.

 

To insert your personal signature into a document either:
Click on the Signature option on the Insert menu OR
Click on the "pen" icon on the message toolbar

5.2.18 Mailing Labels

 

The Labels function on the Contacts screen allows you to easily merge information for any filterable,
searchable or selectable contact group onto any type of standard or custom mailing label. The list of
contact names included in the Target Contacts  box in the Address Labels window, always reflects
the most recent Filter, Search and Select results.
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Tip: To edit a label’s margins or to change the position of text on a predefined or custom label
click on Select, then click on Edit to open the Edit Label window. Only the top and left margin
settings can be changed for predefined labels. All changes made to margin settings will be
remembered for future use.

 

To print labels for some or all of your current "Target" contacts, or to print return address labels, do
the following:

1. Select a label to use for printing by clicking on the Select button and choosing a label from the
predefined list. If you need to create a custom label you can do so by clicking on the New button
in the Select Label window.

2. Select a label printing option using the Print Selection option buttons in the upper middle section
of the Address Labels window. Choose the All Target contacts option to print labels for all of the
currently filtered, searched or selected names listed in the Target Contacts box. Choose the
Selected contacts option if you want to manually select from the names listed in the Target
Contacts box. Choose the One page of return labels option to print a sheet of return address
labels using one selected contact (this option requires that you enter yourself as a contact on the 
Contacts screen).

3. If you chose to select contacts manually in Step 1, select the desired name or names in the
Target Contacts box. Holding down the CTRL key or the SHIFT key while selecting names
allows you to make multiple selections. Double clicking, or clicking on the right-pointing arrow
moves the selected names over to the Labels to Print box on the right.

4. Select a Row and Col to begin printing at if you are using a partially used sheet of labels. For a
new sheet, just set Row and Col both equal to 1. The program will remember your last Row and
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Col entries, and will automatically calculate the correct next setting for these entries every time
you print, based on the currently selected label and the number of labels printed.

5. To modify the Content or the layout of the content on the label, click on the Content button to
display the Label Content window, then select the contact fields you wish to print in the order
and position you wish them to be printed. Salutations and Middle Initials are automatically
combined with a first name anytime the First name field is selected. Selecting the First name
(addl) field in the box immediately to the right of a field containing First name results in an " and
" being added between the two fields, so that "Bob" and "Carol" becomes "Bob and Carol" when
the label is previewed or printed. The Header and Footer entry boxes in the Content window will
only be available if the size of the currently selected label allows room for a header and footer to
be printed. The number of content rows available is also dependent on the size of the currently
selected label.

 

 
6. To modify the Font used to print the label, click on the Font button to display the Label Font

window, then specify the font characteristics you would like to use.
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7. Click on Preview or Print to view or print your labels.

 

Tip: If the text on your labels is not positioned where you would like it to be, just do this:
1. Click on Select from the main Address Labels window.
2. Click on Edit in the Select Label window.
3. Adjust the left and top margin values.
4. Try printing again on a sheet of paper to check alignment.
5. The actual left and top margin values are not important and will vary from one printer to another.

Just adjust the values until the label text is positioned the way you would like it. Once they’re set
correctly, the program will remember your entries and you should not need to adjust them again.

5.2.19 Custom Labels
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Custom labels can be created and edited as follows.
1. Click on the Labels button on the Contacts screen to open the Address Labels window.
2. Click on the Select button in the Address Labels window to open the Select Label window.
3. Click on New to create a new custom label or Edit to edit a previously saved custom label.
4. Select the page orientation and enter a name to describe the custom label, if a new one is being

created.
5. Enter the number of labels across and down on a single page.
6. Enter the dimensions that define the label and its position on the page, using the yellow, numeric,

entry boxes, in the graphic part of the Edit Labels window. If appropriate, you may set some of
the dimensional entries to zero ("0.0").

7. Click on OK to save your entries.
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5.2.20 Custom Contact Fields

 

 

The Contacts screen includes four custom fields which you can name as you choose. These fields
can be handy for keeping track of a contact’s hobby, kids’ names, favorite food, or other "personal
touch" information. To change the name for one or more of these fields, simply click on the name to
open the Custom Fields window for editing. All of your contact listings and all of your active
businesses share the same names for these four custom fields.

5.2.21 Auto Dialing

 

The Dial button on the Contacts screen displays the Auto Dial window, allowing you to select a
telephone number to be automatically dialed. Auto dialing must be configured prior to dialing using
the Contacts - Auto Dial option on the Settings menu or by clicking on Setup from the Auto Dial
window.
 

 
Auto Dial Setup

The Auto Dial Setup window allows you to save the following settings:
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Comm Port:  Select the hardware port assignment that your modem is assigned to on your
computer

Find:  Causes the program to search for a modem installed on your computer

Hold open …:  Tells the program not to disengage itself after dialing. If this box is not
checked, the software will automatically "hang up" a few seconds after
dialing the number. As long as you have picked up a regular telephone
before this happens, the call is continued. This feature is generally only
required if you are using a speakerphone that’s actually built into your
computer.

Dialing Prefix:  Enter the number you have to dial to get an outside line (if any).

Long Distance Prefix:  Enter the number you have to dial before dialing a long distance
number (typically "1"). Also enter the area code from which you will be
placing calls.

International Prefix:  Enter the number you have to dial before dialing an international number
(typically "011"). Also enter the country code from which you will be
placing calls.

Include Custom Fields:  Checking any of these checkboxes tells the program that you are
using the associated fields to keep track of extra phone numbers,
causing these fields to be included in the list of selectable phone
numbers in the Auto Dial window.

 

Automatic Notes Updating

The Preferences window (Preferences option on the Settings menu) has an option that reads
"Enter phone calls in Contact Notes". When this option is selected, an entry is made into a
contact’s Notes field any time you use the Auto Dial window to dial that contact’s phone
number.
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5.2.22 Contact Notes

 

 

The Notes tab on the Edit Contacts screen allows you to keep a detailed history of meetings and
conversations between you and your contacts. The Date button provides a quick way to insert a date
into the Notes box. The Products buttons allow you to click-enter and product descriptions into a
contact’s Notes.

 

The Templates button on the Notes tab displays the Templates window, where you can access
saved templates or create new ones. Templates are pieces of saved text that can be recalled and
entered into a contact’s Notes without you having to re-type them each time. If you have a set of
questions or topics you like to regularly discuss with your customers or downline, you can put them
into a template so that they can be easily entered into a person’s Notes whenever you need them.

 

The program has the capability to make automatic Notes entries every time you complete an
appointment or task, use the auto-dialer, send an email or print a label. These options are available
via the Preferences window, which can be accessed using the Preferences option on the Settings
menu.

 

If you would prefer to have your most recent notes show up at the top of the Notes window, click on
the Options button on the Edit Contacts screen and select the option to "Use reverse scrolling when
entering Notes".

 

When you finish making entries in the Notes box for a contact, be sure and set a follow-up task or
appointment using the buttons provided at the bottom of the Notes tab on the Edit Contacts screen.
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The Notes field allows a maximum of 8000 characters for each of your contacts.

5.2.23 Contact Profiles

 

(Only available in specific custom editions)
 

The Profile tab on the Contacts screen allows you to track client responses to pre-loaded questions
and to print or email product recommendations based on those responses. This view is only available
in certain custom editions of the program. All of the choices offered on this screen are "pre-
configured" and cannot be changed.

 

 

The Profile tab consists of five selection boxes, two lists of checkboxes and a Recommended
Products display box. Making selections or checking off items will modify the list of Recommended
Products to the extent that these relationships have been pre-programmed into the custom pre-load
file for your company.

 

The Blank Form option on the Profile tab allows you email or print "blank" forms for your clients.
When your client returns the filled-out form to you enter their responses into the appropriate areas for
to refer to and for product recommendations.

 

The Completed Profile option on the Profile tab allows you to print out the selected customer’s
profile or to email it directly to them.

 

Clicking on the Email button on the Profile tab displays the Email window and automatically opens
a preloaded template that includes the merge field "<<Profile Info>>". This template can be modified
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and resaved. As long as you do not change the name or location under which the template is saved,
any changes you make to it will be reflected in the template each time you click on Email from the
Profile tab.

 

You can also merge "Profile Info" into any other email you create, including emails that are included
in a Schedule.

5.2.24 Ranking Contacts

 

The Rank tab on the Contacts screen allows you to define sets of criteria that you have found to be
characteristic of successful people, and then rank each of your prospects and / or team members
against those criteria to identify likely business builders. For example, you might want to rank
prospects on their entrepreneurial strength or on their ability to get along with different types of
people.
 

 

A different set of ranking criteria can be defined for each of your Group categories. To set Rank
criteria for one of your contact Groups, do the following:
 

1. Select the Group you want to create Rank criteria for in the Primary Group box on the Contacts
screen. You can also simply select a contact listing that has the desired Primary Group if you
choose.

2. Click on the Rank tab.
3. Click on one of the Criteria labels and enter ranking criteria in the pop-up window.
4. Click on Save to save your entries and close the pop-up window.
5. Repeat for additional criteria as appropriate.
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The currently selected contact does not need to be saved or resaved in order to save the Rank
criteria associated with the selected Group. Any time you select a contact or enter a new contact
using this Group, the criteria you have just entered will show on the Rank tab of the Edit Contacts
screen, allowing you to individually Rank each person in this Group against the same set of criteria.
Your contact database can then be filtered by Rank, making it easy to stay in regular contact with
your most promising people.

5.2.25 Contact Status

 

 

The Process tab on the Contacts screen allows you to define sets of steps that different groups of
contacts typically go through, and then keep track of each contact’s status in their respective
process. For example, a process might involve having someone attend a party, lending them a
product, and then giving them a business presentation..

 

A different set of process steps can be defined for each of your Group categories. To set a Process
step for one of your contact Groups, do the following:
 

1. Select the Group you want to create Process steps for in the Primary Group box on the
Contacts screen. You can also simply select a contact listing that has the desired Primary
Group if you choose.

2. Click on the Process tab.
3. Click on one of the Criteria labels and enter a Process step in the pop-up window.
4. Click on Save to save your entry and close the pop-up window.
5. Repeat for additional steps as appropriate.

 

The currently selected contact does not need to be saved or resaved in order to save the Process
steps associated with the selected Group category.
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Any time you select a contact or enter a new contact using this Group, the steps you have just
entered will show on the Process tab of the Edit Contacts screen, allowing you to individually track
each person in this Group against the same set of Process steps. Your contact database can then
be filtered by Process status, allowing you to quickly identify and communicate with people who have
or have not yet completed a particular step in their process.

5.2.26 Follow-up

 

Viewing or Editing a Contact’s Next Appointment and Task

Immediately below the Notes box on the Notes tab of the Contacts screen, you will see
displayed the next appointment and task you have scheduled with the selected contact. Using
the New, Edit and Del buttons provided, you can easily create a new appointment or task or
edit the next scheduled one. This allows you to set a follow-up action immediately after talking
with a prospect and updating their notes, and without having to switch to the Calendar or
Tasks screen.

 

Viewing or Editing All of a Contact’s Appointments, Tasks and Scheduled Emails

A list of appointments, emails and tasks for each of your contacts is available via the
"binoculars" icon on the Listing tab of the Edit Contacts screen. This list includes both
scheduled and manually entered activities, all of which can be edited or deleted by right clicking
in the Activities window. Appointments and tasks can be created, edited or deleted from this
window by right clicking and selecting from the context menu. Scheduled emails can be
deleted but not created or edited from this window by right clicking.

5.2.27 Event History

 

 

 

 

The Event History window is displayed by clicking on the firecracker icon to the right of the Last
Event and Next Event boxes on the Edit Contacts screen. This window lists all of the Events with
which this contact has been associated. 

 

In most cases, a contact becomes associated or "linked" to an Event when you enter what they
bought on the Edit Sales screen and select an Event to link the sale to. However, you can also add
someone to an Event by clicking on the Add button in the Event History window to display the Link
To Event window. Adding a person to an Event in this manner enables all of the same filtering and
reporting options that are available when they are linked via the Edit Sales screen. Contacts can also
be linked to an Event by editing the Event and adding them to the list of "Invitees / Attendees".
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5.2.28 Importing Contacts

 

The program can import contact information in either comma-delimited or tab-delimited format. To
import a file containing data formatted in one of these two manners do the following:

1. Select the Import option from the File menu.

2. Select the appropriate format in the Import File Type window and click OK.

 

3. Select the file to be imported from the File Open window.

4. Click on Open to display the Import Contacts window where you will match the fields in the
import file to their counterparts in Consultant Front Office.
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5. If you have previously saved a Template that matches the "structure" of the file being imported,

you can use the template to match up the fields in the import file with their counterparts in
Consultant Front Office. To do this, click on the Templates button, then select the template from
the Import Templates window and click on Open.
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6. If you have not previously created a Template for this type of file, match the fields in the Import

Fields box with their counterparts in the Contact Fields box. If the Import Fields box contains
heading information for the various fields in the import file, this process is usually straightforward. If
the Import Fields box contains only actual contact information (e.g. "John", "Smith", "123 Oak
St." instead of "First Name", "Last Name", Address" etc.) then you will have to carefully determine
which piece of information is to be put into each Consultant Front Office Contact Field.

7. To match the fields in the Import Fields box to those in the Contact Fields box, do the following:

7.a. Look in the Contact Fields window for the first unmatched field (e.g. "First Name").

7.b. Look in the Import Fields window for the entry that contains the information for this Contact
Field and either double click on it, or click once on it and then click on the left arrow, to move
that entry into the Match Fields box immediately across from its corresponding Contact Field.

7.c. If one or more of the fields in the Contact Fields box does not have a matching entry in the
Import Fields box, use the No Match button to fill the spot immediately across from this
Contact Field in the Match Fields box. When this step is complete, the contents of the
Match Fields box should be immediately adjacent to their Contact Fields counterparts.

8. Duplicate Checking: Selections made in the Duplicate Checking section of the Import window
instruct the program which fields to check in determining whether an entry in the file being
imported already exists in your contact database. An exact phone or address match, if those
options are selected, will prevent a record from being imported. The number of rejected duplicates
will be reported when importing is completed.

9. Duplicate Response: Allows you to specify what action should be taken when a duplicate
contact is identified in the import file. Selecting the Skip option causes the program to ignore
duplicate entries completely. Selecting the Overwrite option causes the program to overwrite the
entries it currently has for that person with the information in the import file. The number of
duplicate entries skipped or overwritten will be reported once importing is completed. A list
containing the names of all duplicate entries is also written to your Windows Desktop after
importing and placed in a file called "Duplicates.txt".

10. Import Options: Selections made in the Import Options section of the Import window allow
you to control how the information in the import file is processed during importing as follows:

10.a.  Skip first record: Instructs the program to skip the first record in the import file. Select this
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option if the file being imported contains field headings.

10.b.  Mix case: Instructs the program to impose normal capitalization on the entries being
imported.

10.c.  Parse salutation: Instructs the program to search for salutations (e.g. Mr., Mrs. etc.) in the
first name entries being imported. If a salutation is found, it is imported into the Salutation field
during importing. The Match Field entry adjacent to the Salutation Contact Field is ignored
when this option is selected.

10.d.  Parse M.I.: Instructs the program to search for middle initials in the first name entries being
imported. If a middle initial is found, it is imported into the Middle Initial field during importing.
The Match Field entry adjacent to the Middle Initial Contact Field is ignored when this
option is selected.

11. If you would like to save your Match Field settings for future use with import files having an
identical structure, click on the Templates button, then on Save, then enter a name in the Save
As box and click on Save.

12. Click on Import. The program will display a progress meter and will confirm the number of
imported and rejected listings when importing is completed.

 

 

All imported contacts are given a primary Group of Import.

You can easily change the primary Group for all imported listings using Contacts option on the
Categories menu. 

5.2.29 Exporting Contacts

 
 

The program can export contact information in comma-delimited format (CSV) to a file specified by
you, using the Export - Contacts option on the File menu. Exporting always reflects the results of
your most recent Filter, Search and Select operations, allowing you to selectively export any
filterable or searchable group of contacts..

 

The program can also export just email information in comma-delimited format (TXT) to a file specified
by you, using the Export – Email List option on the File menu. This function is specifically designed
to create files for uploading to Internet-based mailing programs. The export file contains each
contact’s name and email address, and is generally ready for uploading immediately after exporting.



Consultant Front Office Version 1192

© 2011 MLM Software Solutions, Inc.

5.3 Calendar

5.3.1 Overview

 
  

The Calendar section of the program is used to set, edit, view and print appointments. Appointments
can be stand-alone or they can be linked to one of your contacts. Linking an appointment to one of
your contacts allows you to print phone numbers and notes for that contact when you print a list of
your appointments. Appointments that are created from the Edit Contacts screen are automatically
linked to a contact when they are created.
 

 

5.3.2 View Options

 

Three views are available when you click on the Calendar button. You can change to a different view
at any time, either by clicking on one of the Daily, Weekly or Monthly buttons in the upper left-hand
corner of the screen, or by using the right-click menu.

All three Calendar views are controlled by the selection in the Filter box at the top of the Calendar
screen. The selection made in the Filter box specifies whether all of your appointments are displayed
or only appointments with a specific Category setting. If you are unable to find an appointment
you’ve entered, try setting the Filter box to "(All Categories)" to ensure the appointment is not being
filtered based on its Category setting.

 

The Daily, Weekly and Monthly views all allow you to create, edit, delete, view and print
appointments. New, edit and delete options are always available via right-click menus. Existing
appointments can also be edited by simply double clicking on the appointment. Additionally,
appointments can be created and edited in the Daily and Weekly views using the New, Edit and
Delete buttons at the bottom of the screen. The Calendar Options window (Options button on the
Calendar screen) has an option allowing you to choose to Show start times only in Monthly view,
thus saving space and allowing more of the appointment message to be shown on the screen.

 

The Daily, Weekly and Monthly views all include Preview and Print buttons in the upper left and
upper right corners of the screen, for previewing or printing the currently displayed appointments.
 

Daily View

The Daily view shows all of your appointments for a given day in a "Day-Timer" type display.
Appointments that overlap or start within the same hour are shown side by side on the screen.
Appointments that are scheduled for the selected day, but do not have a specific starting time,
are shown in the All Day section at the top of the display. The gray box in the lower right hand
corner of this view serves two purposes. If the Contact Info option is selected, the box displays
the contact information for the person who is linked to the selected appointment (if any). If the 
Appointment Notes option is selected, the box displays any Notes that were entered when
the appointment created or edited.
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Weekly View

 The Weekly view shows all of your appointments for the selected week. Appointments for
each day are listed in chronological order. If more appointments exist for a given day then can
fit into the available space, an ellipsis (…) will show in the caption bar for that day.
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Monthly View

The Monthly view shows all of your appointments for the selected six-week time period. This
display can be scrolled one week at a time. Appointments for each day are shown in
chronological order. If more appointments exist for a given day than can fit into the available
space, an ellipsis (…) will show in the caption bar for that day. Clicking on the ellipsis causes
an extended window to become visible that displays all of your appointments for the selected
day. 
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Clicking on the Options button on the Calendar screen displays the View Options window
allowing you to select from the following display options.

Category colors Allows you to specify a color for each different appointment
Category.
 

Daily view start hour Allows you to specify the default starting hour for the daily view.
 

Show start times only… Instructs the program to leave off appointment ending times in
the monthly view.
 

Show month in each
day…

Instructs the program to include the name of the month in each
day of the monthly view.
 

Use backcolor for
monthly …

Instructs the program to use a gray backcolor for each day’s
label in the monthly view.
 

Impose Calendar Filter
…

Causes the Tasks list that appears on the Calendar screen to
be filtered using the Filter setting at the top of the Calendar
screen (this option does not affect the task filtering setting on
the Tasks screen).
 

Always start with
todays …

Instructs the program to revert to today’s date each time it is
opened rather than to remember the last-selected date.
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Show reminders for … Instructs the program to display a pop-up reminder whenever an
appointment or appointment alarm time comes due.
 

Beep when
appointments …

Instructs the program to "beep" when appointments.

Three different selections are also available in the lower right corner of the Daily and Weekly
views on the Calendar screen as follows:

Contact Info: Displays listing information for the contact who is linked to the currently
selected appointment. If no appointment is selected or if there is no
contact link for the selected appointment, this area will be blank (gray).
 

Appt. Note: Displays the Note associated with the currently selected appointment. If
no appointment is selected or if the selected appointment does not have
a Note entry, this area will be blank (gray).
 

Tasks: Displays a miniature version of the Tasks screen. If the Option is
selected to "Impose Calendar filter on Tasks list" then this list will reflect
the current setting in the Calendar Filter box. If not, it will reflect the
current setting of the Filter box on the Tasks screen.

5.3.3 Creating an Appointment

 

Appointments can be created in any of the following ways.
1. By clicking on the New button in the Daily or Weekly views of the Calendar.
2. By right clicking anywhere on the calendar in the Daily, Weekly or Monthly views.
3. By clicking on the New button in the Notes view of the Contacts screen.
4. By clicking on one of the hour time boxes in the Daily view of the Calendar.
5. By assigning a Schedule of appointments to a contact, using the Schedule box on the

Contacts screen.
6. By entering a Birthday for one of your contacts on the Edit Contacts screen.
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Creating an appointment using the any of the first three methods displays the Appointments window
allowing you to specify additional information regarding the appointment.

5.3.4 Editing an Appointment

 

Appointments can be edited in any of the following ways.
1. By double clicking directly on the appointment in the Daily, Weekly or Monthly view of the

Calendar screen.
2. By selecting the appointment in the Daily or Weekly view and then clicking on the Edit button.
3. By right clicking on the appointment in the Daily, Weekly or Monthly view and then selecting

Edit.
4. By using the Edit button in the Notes view of the Edit Contacts screen.
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(Appointments are also automatically updated whenever you change a contact’s Schedule
assignment or Birthday entry and then click on Save in the Edit Contacts screen)
 

Editing an appointment displays the Appointments window, allowing you to specify the following
information.

Message The message you want displayed when the appointment comes due and in printed
reports.

Category The category you would like to associate this appointment with for filtering purposes.

Contact The contact, if any, that the appointment is linked to.

Date The date of the appointment.

Time The beginning and end time of the appointment (if un-checked, the appointment will
be show as an appointment for that day but will not have a specified time).

Repeat The type of appointment being created (please see below).

Alarm Determines whether and when an alarm will be displayed prior to the actual
appointment time.

Private This field has no impact within the program but allows you to mark an appointment
as Private for use with Palm-Compatible handheld organizers.

 

Clicking on the ellipsis (…) next to the Repeat box in the Appointments window displays the
Repeat Appointment Settings window, allowing you to specify the type of repeat appointment and
the frequency with which it should be repeated. Selecting Monthly in the Repeat Appointment
Settings window allows you to additionally specify whether the appointment should repeat based on
the actual date of the original appointment or based on the day of the week. Specifying that the
appointment should repeat on a given day allows you to set up appointments that occur on a given
day in a given week of each month (e.g. the third Thursday of each month). The day and week will be
determined by the day and week of the date entered in the Appointments window.

5.3.5 Deleting an Appointment

 

Appointments can be deleted in any of the following ways.
1. By selecting the appointment in the Daily or Weekly view and then clicking on Delete.
2. By right clicking on the appointment in the Daily, Weekly or Monthly view and then selecting

Delete.
3. By clicking on the Delete button in the Notes view of the Contacts screen.
4. By editing or deleting a Loanout transaction and follow-up date.
5. By changing an appointment schedule assignment using the Schedule box on the Contacts

screen.
6. By changing a contact’s Birthday using the Birthday box on the Edit Contacts screen.

 

If the appointment is set to repeat, you will be prompted to specify whether you would like to delete
all of the appointment’s occurrences or just the current one. Choosing to delete just the current
occurrence leaves all other occurrences unchanged.

You can also delete blocks of appointments using the Delete Calendar option on the File menu. This
feature allows you to delete all appointments set to occur before a specified date.
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5.3.6 Filtering Appointments

 

The Calendar screen allows you to divide your appointments into categories you define using the
Tasks / Calendar option on the Categories menu. Specifying different Category settings for your
appointments allows you to view them by Category using the Filter selection box on the Calendar
screen. Simply select the Category(ies) you would like to view and the display will be automatically
updated.

 

The Calendar also allows you to view appointments based on whether or not they are set to occur at
a specific time. This allows you to view and print calendars for birthdays and other "un-timed" events
separately from calendars containing your actual day-to-day activities.

 

To view all of your appointments according to the options you have selected using the Options button
click on Select All in the filtering window, then click on OK.

5.3.7 Printing Appointments

 

All three views in the Calendar have Preview and Print buttons located in the upper left and upper
right hand corners of their calendar displays. These buttons always preview or print the day, week or
month that is currently displayed. The Print button in the lower right hand corner of the Daily and
Weekly calendar views, displays the Print Appointments window, allowing you to print a list of past,
present or future appointments in half or full-page format.
 

To print your appointments for a given day or range of days, either click the Print button in the upper
right hand corner of the Calendar screen or do the following:

1. Click on the Print button in the lower right hand corner of the Daily or Weekly calendar view to
display the Print Appointments window.
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2. Select one of the options in the Report Options section of the window as follows: The Today’s

appointments option always prints today’s appointments, no matter what day or week is
currently displayed. The "Current week’s appointments" always prints appointments for the week
that includes today’s date, no matter what day or week is currently displayed. The "Appointments
for the next xx day(s)" option always begins with today’s appointments, no matter what day or
week is currently displayed. The "Appointments from" option allows you to print appointments for
any specified past, present or future time period.

3. Select either the Half-page or Full-page format.
4. For the Full-page format only, select any desired options from the Additional Options section of

the window. These options allow you to customize your appointment printout to meet your needs
by including: a list of the Process steps a linked contact has completed, any Notes that you have
entered with your appointments, or any Notes that you have entered for a linked contact.

5.3.8 Printing a Monthly Calendar

 

The Monthly view in the Calendar screen allows you to Preview or Print a monthly calendar
covering whatever days are currently displayed on the screen. The Preview and Print buttons are
located respectively in the upper left and upper right hand corners of the Monthly view in the
Calendar screen.

 

The View Options window (Options button on the Calendar screen) has an option allowing you to
choose to "Show start times only in Monthly view", thus saving space and allowing more of the
appointment message to be shown on the screen and in the printed monthly calendar.
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5.3.9 Linking Appointments to a Contact

 

Appointments can be either stand-alone or they can be linked to one of your contacts. Linking
appointments that are associated with one of your contacts offers several benefits.

1. Contact information is automatically displayed in the Contact Info window of the Daily or Weekly
view whenever that appointment is selected.

2. Contact information is automatically included when you print an appointment summary.
3. The next scheduled appointment for each contact automatically appears in the Notes view of the

Edit Contacts screen anytime that contact is selected. (Appointments created from the Edit
Contacts screen are automatically linked to the correct contact.)

 

To link an existing appointment to one of your contacts simply edit the appointment and select the
correct contact’s name in the Contact box of the Appointments window.

 

A complete list of all of a person’s activities, including appointments, can be viewed by selecting that
person on the Edit Contacts screen and then clicking on the "binoculars" icon next to the
Schedule / Start Date box also on the Edit Contacts screen.

5.3.10 Pop-Up Reminder

 

The program will automatically pop up an appointment reminder window anytime an appointment or
an appointment alarm time comes due, if you have selected that option using the Options button on
the Calendar screen. Appointment status is checked once every minute. A maximum of ten
appointment reminders can be visible on the screen at one time. If the number of due appointments is
greater than ten, the program will wait to display later appointments until earlier reminders are
dismissed by clicking on the Complete button.

 

Reminders that are displayed before the actual appointment time in response to an alarm that’s been
set will have a yellow bar across the top with a caption that indicates the time that remains before the
appointment becomes due. Reminders that are displayed at or after the actual appointment time will
have a red bar across the top with a caption indicating that the appointment is now due.
 

 

The appointment reminder window offers the following options.
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Complet
e

Permanently dismisses the alarm or appointment reminder. Clicking Complete for an
appointment alarm that appears before the actual appointment time, will not prevent a
reminder from being shown when the actual appointment time arrives.

Dial Displays the Auto Dial window containing all of the linked contact’s phone numbers.

Notes Displays Contact Notes for the person associated with this appointment for reference
or for editing.

Print Prints the appointment information.

Edit Opens the Appointments window allowing you to edit the appointment.

Sleep Temporarily hides the appointment reminder for the specified length of time.

 

Checking the Alarm checkbox when creating or editing an appointment, will cause an appointment
reminder to pop up first at the selected alarm time and then again at the actual appointment time.
Clicking on Complete when the "alarm-time" reminder pops up will permanently dismiss the alarm
reminder, but will not prevent the actual appointment reminder from being displayed unless the actual
appointment time has already passed when the alarm reminder is dismissed.

5.4 Tasks

5.4.1 Overview

 
 
 

The Tasks List section of the program is used to set, edit, view and print tasks you need to complete.
Tasks can be stand-alone or they can be linked to one of your contact listings. Linking a task to one
of your contacts allows you to print phone numbers and Notes for that contact when you print a list of
your tasks.
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The tasks displayed on the Tasks List screen are controlled by the selection in the Filter box at the
top of the Tasks List screen. The selection made in the Filter box specifies whether all of your tasks
are displayed or only tasks with a specific Category setting. If you are unable to find a task  you’ve
entered, try setting the Filter box to "(All Categories)" to ensure the task is not being filtered based
on its Category setting.

5.4.2 View Options

 

Clicking on the Options button in the Tasks List screen displays the View Options window allowing
you to select from the following display options.
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Hide completed tasks Instructs the program to exclude tasks that have been marked 
Complete.
 

Show completed tasks Instructs the program to include tasks that have been marked 
Complete.
 

Show tasks completed
today

Instructs the program to hide tasks that have been marked 
Complete unless they were completed today.
 

Show incomplete tasks
… no due date

Instructs the program to include incomplete tasks that have no set 
Due Date.
 

Show incomplete tasks
… not yet due

Instructs the program to include incomplete tasks with a Due Date
that’s later than today.
 

Show incomplete tasks
… now due

Instructs the program to include incomplete tasks that with a Due
Date that’s on or before today.
 

Change due date to
date…

Instructs the program to overwrite the Date Due field with the date
that a task is marked as Complete.
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Show due dates Instructs the program to include the Date Due field.
 

Show priorities Instructs the program to include the Priorities field.
 

Show categories Instructs the program to include the Categories field.
 

Show home phone Instructs the program to include the home phone number field.
 

Show work phone Instructs the program to include the work phone field.
 

Show cell phone Instructs the program to include the cell phone field.
 

Show email Instructs the program to include the email address field.

 

You can sort the tasks shown in the Tasks List screen display by simply clicking on any of the
column headings. Clicking on the same column more than once toggles the sort between ascending
and descending order.

5.4.3 Creating a Task

 

Tasks can be created in one of three ways.
1. By clicking on the New button in the Tasks List screen.
2. By right clicking on the task display portion of the Tasks List screen and then selecting New.
3. By using the New button in the Notes view of the Edit Contacts screen.

 

 

All of these methods display the Task Info window allowing you to enter the information associated
with the new task.
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5.4.4 Editing a Task

 

Tasks can be edited in one of three ways.
1. By selecting the task in the Daily view and then clicking on Edit.
2. By right clicking directly on the task and then selecting Edit.
3. By using the Edit button in the Notes view of the Edit Contacts screen.

 

 

 

Editing a task displays the Task Info window, allowing you to specify the following information.

 

Task A description of the task to be completed.

Priority The importance of the task (1=high, 5=low).

Status The current status of this task

Date Due The date the task must be completed by (if any).

Category The category that best describes the task.

Contact The contact with which this task is linked (if any).

Private Allows you to hide tasks when syncing with a Palm-compatible organizer.

5.4.5 Deleting a Task
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Tasks can be deleted in one of three ways.
1. By selecting the task and then clicking on Delete.
2. By right clicking directly on the tasks and then selecting Delete.
3. By using the Delete button in the Notes view of the Contacts screen.
4. By right clicking in an Activities window and then left clicking on Delete.

5.4.6 Filtering and Sorting Tasks

 

The Tasks List screen allows you to divide your tasks into categories you define using the Tasks /
Calendar option on the Categories menu. Specifying different Category settings for your tasks
allows you to view them by Category using the Filter selection box on the Tasks List screen.
Simply select the Category(ies) you would like to view and the display will be automatically updated.
To view all of your tasks according to the options you have selected using the Options button click
on Select All in the filtering window, then click on OK.

 

You can also sort your task display by simply clicking on any of the column headings. Clicking more
than once toggles the sort between ascending and descending order.

5.4.7 Printing a Task

 

The Print button in the lower right hand corner of the Tasks List screen displays the Print Tasks
List window, allowing you to print the list of tasks currently displayed in the Tasks List screen.

To print a list of your tasks do the following:
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1. Use the Filter selection box along with the view Options button to display your tasks the way you
would like them printed. To sort the Tasks List display, just click on any of the column headings.
(Note: all columns are automatically included in the printout even if you have elected not to have
one or more of them displayed in the Tasks List screen).

2. Click on the Print button from the Tasks List screen to display the Print Tasks List window.

 

 
3. Select either the Half-page or Full-page format.
4. For the Full-page format only, select any desired options from the Additional Options section of

the window. These options allow you to customize your appointment printout to meet your needs
by including:

5. A list of the Process steps a linked contact has completed
6. Any Notes that you have entered with your appointments
7. All of the phone numbers or Notes that you have entered for a linked contact.

5.4.8 Linking Tasks to a Contact

 

Tasks can either be stand-alone (e.g. Make copies) or they can be linked to one of your contact
listings. Linking tasks are associated with a contact offers several benefits.

1. Contact information is automatically included when you print a task summary.
2. The next incomplete task for each contact automatically appears in the Notes view of the Edit

Contacts screen anytime that listing is selected.
3. All of the incomplete tasks for each contact automatically appear in the Activities window that

can be accessed via the "binoculars" icon on the Edit Contacts screen.

 

To link an existing task to one of your contact listings simply right click on the task in the Tasks List
screen, then click on Edit to display the Task Info window. Locate the box labeled Contact, then
either click into the box and begin typing the contact’s last name or simply click on the button on the
right side of the box and select the name from the Contacts selection window. New appointment links
are created in a similar manner. Contact links can be removed by clicking on the button and then
click on the Remove Link button in the Contacts selection window.

 

A complete list of all of a person’s activities, including tasks, can be viewed by selecting that person
on the Edit Contacts screen and then clicking on the "binoculars" icon next to the Schedule / Start
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Date box also on the Edit Contacts screen.

5.5 Memos

5.5.1 Overview

 

The Memos window is used for creating, editing and deleting memos. It is accessed by clicking on
the note pad icon on the left side of the Current Time Period toolbar. The list of memos visible in
this window can be filtered by making a selection in the Filter box.  New memo categories can be
added to the Filter box using the Memos option on the Categories menu. You may save as many
memos as you like. Each memo can be up to 4000 characters in length.
 

5.5.2 Creating a Memo

 

To create a memo, you must first open the Memos window, which can be accessed by clicking on
the notebook icon to the left of the Current Time Period toolbar (near the top of the main program
window). Memos can then be created in one of two ways.

1. By clicking on the New button in the Memos window.
2. By right clicking on the memo display table in the Memos window and then selecting New.
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Both of these methods display the Memo window allowing you to enter the memo text and select a
memo category for filtering purposes.

5.5.3 Editing a Memo

 

Memos can be edited in the following ways.
1. By selecting a memo from the list in the Memos window and then clicking on Edit.
2. By right clicking directly on a memo from the list in the Memos window and then selecting Edit.
3. By double clicking directly on a memo from the list in the Memos window.
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All of these methods display the Memo window, allowing you to modify the selected memo. The
Private box in the Memo window allows you to hide memos when interfacing with a Palm-compatible
handheld organizer.

5.5.4 Deleting a Memo

 

Memos can be deleted in the following ways.
1. By selecting the memo from the list in the Memos window and then clicking on Delete.
2. By right clicking directly on the memo and then selecting Delete.
3. By deleting the memo from the Notes tab on the Contacts screen.
4. By right clicking and deleting the memo via the Activities window on the Contacts screen (click

on the "binoculars" icon).

5.5.5 Filtering Memos

 

The Memos window allows you to divide your memos into categories you define using the Memo
option on the Categories menu. Specifying different Category settings for your memos allows you to
view them by Category using the Filter selection box in the Memos window. Simply select the
Category you would like to view and the display will be automatically updated. To view all of your
memos select All categories (the topmost Filter setting).

5.5.6 Printing a Memo

 

Memos can be previewed or printed by selecting the memo for editing and then clicking on the 
Preview or Print button in the Memo window.



Part

VI

Financial Management
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6 Financial Management

6.1 Overview

 

 

The program is designed to handle all of your business’s financial management needs and to
generate tax-ready reports for income and sales tax filing. The financial management section of the
program consists of up to eight main screens as follows:

 

Goals used to enter financial and recruiting goals and to track your progress
against them (Professional Editions only)

Income /
Expenses

used to enter non-product income and expenses

Sales used to enter sales you make to your customers

Purchases used to enter purchases you make from the company you sell products for

Vehicles used to enter mileage and expenses involving business use of personal
vehicles (Standard and Professional Editions only)

Home Office used to enter expenses associated with a home office (Professional Editions
only)

Taxes used to help you prepare tax reports or request a free tax preparation quote.

Also used to export your records to TurboTax® or TaxCut® (Professional
Editions only)

 

There are also a number of menu items at the top of the main program window that are part of the
financial management system, including:
 

Categories used to edit Income and Expense categories and product and Event
information

Settings used to access some financial settings

Accounts used to access your cash, checking and credit card account registers

Personal Use used to track product taken for your personal use

Samples used to track product taken as promotional samples

Loans used to track products you loan or borrow (Std and Pro only)

Trades used to track product trades (Std and Pro only)
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Inventory used to make occasional inventory adjustments (full-inventory edition only)
 

 

Detailed information on all of these functions can be found by locating the topic in the main Table of
Contents.

6.2 Setup

6.2.1 Setting Freight Rates

 

Purchases

There is typically no need to set freight rates in the program for product purchases. The freight
charge on product purchases should generally be copied directly from your company’s invoice,
mak ing freight settings for purchases unnecessary.

 

Sales

Freight rates for product sales are entered using the Settings buttons on the Edit Sales
screen. This window can also be accessed via the Setup Wizard option on the Help menu
and by clicking on the Freight label on the Edit Sales screen.
 

 

If you would like the program to calculate and enter freight for you on the Sales screen, check
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the checkbox at the top of the Sale Settings window.  In general, it is usually easier to enter
freight on product purchases manually, while allowing the program to calculate and enter the
freight for you on product sales.

 

Company-specific: In some custom editions of the program, the Company-specific freight
calculation option will be enabled. Checking this box instructs the program to calculate freight
charges using the method your company employs to determine freight charges. Company-
specific freight calculations are handled automatically by the program, hence none of the User-
defined settings will have any impact on freight calculations when this option is selected.

 

User-defined:  When the User-defined freight calculation option is selected, the amount of
freight automatically entered on product sales is calculated as follows. First, the program
multiplies the freight rate, if any, times the total cost, price or weight of the product(s) being
purchased or sold. Second, it compares this result with the minimum / fixed charge, selects
whichever value is higher, and adds to it any handling charges. If you don't specify a minimum /
fixed charge, the freight calculated will always be the freight rate times the total product cost,
price or weight, plus handling. If you don't specify a freight rate, the freight calculated will
always be the fixed / minimum charge plus handling.

6.2.2 Setting Tax Rates

 

Purchases

There is typically no need to set tax rates in the program for product purchases. The tax charge
(s) on product purchases should generally be copied directly from your company’s invoice,
mak ing tax settings for purchases unnecessary (see Step 3 below).

 Sales

Tax rates for sales are entered using the Settings buttons on the Edit Sales screen. This
window can also be accessed via the Setup Wizard option on the Help menu and by clicking
on the Tax label on the Edit Sales screen.
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To configure your tax settings using the Tax tab in the Sale Settings window, just do the
following:

1. Check the first checkbox if your state, province or country charges sales or VAT tax on any
of the products you sell. This setting affects both Purchases and Sales. Checking or un-
checking this box in either the Purchase Settings or Sale Settings window will cause it to
have the same setting in the other window. If none of your products are subject to sales or
VAT tax, leave the first checkbox un-checked and click on Save. You are finished
configuring your tax settings.

2. Check the second checkbox if your state, province or country has two different sales or VAT
tax rates for any of the products you sell. This setting affects both Purchases and Sales.
Checking or un-checking this box in the Purchase Settings or Sale Settings window will
cause it to have the same setting in the other window.

3. Check the third checkbox if you would like the program to calculate and enter tax for you on
the Purchases or Sales screen. In general, it is usually easier to enter tax on product
purchases manually, while allowing the program to calculate and enter the tax for you on
product sales.

4. Enter the rate at which some or all of your products are taxed in the Tax Rate 1 box. The
name used to identify this tax rate can be changed by clicking on the label and entering a
new name.

5. Select the option describing how this tax rate is applied using the option buttons
immediately below the tax rate box. The Actual Cost or Actual Price and Actual Cost +
Frt or Actual Price + Frt options use the net price of the products after any discount is
applied in determining the taxable product total. Business Items entered on the Purchases
or Sales screen are always assumed to be taxable.
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6. Repeat Steps 4 and 5 for your second tax rate if applicable.
7. If you have selected one of the tax options that include tax on freight you may select the

option to Only tax freight allocated to taxable items if this is how your state or province
charges tax. If this option is not selected, freight will always be fully taxed whether or not a
PO or Invoice includes other taxable items.

8. Click on Save to save your settings and close the window.
9. Click on the Product option on the Categories menu and set the default taxability for each

individual product as appropriate.

6.2.3 Products

 

 

 

The Products window shows the list of products that have been entered or imported into the software.
There are four options that affect this display, three of which also affect operation of the program on
other screens as follows:
 

Show product groups Allows you to associate individual products with "groups" for selecting
and reporting purposes

Hide inactive
products

Hides inactive products in the Products window (this option only
affects the Products window)

Show Alt Cost field Allows you to specify two different "cost" values for each product

Show volume fields Allows you to track "volume" on product purchases and sales
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Adding Products

To add a new product to the program, do the following:
1. Click on the Products option on the Categories menu to display the Products window.
2. Click on the New button in the Products window to display the Add Products window.

 

 
3. If you have selected the option to "Show product Groups" in the main Products window,

then select the group you would like to add this product to in the Group selection box.
4. Enter the product’s Item # and Description in the boxes provided.
5. Enter the product’s retail price in the Unit Price box. When you exit from this box all of the

visible cost and volume fields will be populated with the entry you made in the Unit Price
field. For most companies, setting these fields to the retail price of a product is the right
thing to do since your "cost" is determined by applying a discount to the retail price. If so
you can just tab through the boxes until you get to the Min Qty box. If you need to make
changes along the way, just tab or click into a box and the program will highlight the
existing entry making it easy to overwrite that entry when you type in a new one.

6. Enter the product’s wholesale cost in the Unit Cost box and its member cost in the
Alternate Cost box if these values have not already been correctly entered by the program..
If your cost in purchasing products is determined by applying a discount to the retail price
then the retail price should be entered into both of these boxes.

7. Enter the volume numbers associated with the product in the Vol 1 and Vol 2 boxes
(optional).

8. The two "tax" checkboxes at the bottom of the Product window will only be "enabled" if you
have previously indicated that some or all of your product sales are subject to sales or VAT
tax (see Setting Tax Rates).  If the product you are entering is taxable, check one or both of
the checkboxes at the bottom of the window to indicate which tax rate(s) this particular
product is subject to.
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9. Click on Save to add this product to the program’s list of products.

 

Editing Product Information

To edit product information, do the following:
1. Click on the Products option on the Categories menu to display the Products window.
2. Locate the product and double click on the entry to be edited.
3. If you are editing the Item # field, an entry box will be displayed when you double click to

edit. Enter the new item number into the entry box and click on Save. If you are editing any
other field, simply make your changes in the Products window.

4. Click on Save to save your changes and close the Products window.

Tip: Use the "arrow" keys on your keyboard to navigate quickly in the Products window. Using
the arrow key to move from one row to the next avoids the need to double click on an entry in
order to change it. To quickly set the Active or Tax status of your products, use the arrow
keys to move from one row to the next, and the space bar to check or un-check each
checkbox.

 

Setting Products to Active or Inactive

Products that are set to "Active" are included in all of the program’s product selection boxes.
Products that are not set to "Active" will only be included in the program’s selection boxes and
displays if you are displaying or editing a record that was based on the inactive product.

To set a product’s Active status, do the following:
1. Click on the Products option on the Categories menu to display the Products window.
2. Locate the product and check or un-check its Active checkbox.
3. Click on Save to save your changes and close the Products window.

 

Deleting Products

A product can only be deleted from your product listing if none of your business records depend
on that product. If you are unable to delete a product because one or more of your business
records depend on it, un-checking the product’s Active checkbox will remove the product from
the program’s selection boxes and reports, unless it is needed to edit or display a previously-
entered transaction.

To delete a product from the program, do the following:
1. Click on the Products option on the Categories menu to display the Products window.
2. Select the product by clicking on it with your mouse.
3. Click on Delete to remove the product from the program’s product listing.

6.2.4 Product Bundles
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If you always buy and resell product Bundles as a unit, and never break them up to sell the individual
products, then you are not likely to need this feature. Simply create a single product to represent the
bundle using the Products option on the Categories menu.

 

If you sometimes break up product Bundles into individual products, then the Bundles feature can
save you considerable time by automatically entering the individual products for you on the Edit
Purchases and Edit Sales screens.

 

The Bundles buttons on the Edit Purchases and Edit Sales screens display the Product Bundles
window. This window allows you to save the first 100 lines of product selections on the Edit
Purchases or Edit Sales screen under a name chosen by you. This product bundle can then be
recalled at any time to have the information automatically entered on either screen. Purchases and
Sales share the same list of product Bundles, so creating a package on either screen allows you to
access it from either location.

 

To create a new product package do the following:
1. Enter the appropriate information on the Edit Purchases or Edit Sales screen but do not save the

transaction.
2. Click on the Bundles button to display the Product Bundles window.
3. Enter a name to identify this product bundle.
4. Click on Save.

 

To recall a previously saved product package do the following:
1. Click on the Bundles button in either the Edit Purchases or Edit Sales screen to display the

Product Bundles window.
2. Select the product bundle to be recalled from the list provided.
3. Click on Recall to have the information automatically entered on the current screen.

 

Multiple product Bundles can be recalled for a single invoice or purchase order. Each package will be
entered starting with the first empty line on the current screen.

6.2.5 Current Time Period
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The two date boxes at the top of the screen define the time period that is currently active within the
program. This time interval is referred to as the Current Time Period. There are two things to
remember about the Current Time Period.

1. The program keeps a record of every transaction you enter, no matter what dates you have set for
the Current Time Period.

2. The displays and reports in the program default to including only those entries that fall within the 
Current Time Period, so transactions you record may not show up in the program if they are
outside of this date range.

 

The Current Time Period allows you to temporarily focus on any period of activity you like. Simply
reset the date boxes to reflect the time period of interest. When viewing financial displays (e.g. 
Events or Invoices) in the program, you can set whether or not records outside of the Current Time
Period should be included in the display by checking or unchecking the checkbox that reads "Only
show records within the Current Time Period" at the top of each of these windows. When previewing
or printing most financial reports, this option is available in the report-filtering window.

6.3 Events

6.3.1 Overview

 

  

Overview

The program allows you to create and maintain a list of Events and then to associate transactions of
all types with these Events for reporting purposes. Events can be parties, craft shows, trade shows,
fundraisers, or any other one-time gathering at which you sold product(s). Associating your financial
entries with these events allows you to view reports summarizing event activity.
 

 

The list of available Events can be edited using the Events option on the Categories menu. It can
also be accessed using the Events buttons on the Sales and Purchases screens. The Events
window can be sorted by left clicking on any one of its column headings. The sorted display can also
be printed using the Print button in the Events window. The window will remember its size, the size
of each of its columns and its last sort order each time it is opened. Checking or unchecking the box
at the top allows you to specify whether or not this display is limited to displaying records within the 
Current Time Period.
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6.3.2 Adding an Event

 

To add an Event, just do the following:

1. Click on the Events button on either the Sales or Purchases screen to display the Events
window or click on the ellipsis (…) button to the right of the Event boxes on any of the main
financial screens.

2. Click on the New button to display the New Event window.

 

 
3. Date / Time: Click on the button at the right side of the Date box and select the date the event

occurred or will occur, then do the same for the Time. Dates and times can also be entered by
typing directly into the box or using the Up and Down arrow keys or the PgUp and PgDn keys to
scroll one day or one week at a time respectively.

4. Host: Select the host’s name from your list of contacts by clicking on the button at the right side
of the Host box. Names can also be selected by typing directly into the box or using the Up and
Down arrow keys and the PgUp and PgDn keys to scroll one name or several names at a time
respectively. To add a new name to the list directly from this window, click on the second ellipsis
(…) button to the right of the Host box. This will display the New Contact window, allowing you to
enter a new contact and add them to your contact database. Selecting one of your contact as the
Host for an Event simultaneously assigns that person an Additional Primary Group of "Past
Host" for filtering purposes.

5. Description: Enter a Description that will help you to distinguish this Event from the others in
your list.

6. Referring Host: The Referring Host field should be filled in automatically based on your
selection in the Host box. Selecting a Host causes the program to search its records to see if this
new host attended one of your earlier parties. If so, then the program assumes that the host of
that earlier party is the Referring Host of this new party. If no earlier party is found, the program
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enters your name as the Referring Host. If the automatic entry in this box is not correct it can be
overridden using the ellipsis (…) buttons to the right.

7. Date Booked: If the program was able to find a previous Event that this host attended, the date of
that previous Event will be entered into the Date Booked field. This entry can be overridden by
typing or using the ellipsis (…) button to display a pop-up calendar.

8. Type:  The program allows you to define four different "types" of events. To change the default
types click on the ellipsis (…) button to the right of the Type selection box.

9. Host Credit Percent: Enter your company’s recommended host percentage in the Host Credit
Percent box. The percentage entered into this box will be multiplied by the total retail amount of
the Event to arrive at the recommended host credit. (Note: there are several options available via
the Options button on the Reports screen that affect the results of the host credit calculation..

10.Hours worked: Enter the number of hours you personally worked on this Event in the Hours
worked entry box.If this Event has not yet taken place you can edit this Event later to fill in this
entry.

11.Profit estimate: Enter the percentage of Net Event Sales you would like designated as your
personal profit in the Profit estimate entry box (e.g. "20").

12.Unlinked expenses: Enter any Event expenses that will not be linked to this Event from the
Income / Expenses screen, into the Unlinked Expenses entry box. This entry is used primarily
to allocate a portion of a sample or supply expense to an Event. It does not affect your general
business records but does allow you to get a more accurate picture of the actual profitability of
your events via the Event Summary report on the Reports screen. Say, for example, that you
purchase $20 worth of product samples, which you then use at several events. You would record
the whole $20 on the Income / Expenses screen, leaving the Event box empty since there’s no
single Event at which they were all used. You would then allocate the $20 as appropriate, using
the Unlinked Expenses entry for the events at which the samples were actually used.

13.Linked appointment: If you choose, use the New button next to the Linked Appointment box
to create an appointment in your Calendar for the Event being added.

14.Invitees / Attendees: If this Event has already occurred then there’s no need to add the
attendees from the Event window. As you enter and link each person’s order to this Event from
the Sales screen, their name will be added to the Event automatically. If this Event has not yet
occurred and if you would like to use the software to help in planning and preparing for the Event,
use the Add button beneath the Invitees / Attendees box to add people from your contact
database. Contacts can be added to your contact database directly from the Event window by
clicking on Add and then clicking on New. Adding invitees to an Event before the Event occurs
allows you to use the program to send invitations (email or printed) and to stay in touch with the
invitees prior to the date of the Event.

Note: Names that are listed in this box because they are listed as the customer on a sales
order that's linked to this Event cannot be removed using the Remove button. To remove a
customer's name from this list you will need to edit their sale and change or remove the Event
entry.

6.3.3 Editing or Deleting an Event

 

To edit or delete an existing Event just double click on the Event or click once on it and then click
on Edit. This will display the Edit Event window allowing you to make changes or delete the Event
entirely. Deleting an event with which you have previously associated one or more sales will not affect
your sales from a financial standpoint, but will remove all references to the deleted Event from the
associated sales records.

 

For more information on the individual fields in the Edit Event window please see Adding an Event.
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6.3.4 Viewing Your Event Referral Network

 

Whenever you add a new event using a Host who was a customer at an earlier event, the program will
locate the previous invoice and enter the name of the referring host in the Last Host box in the Events
window. If the program is unable to locate a referring host, it will prompt you to select one from your
list of Events or to specify yourself as the referral source. This referral network can be displayed
visually, by clicking on the View button in the Events window to display the Event Tree window.
 

The Event Tree window, like the Team screen, offers three different views.

 

Visual: Shows a hierarchical display of your host referral network.

Listing: Allows you to quickly access contact information for any past host.

Activity: Shows summary financial numbers for each of your parties.

 

Visual View
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In the Visual view, all of your past hosts are displayed in a hierarchical "tree" diagram with the
currently selected host / party shown in bold. Use the magnifying-glass buttons to change the
display’s magnification or to reset it to its default position and magnification. Holding the CTRL
key down while clicking either of the zoom buttons allows you to change the zoom setting more
quickly. The rightmost magnifying-glass button sets the magnification back to its default value
and re-centers the display around the topmost node. To view off-screen portions of your team
use the horizontal and vertical scrollbars. Scrolling can also be accomplished by dragging the
diagram using your mouse. To do this, left click directly on the diagram, then move your mouse
while continuing to hold the mouse button down.

 

Event information can be displayed for whichever node the mouse is currently over, by right
clicking once anywhere in the Visual view. Left clicking turns the Event information display off.

Listing View

 

In the Listing view, host contact information is displayed in a table with the currently selected
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host highlighted in blue. Hosts who are hidden from view in the Explorer hierarchy are also
hidden from view in the Listing view grid. To display hosts that are hidden, click on the plus
sign next to the their referring host in the Explorer hierarchy or just double click on their
referring host’s name. Clicking on any of the column headings in the Listing view causes the
display to be sorted based on the entries in the column. Clicking on it again reverses the sort
order. After sorting, the entries in the Listing display may not be aligned with their counterparts
in the Explorer hierarchy on the left side of the Events Tree window. To re-order the Listing
view display so that it’s in the same order as the hierarchy on the left, just click on the first
column in the display to sort it based on its row numbers. The program will remember your last 
Listing view sort order and will sort the display in the same manner the next time the window is
opened.

 
Activity View

The Activity view contains a display summary for each of your Events. Events that are hidden
from view in the Explorer hierarchy are also hidden from view in the Activity view grid. To
display hidden Events, click on the plus sign next to their referring host in the Explorer
hierarchy or just double click on their referring host’s name. Clicking on any of the column
headings in the Activity view causes the display to be sorted based on the entries in the
column. Clicking on it again reverses the sort order. After sorting, the entries in the Activity
display may not be aligned with their counterparts in the Explorer hierarchy on the left side of
the Events Tree window. To re-order the Activity view display so that it’s in the same order as
the hierarchy on the left, just click on the first column in the display to sort it based on its row
numbers. The program will remember your last Activity view sort order and will sort the display
in the same manner the next time the window is opened.

6.4 Income and Expenses

6.4.1 Overview

 
  

The Income / Expenses screen is used to enter all types of income and expenses except for
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product purchases (from your company) and sales (to your customers). Commission checks, office
supplies, party favors and travel expenses are all examples of the types of entries you might make on
this screen.
 

6.4.2 Entering Income and Expenses

 

To make a new income or expense entry, just do the following:
 

1. Click on the Income or Expense button in the lower right corner of the screen to add a new row
to the display. Clicking on either of these buttons also checks the "Only show records that have
not been saved" checkbox, causing the screen to temporarily display only the new records you
are working on.
 

2. Date: Click in the Date field and either type a date or use the ellipsis (…) button to display a pop-
up calendar. Dates can also be entered or adjusted using the Up and Down arrow keys in
combination with the Shift key to scroll one day at a time.
 

3. Type: Assuming you clicked on the correct button (Income or Expense) in Step 1 you should
not need to adjust the type of record being entered. To change the type, either type an "i" or an
"e" or make a new selection with your mouse.
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4. Event: If the income or expense happened in association with an Event, select that event in the
Event field. This will cause your entry to be included in reports that are filtered by event, including
the "Event Summary" report on the Reports screen.
 

5. Category: Select the appropriate category by typing or by clicking on the button at the right side
of the box and then clicking on one of the names in the dropdown list. Categories can also be
selected using the Up and Down arrow keys in combination with the Shift key to scroll one item
at a time. To add new categories or edit existing ones, click on the Income or Expenses option
on the Categories menu.
 

6. Amount:  Enter the amount of the income or expense in the Amount box.
 

7. Method:  Select the method of payment in the Method box by typing or by clicking on the button
at the right side of the box and then clicking on one of the items in the dropdown list (optional).
Use the "(other)" payment options for expenses to indicate that an expense was not paid from one
of your primary business accounts. While this does not affect your actual business or tax records,
it prevents the entry from being "rolled up" into your Cash, Checking or Credit account registers.
 

8. Check #:  Enter the check number in the Check # box (if applicable).
 

9. Note:  Enter a note or comment in the Note box (optional).
 

10.Click on the Save button to save your entries. This also unchecks the "Only show records that
have not been saved" checkbox causing previously-saved records to be once again displayed.
 

6.4.3 Editing Income and Expense Entries

 

To edit a previously recorded income or expense entry, just do the following:

1. Double click on the entry to be changed.
2. Make the desired change.
3. Repeat Steps 1 – 2 for additional changes.
4. Click on Save to save all of your changes.
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6.4.4 Deleting Income and Expense Entries

 

To delete one or more Income or Expense entries, do the following:

1. Click on the row to be deleted. Hold down your CTRL key while clicking to select more than one
row at a time.

2. Click on Delete to remove the selected entry(ies).
3. Click on OK when prompted to confirm the delete operation.

6.4.5 Travel, Meals and Entertainment

 

Tax agencies generally require additional supporting information to substantiate expenses based on
travel, meals and entertainment. Consultant Front Office provides extra fields on the Income /
Expenses screen for these entries whenever the "Show supporting entries" checkbox on the Income
/ Expenses screen is checked.

You can instruct the program to require that these entries be completed when recording travel, meals
and entertainment expenses using the Preferences option on the Settings menu ("Require
supporting entries for Expenses" on the Financial tab).

These entries then become part of your permanent records. All of these entries can be reviewed or
printed from the Income / Expenses screen or using the Expense – History report option on the
Reports screen.
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6.4.6 Importing Income and Expense Data

  

Working With An Assistant

Income and expense entries can be exported and imported using the Export – Miscellaneous
and Import – Miscellaneous functions on the File menu. This function uses the "ezx" file
format and is not compatible with files generated by other financial programs or institutions, but
it does allow you to import entries made by an assistant without overwriting changes made on
your own computer.

 

Importing Bank and Credit Card Statements

Income and expense entries can also be imported using industry standard Microsoft Money
(OFX) and Quicken (QIF and QFX) file formats to eliminate data entry and prevent missed
entries. These types of files are imported using the Import button on the Income / Expenses
screen.

6.5 Sales

6.5.1 Overview

 
 
The Sales screen is used to enter all income resulting directly from the sale of products. In the "full-
inventory" edition of the program, products entered as part of a sale Sales are automatically removed
from your personal inventory when the transaction is saved.

The main Sales screen shows a listing of all of the invoices you have entered into the program,
unless some of those invoices are hidden due to the "Only show records within the Current Time
Period" checkbox at the top of the screen being checked. Invoices can be customized, emailed
(Standard and Professional only), previewed and printed by clicking on the Invoices button.

Credit card payments can also be uploaded to a ProPay™ merchant account using the ProPay
button on the Sales screen (Standard and Professional only). Uploading payments to ProPay from
Consultant Front Office makes it unnecessary to go to the ProPay website to charge your
customers’ credit cards. It also allows you to delay payments until a specific date (e.g. half now, half
a week from now) with the system keeping track of when those payments become due.
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6.5.2 Settings

 
 

The Sales Settings window is displayed by clicking on the Settings button on the Edit Sales
screen. Freight and tax setting instructions for this window can be found using the links above (
Related Topics).

The Misc tab of the Sales Settings window is used to customize the Edit Sales screen to your
liking. The generally recommended settings are shown below but feel free to change any of these to
fit your style of doing business.
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Check the Dis box… Instructs the program to put a checkmark in the Discounted checkbox
whenever a product is selected on the Edit Sales screen
 

Check the Del box
…

Instructs the program to put a checkmark in the Delivered checkbox
whenever a product is selected on the Edit Sales screen.
 

Ignore Auto Print … Instructs the program not to automatically print invoices when editing
 

Notify if a customer
…

Instructs the program to display a warning at the top of the Edit Sales
screen when a customer is selected who has an outstanding balance on
their account
 

Enter sales into … Instructs the program to enter a list of the products purchased into each
customer’s contact Notes. While this may seem desirable, it’s generally
unnecessary since a customer’s purchase history is readily available from
the Edit Contacts screen.
 

Auto print quantity Tells the program how many invoice copies to print when a sale is saved.



Financial Management 133

© 2011 MLM Software Solutions, Inc.

6.5.3 Entering Sales

6.5.3.1 Overview

 

 
 

Product sales are entered on the Edit Sales screen. This screen can be opened by clicking on the
New button on the main Sales screen or by double clicking on an invoice in the main Sales screen.
Up to 150 line item entries can be made on a single invoice

Here are the basic instructions for entering a sale. The links at the end of some of these steps
contain more detailed information regarding that specific entry.
 

1. Click on the Sales button on the main program toolbar to go to the Sales screen.
2. Click on the New button on the Sales screen to open the Edit Sales window.
3. Date:  Enter the date you actually sold the products either by typing or using the pop-up calendar.

Dates can also be adjusted using the up and down arrow keys and the PgUp and PgDn keys.
4. Invoice #:  Check the box and let the program enter numbers automatically (Invoice No).
5. Customer:  Select the customer’s name from your list of contacts (Customer).
6. Comment:  Enter a note regarding the sale (optional - Invoice Comment).
7. Event: Select the Event this sale is associated with (optional - Event).
8. Method: Select the method of payment or leave blank if unpaid (Pay Method).
9. Check #: Enter the check number in the Check # box if applicable.
10.Inside Order: Check this box if the sale being recorded occurred at the selected Event (Inside

Order).
11.Potential Host: Check this box if the customer expressed interest in hosting an Event of their

own (Potential Host).
12.Booked Event: Check this box if the customer booked an Event while making this purchase (

Booked Event).
13.Potential Recruit: Check this box if the customer is interested in your business opportunity (

Potential Recruit).
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14.Host Order: This box should be checked automatically if the Customer you have selected is
also the host of the Event that is selected for this sale (Host Order).

15.Reorder: This box will be checked automatically if a previous sale for this Customer has been
entered. If a previous sale occurred but is not in the program you will need to check this box
manually to have the sale treated as a reorder for reporting purposes.

16.Commission only: This box is only to be used to enter sales for which you do not receive
payment except in the form of a commission (Commission Only).

17.Group: Select the Group to which the first item belongs. Selecting a Group will rebuild the lists
of products in the Item # and Description fields based on your Group selection. The Group field
will only be visible on the Edit Sales screen if the "Show product Groups" option has been
selected using the Products option on the Categories menu (Group).

18.Item # / Description: Select the product you sold by typing or by clicking on the button at the
right side of either the Item # box or the Description box and then clicking on the correct item.
Pressing the Delete key on your keyboard in either the Item # or Description box clears all of
the entries on that line (Item No). 

19.Qty: Enter the quantity sold in the Qty box.
20.Unit Price / Extd Price: If the selling price was different than the default value that was

automatically entered in the Unit Price box you can change it by simply typing a new value into
the box. If this item’s Qty is more than 1, you can also enter a total price in the Extd. Price box
and the program will calculate the corresponding Unit Price box for you (Unit Price).

21.Note: Enter a Note or comment regarding this line item in the Note box (optional).
22.Dis / Tax: Select the "discountability" (Dis) and "taxability" (Tax) of this line item using the

checkboxes at the end of the line. Percentage discount factors are only applied to line items that
have their Dis box checked (Discountability and Taxability).

23.Del: If the product has already been delivered to your customer, check the "delivered" (Del)
checkbox at the end of the line. If the product has not been delivered to your customer leave the
box unchecked. This box is for reference and reporting purposes only If you are using the full-
inventory edition of the program checking or unchecking the Del box will not affect your inventory
count.

24.Repeat Steps 15 – 21 for each item that you sold.
25.Supplies: If you are selling any business supplies enter the total amount into the Supplies box

on the Edit Sales screen.
26.Discount: Enter a fixed discount amount or a percentage discount factor in the Discount boxes

provided (optional - Discountability and Taxability).
27.Freight: In general, you will probably want the program to enter freight for you automatically (see

Setting Freight Rates)..
28.Tax: In general, you will probably want the program to enter tax for you automatically (see

Setting Tax Rates).
29.Credit: This box is typically used to enter a "Host Credit". A Credit is similar to a Discount,

except that it does not affect the calculation of freight or tax and it can be used to offset the freight
and tax in determining the Total amount of the sale (optional).

30.Balance Due: Enter any partial payment information using the button just to the right of the
Balance Due box (Standard and Professional only). This button displays the Payment History
window, which allows you to keep track of up to ten separate payments on each individual sale. If
a Method of payment has been specified, the program will automatically create a default payment
record for the Total amount of the sale (Receivables).

31.Click on Save to save your entries.

 

If you later discover that you made a mistake in one of your entries, simply double click on the invoice
in the main Sales window to open it back up for editing.
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6.5.3.2 Invoice No.

Enter the invoice number you will use to refer to the sale being recorded. Consultant Front Office will
automatically enter the next available invoice number for you, if the Auto number checkbox next to
the Invoice # entry box is checked.. To set invoice auto numbering to a new starting point, just enter
the new beginning invoice number when you record your next sale.

6.5.3.3 Customer

 

Select the name of the person who purchased the product(s) from you. All of your currently filtered
contact listings are available for selection in the Customer box. 

To add a new customer to the list or to enter a customer name for this invoice only, click on the
second ellipsis (…) button to the right of the Customer box. This will display the New Contact
window, allowing you to enter a name, and select whether this name should be added to your contact
database (Add Contact) or saved only in association with this invoice (Invoice Only).
 

 

The second ellipsis button can also be used to edit an existing customer's information or to add to
their Notes after selecting their name in the Customer box on the Sales screen.
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The pop-up contact window does not allow you to enter everything that can be entered on the main 
Contacts screen. If you would like to enter additional information, you may want to enter customer
information first on the Contacts screen, then come back to the Sales screen to enter their order.

6.5.3.4 Comment

 

Enter a brief Comment describing the sale being recorded (optional). This Comment can be included
on your printed invoices by selecting the appropriate option in the Customize Invoices window.

6.5.3.5 Event

 

Select the Event (if any) that this sale is associated with. If this sale occurred at a party, trade show
or other type of Event, and you would like to be able to get reports based on this Event, select the
corresponding Event number from the available list. The list of available events can be edited directly
from the Edit Sales screen by clicking on the button just to the right of the Event boxes. This button
displays the Events window, showing a list of your previously defined events. Clicking on an Event
and then clicking on Select allows you to select an Event for the Edit Sales screen directly from
the Events window.
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6.5.3.6 Payment Method

 

Select the method of payment used to purchase the products being sold. Electronic payments are
automatically deposited into your checking account. Cash, Check and Credit / Debit transactions
can also be automatically deposited into your checking account if the associated options have been
selected using the Preferences option on the Settings menu.

In general, it’s usually best not to have the program automatically deposit income into your checking
account since these individual transactions won’t match up with your actual deposits. It’s usually
better to leave these auto-deposit options turned off and make deposits into your checking account
manually, using the Adjust button in the Checking account window.

6.5.3.7 Inside Order

Check the Inside Order box if the sale being recorded occurred at the event you selected in the
Event box on the Edit Sales screen. This box is only visible when an event number has been
selected. Checking this box also sets the Date box on the Edit Sales screen to the date of the
selected Event and instructs the program to count the sale as an "inside order" in the Event
Summary and Host Summary reports.

To enter a sale that was the result of an Event but did not actually occur at the event, select the
event in the Event box on the Edit Sales screen but leave the Inside Order box unchecked.

6.5.3.8 Potential Host

Check the Potential Host checkbox if the customer for this sale has expressed interest in hosting an
event of their own. The customer’s name will then be appear in the list of "Potential Hosts" in the 
Event Summary and Host Summary reports. The customer’s will also be assigned an Additional
Primary Group of Potential Host for filtering purposes on the Contacts screen.

6.5.3.9 Booked Event

 

Check the Booked Event checkbox if the customer for this sale has booked their own party or event.
The customer’s name will then appear in the list of Bookings in the Event Summary and Host
Summary reports.

6.5.3.10 Potential Recruit

 

Check the Potential Recruit checkbox if the customer for this sale expresses an interest in getting
involved in the business. The customer’s name will then appear in the list of Potential Recruits in the 
Event Summary and Host Summary reports. The customer’s will also be assigned an Additional
Primary Group of Potential Recruit for filtering purposes on the Contacts screen.

6.5.3.11 Host Order

This box will be checked automatically based on the Customer and Event selections on the Edit
Sales screen. The Host Order is reported separately in the Event Summary and Host Summary
reports on the Reports screen.
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6.5.3.12 Reorder

 

The Reorder checkbox will be automatically checked whenever you select a Customer who has
purchased product(s) from you in the past. You can also check the box manually if the previous
purchase has not been entered into the program. If the Reorder checkbox is checked when a sale is
recorded, the customer’s contact listing will be assigned an Additional Primary Group of Reorder
Customer for filtering purposes on the Contacts screen.

To avoid double counting on some reports, sales which are associated with an Event cannot also be
marked as Reorders. For this reason, the Reorder checkbox is automatically cleared and disabled
(grayed out) whenever an Event is selected on the Edit Sales screen.

Reorder activity can be summarized for any time period you choose using the Reorder Summary
report on the Reports screen. Reorder activity is also summarized in the Monthly Summary report.

6.5.3.13 Commission Only

 

Checking the "Commission only" box when you enter a sale causes the program to ignore the
transaction from a financial standpoint. Checking this box in the "full-inventory" edition of the program
also causes the program to ignore the inventory implications of the sale, thus leaving your inventory
count and value unchanged. This allows you to enter sales into your system for which you did not
personally receive payment except in the form of a commission. 

Commission-only sales often occur directly through your company's website, though they may also
occur anytime you get paid using a credit card, if your company processes the credit card payment
on your behalf. The key factor here is whether you directly receive payment for the products
that were sold. If you receive payment directly and the payment gets deposited into your business
bank account, leave the "Commission only" box unchecked. If the only payment you receive is in the
form of a commission, then check the box and enter the commission when you receive it on the 
Income / Expenses screen.

Entering commission-only sales allows you to use all of the program's filtering, searching and follow-
up capabilities for sales that could otherwise not be entered into your system.

6.5.3.14 Selecting Products

6.5.3.14.1  Group

The Group column will only be displayed if you’ve checked the "Show product groups" checkbox
under the Products option on the Categories menu. Product Groups can make it easier to select
products quickly if your company offers a large number of products with somewhat similar
descriptions.
 

Select the product Group by clicking on the button at the right side of the Group box and then
clicking on the correct item. Selecting a Group causes the program to generate the list of products
that are in that Group and put that list into the Item # and Description selection lists. Product
Groups can also be selected by typing directly into the box or using the Up and Down arrow keys in
combination with the Shift key. To add a new product Group or modify information for an existing one
use the Products option on the Categories menu or right click when the cursor is in one of the
Group boxes (Categories Menu - Products).
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6.5.3.14.2  Item No.

 

Select the product being sold by typing or by clicking on the button at the right side of either the Item
# box or the Description box and then clicking on the correct item. Selecting either an Item # or a
Description will automatically select its counterpart in the associated box. Item numbers and
descriptions can also be selected using the Up and Down arrow keys in combination with the Shift
key. To add a new product or modify information for an existing one use the Products option on the
Categories menu or right click when the cursor is in one of the Item # or Description boxes (
Categories Menu - Products).

6.5.3.14.3  Unit Price

 

If the price is different than the default value automatically entered in the Price box you can change it
by simply typing a new value into the Price box. If the quantity is more than 1, you can also enter a
total price in the Extd. Price box and the program will enter the corresponding unit price in the Price
box for you. Default product pricing can be changed using the Product option on the Categories
menu.

You can also choose to use the Unit Cost or Alt Cost field as the source of a product’s price on the
Sales screen. To do this, simply click on the Unit Price… column heading on the Sales screen and
select the desired field from the selection box.

6.5.3.14.4  Dis and Tax

 

Selecting the Dis checkbox causes the program to include a line item in calculating a percentage
Discount.
 

Selecting the Tax checkbox causes the program to include this line item in calculating sales or VAT
tax. By default, the tax checkbox(es) reflect the settings entered using the Products option on the
Categories menu. Changing taxability settings on the Edit Sales screen affects only the current
sale. To change the default taxability setting for any of your products, use the Products option on
the Categories menu.

6.5.3.14.5  Del

 

The Del checkbox at the end of each line item on the Sales screen allows you to indicate whether
that product has been delivered to your customer or is backordered. Checking the box indicates that
your customer has received the item(s). Unchecking the box indicates that your customer has not yet
received the product(s).

Whether or not the Del checkbox is checked all line items will still be withdrawn from the program’s
inventory if you have the full-inventory edition of the program. The Del checkbox is for reporting
purposes only and has no impact on the program’s inventory count.

All products which have not yet been delivered can be found by previewing or printing a Sales
History report on the Reports screen and checking the filter box that reads " Show not delivered or
received only". To change the Del status of an individual line item simply edit the sale containing that
item.

An easy way to quickly locate all of your invoices that have one or more undelivered products is by
checking the box that reads "Highlight invoices with items that have not been delivered" in the main 
Sales window. If all of the items for a particular invoice have now been delivered you can mark the
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invoice as delivered by selecting it and the clicking on the Mark selected records as delivered in
the main Sales screen.

6.5.3.15 Setting Freight Rates

 

Purchases

There is typically no need to set freight rates in the program for product purchases. The freight
charge on product purchases should generally be copied directly from your company’s invoice,
mak ing freight settings for purchases unnecessary.

 

Sales

Freight rates for product sales are entered using the Settings buttons on the Edit Sales
screen. This window can also be accessed via the Setup Wizard option on the Help menu
and by clicking on the Freight label on the Edit Sales screen.
 

 

If you would like the program to calculate and enter freight for you on the Sales screen, check
the checkbox at the top of the Sale Settings window.  In general, it is usually easier to enter
freight on product purchases manually, while allowing the program to calculate and enter the
freight for you on product sales.

 

Company-specific: In some custom editions of the program, the Company-specific freight
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calculation option will be enabled. Checking this box instructs the program to calculate freight
charges using the method your company employs to determine freight charges. Company-
specific freight calculations are handled automatically by the program, hence none of the User-
defined settings will have any impact on freight calculations when this option is selected.

 

User-defined:  When the User-defined freight calculation option is selected, the amount of
freight automatically entered on product sales is calculated as follows. First, the program
multiplies the freight rate, if any, times the total cost, price or weight of the product(s) being
purchased or sold. Second, it compares this result with the minimum / fixed charge, selects
whichever value is higher, and adds to it any handling charges. If you don't specify a minimum /
fixed charge, the freight calculated will always be the freight rate times the total product cost,
price or weight, plus handling. If you don't specify a freight rate, the freight calculated will
always be the fixed / minimum charge plus handling.

6.5.3.16 Setting Tax Rates

 

Purchases

There is typically no need to set tax rates in the program for product purchases. The tax charge
(s) on product purchases should generally be copied directly from your company’s invoice,
mak ing tax settings for purchases unnecessary (see Step 3 below).

 Sales

Tax rates for sales are entered using the Settings buttons on the Edit Sales screen. This
window can also be accessed via the Setup Wizard option on the Help menu and by clicking
on the Tax label on the Edit Sales screen.
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To configure your tax settings using the Tax tab in the Sale Settings window, just do the
following:

1. Check the first checkbox if your state, province or country charges sales or VAT tax on any
of the products you sell. This setting affects both Purchases and Sales. Checking or un-
checking this box in either the Purchase Settings or Sale Settings window will cause it to
have the same setting in the other window. If none of your products are subject to sales or
VAT tax, leave the first checkbox un-checked and click on Save. You are finished
configuring your tax settings.

2. Check the second checkbox if your state, province or country has two different sales or VAT
tax rates for any of the products you sell. This setting affects both Purchases and Sales.
Checking or un-checking this box in the Purchase Settings or Sale Settings window will
cause it to have the same setting in the other window.

3. Check the third checkbox if you would like the program to calculate and enter tax for you on
the Purchases or Sales screen. In general, it is usually easier to enter tax on product
purchases manually, while allowing the program to calculate and enter the tax for you on
product sales.

4. Enter the rate at which some or all of your products are taxed in the Tax Rate 1 box. The
name used to identify this tax rate can be changed by clicking on the label and entering a
new name.

5. Select the option describing how this tax rate is applied using the option buttons
immediately below the tax rate box. The Actual Cost or Actual Price and Actual Cost +
Frt or Actual Price + Frt options use the net price of the products after any discount is
applied in determining the taxable product total. Business Items entered on the Purchases
or Sales screen are always assumed to be taxable.
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6. Repeat Steps 4 and 5 for your second tax rate if applicable.
7. If you have selected one of the tax options that include tax on freight you may select the

option to Only tax freight allocated to taxable items if this is how your state or province
charges tax. If this option is not selected, freight will always be fully taxed whether or not a
PO or Invoice includes other taxable items.

8. Click on Save to save your settings and close the window.
9. Click on the Product option on the Categories menu and set the default taxability for each

individual product as appropriate.

6.5.3.17 Payment History

 

If the entire sale is being paid for with a single payment, selecting the appropriate Method of payment
on the Edit Sales screen is all you need to do. Selecting the Method of payment will automatically
retrieve any additional information that is needed to create the default payment record, including the
customer’s credit card information if required.

If more than one payment will be made on a sale, click on the ellipsis (…) button to the right of the 
Balance Due box on the Edit Sales screen (Standard and Professional only). This will display the
Payment History window allowing you to track up to ten separate payments for each sale.
 

 

If the total amount of the payments entered is less than the Total amount of the sale, the invoice will
show a positive Balance Due. If the total amount of the payments is greater than the Total amount
of the sale, as in the case of an overpayment, the invoice will show a negative Balance Due. Use
the Balance Due report on the Reports screen (or the Invoices report with the "Show Balance Dues
only" option selected to quickly find who owes you money and how much they owe you.

Payment information entered in the Payment History window (or the default payment record created
by selecting the appropriate Method of payment) can be uploaded to ProPay for automated credit
card processing. Payments that have been successfully uploaded and processed will be shown with
a blue-green (teal) background in the Payment History window indicating that they are locked and
can no longer be modified.

6.5.3.18 Receivables

 

Customers who have a Balance Due can be located several ways. One way is to click on the
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Balance column heading on the Sales screen to sort the list by the amounts in that column. A
second way is to preview or print a Balance Dues report or Invoices report on the Reports screen,
while checking the "Show Balance Dues only" checkbox in the report filtering window. Finally, you
can use the Filter button in the Contacts screen and select the Sales filter option that reads "Select
only those contacts who have a balance due".

You can also have the program notify you any time you select a customer who has an outstanding
balance using the "Notify if customer has a balance due" option (Settings button on the Edit Sales
screen).

6.5.4 Editing Sales

 

 

To edit a previously recorded Sales entry do the following:
1. Click on the Sales button on the main toolbar to go to the Sales screen.
2. Double click on a row in the display to open the Edit Sales window.
3. Make the desired changes.
4. Click on Save to save your changes.
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6.5.5 Deleting Sales

 

 

To delete a previously saved Sales entry do the following:
1. Click on the Sales button on the main toolbar to go to the Sales screen.
2. Click on the row to be deleted. To delete multiple rows hold down your CTRL key while clicking.
3. Click on Delete to delete the sale(s).

 

In the full-inventory edition of the program, deleting a sale also restores the products to inventory and
makes all necessary adjustments to your Cost of Goods Sold.

6.5.6 Invoices

Invoices
 

Consultant Front Office automatically creates an invoice every time you enter a sale. To customize
the appearance of invoices click on the Invoices button on the Sales screen,  then click on Settings
.

To preview, print or email a copy of an invoice do the following:
1. Select the invoice(s) on  the main Sales screen using your mouse. To select multiple rows hold

down your CTRL key while clicking.
2. Click on the Invoices  button on the Sales screen to display the Invoices window.
3. Click on the Settings button to customize the appearance of all of your invoices (see below).
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4. Select one of the displayed options and click OK.

 

 
 
If you select the option that reads "Email the selected invoice(s), then the Invoice Email Options
window will be displayed, allowing you to choose who you would the invoice emailed to.
 

 

 

Modifying Invoices

Invoices can be modified or deleted, by editing the underlying sale transaction.
 

Customizing Invoices and Purchase Orders

Clicking on the Settings  button in the Invoices  window allows you to specify what information is
included in these documents and to add text and images to them if you choose.
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To add a header or footer image to your invoices check the appropriate checkbox, then click on the
ellipsis (…) button to the far right of the checkbox and select the image file you would like to include.
Image files with any of the following file extensions can be added to your invoices:

bmp
gif
jpg
wmf

The program will not allow you to close the Customize Invoice window if you have selected either of
these "image" options and not entered a valid image path.
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To append text from a file to the end of your invoice check the Append text from file option on the
Misc tab of the Customize Invoices window, then click on the ellipsis (…) button to the far right of
the checkbox and select the text file you would like to append.
 

Uploading Payments to ProPay™

Your customers credit card payments can be uploaded to ProPay for credit card processing using
the ProPay button on the Sales screen..
 

Printing Invoices  Automatically

Invoices  can  be printed automatically when a sale  is saved  by checking the Auto Print checkbox
on the Edit Sales screen. If you would like more than one copy of an invoice printed using the Auto
Print function, click on the Settings button on the Edit Sales screen and set the "Auto print
quantity" on the Misc tab to the desired number of copies.
 

6.5.7 Discountability and Taxability

 

Selecting the Dis checkbox causes the program to include a line item in calculating a percentage
Discount.
 

Selecting the Tax checkbox causes the program to include this line item in calculating sales or VAT
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tax. By default, the tax checkbox(es) reflect the settings entered using the Products option on the
Categories menu. Changing taxability settings on the Edit Sales screen affects only the current
sale. To change the default taxability setting for any of your products, use the Products option on
the Categories menu.

6.5.8 Uploading Payments To ProPay

 

The program is capable of tracking the status of credit card payments from your customers and of
uploading those payments to the ProPay merchant account system for processing.

To use the program’s credit card payment status tracking and uploading capabilities, just do the
following:

1. Ensure that customer credit card information is accurately entered on the Contacts screen or
using the mini-contacts screen that’s available when you’re entering a sale. This must be done
prior to saving a customer’s sale for the credit card information to be retrieved
automatically. To associate a credit card number with a sale that’s already been saved you will
need to:
1.a.Edit the sale by double clicking on that entry in the main Sales screen.
1.b.Click on the ellipsis (…) button next to the Balance Due box to open the Payment History

window.
1.c.Right click on the first payment record and left click on Update credit card.
1.d.Close the Payment History window and resave the sale.

2. Check the box on the main Sales screen that reads "Highlight invoices with unprocessed credit
card payments". This will cause the program to highlight the Method of payment field in each row
where an unprocessed credit card payment was found. (To change the highlighting color click on
the button next to this checkbox that displays the current color.)

3. Click on the link next to this checkbox that reads "Select highlighted" to have the program select
all of the highlighted rows.

4. Click on the ProPay button to open the Upload Invoices window.
5. Make sure that the "Selected items" option is selected.
6. Make sure the "ProPay" is selected in the Upload Format section. If you would like to append

your name to the invoice number field in the upload file, put a check in the box that reads "Append
my name to invoice #"". (Appending your name to the invoice number field causes your name to
be printed next to the charge amount on your customer’s credit card statement for identification
purposes).

7. Enter the email address you use to log into ProPay in the space provided.
8. Click on Upload.
9. Click OK when asked to confirm that you would like to charge your customers’ credit card(s).

 

Invoices can also be selected by date using the other selection options in the invoices section of
the Upload Invoices window.
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Once uploading is complete, an Upload Results box will be displayed containing the following
information:

 

 

 

Attempted the number and total value of payments uploaded to ProPay for
processing.

Succeeded the number and total value of payments successfully processed by
ProPay.

Failed the number and total value of payments that were not successfully
processed.
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Previously .. the number and total value of payments that were not uploaded because
they have already been successfully processed.

6.5.9 Receivables

 

Customers who have a Balance Due can be located several ways. One way is to click on the
Balance column heading on the Sales screen to sort the list by the amounts in that column. A
second way is to preview or print a Balance Dues report or Invoices report on the Reports screen,
while checking the "Show Balance Dues only" checkbox in the report filtering window. Finally, you
can use the Filter button in the Contacts screen and select the Sales filter option that reads "Select
only those contacts who have a balance due".

You can also have the program notify you any time you select a customer who has an outstanding
balance using the "Notify if customer has a balance due" option (Settings button on the Edit Sales
screen).

6.6 Purchases

6.6.1 Overview

The Purchases screen is used to enter all expenses resulting directly from the purchase of products
for resale.

 

The Purchases screen shows a listing of all of the purchase orders (POs) you have entered into the
program, unless some of those POs are hidden due to the "Only show records within the Current
Time Period" checkbox at the top of the screen being checked.
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6.6.2 Entering Purchases

6.6.2.1 Overview
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Product purchases are entered directly onto the Purchases screen. Here are the basic instructions
for entering a purchase. The links at the end of some of these steps contain more detailed information
regarding that specific entry.
 

1. Click on the Purchases button on the main program toolbar to go to the Purchases screen.
2. Click on the New button on the Purchases screen to add a new row to the display.
3. Date:  Enter the date you actually bought the products either by typing or using the pop-up

calendar. Dates can also be adjusted using the up and down arrows and PgUp and PgDn keys.
4. P.O. #:  Enter the invoice or order number found on the paperwork you received from your

company.
5. Vendor:  Select the vendor’s name from your list of contacts (Vendor).
6. Comment:  Enter a note regarding the purchase.
7. Event: Select the Event this purchase is associated with (optional - Event),
8. Product Enter the cost for resellable products as shown on the paperwork received from your

company.
9. Supplies Enter the cost for business supplies as shown on the paperwork received from your

company.
10.Disct Enter the amount of any discount that was applied to this order.
11.Frt Enter the freight or shipping and handling charge as shown on the paperwork received from

your company.
12.Tax 1 Enter the amount of sales or VAT tax (first tax rate) as shown on the paperwork received

from your company.
13.Tax 2 Enter the amount of sales or VAT tax (second tax rate) as shown on the paperwork

received from your company.
14.Credit Enter the amount of any credit that was applied to this order.
15.Method: Select the method of payment or leave blank if unpaid (optional - (Pay Method).
16.Check #: Enter the check number in the Check # box if applicable.
17.Click on Save to save your entries.
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6.6.2.2 Vendor

Select the name of the person or business you are purchasing the product(s) from. All of your
currently filtered contact listings are available for selection in the Vendor box or using the first ellipsis
(...) button to the right of the box. To add a new vendor to the list, or to enter a vendor name for this
purchase order only, click on the ellipsis button, then click on the New button in the Contacts
window. This will display the New Contact window, allowing you to enter a name, and select whether
this name should be added to your contact database (Add Contact) or saved only in association with
this P.O. (P.O. Only).
 

6.6.2.3 Event

Select the Event (if any) that this purchase is associated with. If this purchase occurred in
connection with a party, trade show or other type of Event, and you would like to be able to get
reports based on this Event, select the corresponding Event number from the available list. The list of
available events can be edited directly from the Purchases screen by clicking on the Events button
at the bottom of the screen. This button displays the Events window, showing a list of your previously
defined events.

6.6.2.4 Payment Method

 

Select the method of payment used to pay for the purchase being recorded. Check, Debit and
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Electronic payments are automatically deducted from your checking account. Credit payments are
automatically deducted from your credit card account.

Use the "(other)" payment options to indicate that an expense was not paid from one of your primary
business accounts. While this does not change your business records, it prevents the entry from
being "rolled up" into your Cash, Checking or Credit account registers.

If more than one payment method was used on a purchase, click on the ellipsis (...) button in in the 
Balance Due field for the purchase being entered or edited, to enter up to 10 individual payments for
each purchase.

6.6.3 Editing Purchases

 

 

To edit a previously recorded purchase entry, just do the following:
1. Double click on the entry to be changed.
2. Make the desired change.
3. Repeat Steps 1 – 2 for additional changes.
4. Click on Save to save all of your changes.
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6.6.4 Deleting Purchases

 

 

To delete a previously recorded Purchase entry, do the following:
1. Click on the Purchases button on the main toolbar to go to the Purchases screen.
2. Click on the row to be deleted. To delete multiple rows hold down your CTRL key while clicking.
3. Click on Delete to delete the purchase(s).

6.7 Personal Use and Samples

6.7.1 Personal Use

 
 
 



Financial Management 157

© 2011 MLM Software Solutions, Inc.

 

 

Resellable products used for your own personal use can be tracked using the Withdrawals option on
the Personal Use menu. Tracking personal use products in this manner makes it easier to estimate
the total value of personally used products for entry on the Taxes screen at the end of each year.
 

6.7.2 Samples

 

 

 

 

Resellable products used as promotional samples can be tracked using the Withdrawals option on
the Samples menu. This capability is provided for your convenience and is not a required entry.
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6.8 Loans and Trades

6.8.1 Loaned Products

 

 

 

 

Resellable products that you loan to a customer or to another distributor can be tracked using the 
Loan option on the Loans menu. This capability is provided for your convenience and is not a
required entry.
 

6.8.2 Borrowed Products
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Resellable products that you borrow from another distributor can be tracked using the Borrow option
on the Loans menu. This capability is provided for your convenience and is not a required entry.
 

6.8.3 Product Trades
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Product trades can be tracked using the Trades menu at the top of the screen. This capability is
provided for your convenience and is not a required entry.

6.9 Accounts

6.9.1 Cash Account

 

Your Cash account contains a listing of Expense and Purchase transactions where the selected
pay method is "Cash". Your Cash account also contains a listing of Income and Sale transactions
where the selected pay method is "Cash", if the Preferences option "Deposit Cash payments into
Cash account" is selected at the time the transaction is saved.
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Deposits to your Cash account are shown in black and withdrawals in red. Adjustments to your Cash
account can be made using the Adjust button in the Cash account window. This button displays the
Adjust Cash window allowing you to enter deposits or withdrawals that are not associated with an
Income, Expense, Sales or Purchase transaction. The Cash account register can be sorted by
clicking directly on any of the column headings. This sorted display can also be printed using the 
Print button in the Cash account window.

The account can be reconciled using the Reconcile button in the Cash account window. Individual
records can also be marked as reconciled  or as unreconciled, by right clicking on a row and then left
clicking on the desired option. Please see Reconciling an Account for instructions on reconciling
your Cash account.

6.9.2 Checking Account

 

Your Checking account contains a listing of Expense and Purchase transactions where the
selected pay method is "Check", "Debit" or "Electronic". Although options exist to have Income and
Sales transactions entered automatically into your Checking account, it is typically better to enter
these deposits manually using the Adjust button in the Checking account window, so that the
deposits exactly match those on your bank statement.
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Deposits to your Checking account are shown in black and withdrawals in red. Adjustments to your
Checking account can be made using the Adjust button in the Checking account window. This
button displays the Adjust Checking window allowing you to enter deposits or withdrawals that are
not associated with an Income, Expense, Sales or Purchase transaction.

To establish your starting checking account balance in the program, just do this:
1. Reconcile any existing
2. Use the Adjust Checking window to enter a deposit or a withdrawal for the amount in your

checking account on the day you begin using the software.

The Checking account register can be sorted by clicking directly on any of the column headings.
This sorted display can also be printed using the Print button in the Checking account window.

The account can be reconciled using the Reconcile button in the Checking account window.
Individual records can also be marked as reconciled  or as unreconciled, by right clicking on a row
and then left clicking on the desired option. Please see Reconciling an Account for instructions on
reconciling your Checking account.

6.9.3 Credit Account

  

Your Credit account contains a listing of Expense and Purchase transactions where the selected
pay method is Credit.
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Deposits to your Credit account are shown in black and withdrawals in red. Adjustments to your
Credit account can be made using the Adjust button in the Credit account window. This button
displays the Adjust Credit window allowing you to enter deposits or withdrawals that are not
associated with an Expense or Purchase transaction.

The Credit account register can be sorted by clicking directly on any of the column headings. This
sorted display can also be printed using the Print button in the Credit account window.

The account can be reconciled using the Reconcile button in the Credit account window. Individual
records can also be marked as reconciled  or as unreconciled, by right clicking on a row and then left
clicking on the desired option. Please see Reconciling an Account for instructions on reconciling
your Credit account.

6.9.4 Reconciling an Account

 

To reconcile your Cash, Checking or Credit account, just do the following:
1. Open the account you wish to reconcile using the Accounts menu or the icons to the right of the

Current Time Period at the top of the screen.
 

2. Click on the Reconcile button in the account window to display the Reconcile window.
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3. If you have previously reconciled this account, the Opening Balance should be automatically

filled in with your previous Closing Balance. If this is your first time reconciling this account,
leave the Opening Balance empty for the time being.
 

4. Enter the ending balance from your bank statement in the Closing Balance box.
 

5. The Interest and Service Charge boxes are provided for convenience and perform essentially the
same function as entries made using the Deposits /Withdrawals button from the account
window. The Interest and Service harge boxes are disabled when reconciling the Cash account.
 

IMPORTANT: Entries recorded using the Interest and Service Charge boxes only affect your
account register and are not reflected in your business or tax records. To have these entries
become part of your business records make the entries on the Income and Expenses
screens instead of from the Reconcile window.

6. Check off the records you want to reconcile by clicking with your mouse in the Clear column next
to the reconciled item. This will turn that record yellow and enter a "C" in the Clear column
indicating that it has been cleared and will be reconciled when the Reconcile button is clicked.
To limit the display to records entered during the Current Time Period right click on the grid
display and then left click on the Impose Current Time Period option. To include records in the
display that have already been reconciled, right click on the grid display and then left click on 
Include reconciled records. The display can also be limited to display only deposits, only
withdrawals, or both types of transactions, using the checkboxes located just below the Help
button.
 

7. If you want to save the changes you’ve made but are not yet ready to permanently reconcile the
records, click on the Finish Later button to save your current status. To discard all of the
changes made since the Reconcile window was opened click on Cancel.
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8. When you’re done checking off records, the Cleared Balance should match the Closing

Balance leaving the entry in the Difference box at exactly zero, unless this is your first time
reconciling this account. If this is your first time reconciling, then the value in the Difference box
is likely to be negative. Enter the value found in the Difference box as a positive value in the
Opening Balance box, so that the value in the Difference box becomes zero. You can then
click on the Reconcile button to permanently reconcile the selected entries. If the Difference
box shows a value other than zero, you can still click on the Reconcile button, but the program
will warn you that an automatic adjustment entry will be required. The program will then make an
adjustment to your account in the amount necessary to make the Difference between the
Closing Balance and the Cleared Balance equal to zero.
 

6.10 Vehicles

6.10.1 Overview

  

 

 

The Vehicles screen is used to keep track of deductions resulting from the business use of one or
more of your personal vehicles. It allows you to deduct  expenses for as many vehicles as you
choose using either the "Standard Mileage Rate" or the "Actual Expenses" method.
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Vehicle information that you enter into the program is included in the program's Income Tax report
and is summarized in the Vehicle Summary report, both of which are available on the Taxes screen

 

The screen has three areas as follows:
Vehicles: This section of the screen contains a list of all of the vehicles you have ever used for a
business purpose. It's perfectly fine to leave vehicles on this list even if you're no longer using them
in your business, since the program's reports will ignore them unless they have mileage or
expense entries that occur within the time period for which the report is generated.

Mileage (or Expenses): This section of the screen contains a list of all of the mileage or expense
entries you've made for the vehicle that's currently selected in the Vehicles section of the screen.
The heading for this section of the screen will change between Mileage and Expenses depending
on the Deduction Method of the currently-selected vehicle.

Total Mileage (Expenses) for: This section of the screen contains summary information for the
currently-selected vehicle. All of the monthly columns as well as the "Total" column in this display
will be filled in automatically, either by having the "Recalculate totals automatically" checkbox
checked or by clicking on the Recalc button from time to time after entering new records. The
heading for this section of the screen will change between Mileage and Expenses depending on
the Deduction Method of the currently-selected vehicle.

6.10.2 Entering Vehicle Information

 

 

To add a vehicle to the program so you can start tracking deductions just do this:
1. Click on the Vehicles button on the main toolbar to go to the Vehicles screen.
2. Click on the New button in the Vehicles section of the screen to add a new vehicle record to the
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display.
3. Select a deduction method in the Vehicle Deduction Method window and click OK.
4. Enter the Make and Model and select the model Year of the vehicle.
5. Enter the Start Date by typing or using the pop-up calendar.
6. Click on Save in the lower right corner of the screen.

Note: Entering or changing the Start Date will cause the display at the bottom of the Vehicles
window to be populated with the years for which this vehicle could be "in service". You will want to
use this display to track the Starting Odometer reading, Ending Odometer reading and Commute
Miles (miles to and from your regular job) for your vehicle for each year that you use it in your
business.

 

To add a mileage or expense entry just do this:
1. Make sure that the vehicle you are adding mileage or expenses for is selected in the Vehicles

section of the Vehicles screen.
2. Click on the New button in  the Mileage (or Expenses) section on the right side of the Vehicles

window. (The heading on this section will depend on which Deduction Method is being used for
the currently-selected vehicle.)

3. Enter the Date by typing or using the pop-up calendar.
4. If the Deduction Method for this vehicle is "Actual Expenses" enter the Amount and Purpose

(what you purchased) into the new row in the display. If the Deduction Method for this vehicle is
"Standard mileage rate", enter the Origin (where you started), the Destination (where you ended
up), total Mileage and Business Purpose (why you made this trip) into the new row in the
display. These entries will automatically complete if you have previously entered the same
information providing that the "Automatically complete typing" option is selected in the 
Preferences window.

5. If you're adding more than one row, click on New again each time you would like to add a new row
to the display. New rows will also be automatically added to the display if you press your TAB key
at the end of the last row in the display.

6. Click on Save to save your new entry(ies).

At the end of each year you will need to make the following entries into the table at the bottom of the 
Vehicles screen.

1. Ending Odometer: the reading on your car's odometer at the end of the year. This entry will
automatically carry over to the Starting Odometer field for the next year.

2. Commute Miles: the number of miles driven to and from your regular job during the year.
3. For vehicles using the Actual Expenses deduction method, you will need to enter the total

Business Miles driven during the year so that the program can calculate the percentage of car
expenses that are deductible based on the percentage of total miles that were driven for business.

4. For vehicles using the Standard Mileage Rate deduction method, you will need to enter the rate
per mile ($ per mile) that is allowed for a tax deduction. If this rate changed during the tax year,
enter a second rate ($ per mile) in the second field provided, then enter or select the date that the
rate change took effect.

Note: All of the monthly columns as well as the "Total" column in the bottom display will be filled in
automatically, either by having the "Recalculate totals automatically" checkbox checked or by
clicking on the Recalc button from time to time after entering new mileage or expense records.

http://www.unclefed.com/IRS-Forms/2001/p463.pdf
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6.10.3 Editing or Deleting Vehicle Information

 

 

To edit vehicle information in any section of the Vehicles screen::

1. Click into a field and make changes.
2. Click on Save to save your changes.

Note: The Deduction Method field cannot be changed once you have added a new vehicle to
your records. If you change the method used for deducting expenses on a vehicle just enter a
new record for that vehicle. This way, all of your previously-entered records will stay intact for
recordkeeping purposes.

 

To delete a vehicle record:

1. Click on a row in the Vehicles section of the Vehicles screen.
2. Click on the Delete button in the Vehicles section of the screen.
3. Repeat Steps 1- 2 to delete more vehicle records.
4. Click on Save to permanently delete the vehicle record.

 

To delete a mileage or expense record:

1. Click on a row in the Mileage or Expenses section of the Vehicles screen.
2. Click on the Delete button in the Mileage or Expenses section of the screen.
3. Repeat Steps 1-2 to delete more mileage or expense records.
4. Click on Save to permanently delete the record(s).

 



Financial Management 169

© 2011 MLM Software Solutions, Inc.

6.10.4 Importing Mileage Records

Mileage data from other applications, including most smart phone mileage-tracking applications, can be
imported into the program to eliminate having to enter data twice. If your favorite mileage-tracking
application isn't in our list of supported programs submit a support ticket to us and we'll be happy to look
into adding it.

To import mileage data into the Vehicles screen do the following:

1. Select the appropriate vehicle from the table in the upper left corner of the Vehicles screen. The
selected vehicle must be set to use the "Standard mileage rate" method of deduction for the Import
button to be enabled.

2. Click on the Import button located under Mileage table on the Vehicles screen. This will open up
the Import Mileage window.

3. Select the application from which you exported mileage data in the first selection box. If the
application you use isn't listed please submit a support ticket to us and we'll be happy to look into
adding it. For instructions regarding the "Other" option listed in the box, please see below.

4. Click on the ellipsis (...) button next to the second entry box and browse to locate the file you wish to
import.

5. Click on Import to load the records into the Vehicles screen. A confirmation window will be displayed
once importing has been completed, telling you how many records were imported and how many
duplicates were skipped.

6. Click OK to close the confirmation window.
7. Click Cancel to close the Import Mileage window.
8. Examine the records that were imported on the main Vehicles screen. Make changes as required,

then click on Save to save the imported entries. You must click on Save in order to permanently
save the imported records.

Records can also be imported using a built-in, default CSV file format. To use the "Other (see Help)"
import option, the import file must be a CSV (comma-separated value) file in the following format:

Position
in file

Contents

1 Date
2 Origin
3 Destination
4 Starting odometer reading (optional - required if miles driven is not provided)
5 Ending odometer reading (optional - required if miles driven is not provided)
6 Miles driven (optional - required if odometer readings are not provided)
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7 Rate per mile (optional - not currently used)
8 Notes / business purpose (optional but required by taxing agencies)

6.11 Taxes

6.11.1 Overview

 

 

 

 

The Taxes screen is designed to assist you in easily and accurately preparing your business income
and sales tax reports. If your company collects and pays sales tax for you then you will not need to
use the sales tax portion of this screen.

 

Income Tax

To prepare your business income tax reports select the "Income tax for the year" option at the
top of the Taxes screen, then select the year for which you are preparing taxes. If your
business operates on a non-calendar fiscal year (e.g. July 1 - June 30), you will need to print
your Income Tax report from the Reports screen instead of from the Taxes screen. Printing
this report from the Reports screen allows you to specify the time period for the report using
the Current Time Period at the top of the program. This option for printing the report is only
available in the Professional Edition of the program.



Financial Management 171

© 2011 MLM Software Solutions, Inc.

Next, follow the instructions displayed on the Taxes screen to make sure your records are
complete and accurate prior to printing or exporting your data.

 

Sales Tax

To prepare your business sales tax report select the "Sales tax from" option at the top of the 
Taxes screen, then select the time period  for which you are preparing taxes.

Next, follow the instructions displayed on the Taxes screen to make sure your records are
complete and accurate prior to printing your sales tax report.

 

6.11.2 Inventory and Cost of Goods Sold (Full-Inventory)

 

The Inventory and Cost of Goods Sold display in the lower left corner of the Taxes screen must be
completed prior to printing your final Income Tax report. Please see the instructions on the Taxes
screen for information on completing the entries in this section of the screen.

 

6.11.3 Printing Tax Reports

 

Tax reports are printed using the options in the lower right corner of the Taxes screen. Please see
the instructions displayed on the Taxes screen to make sure your entries are complete and accurate
prior to printing final tax reports.
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6.11.4 Obtaining a Free Tax Preparation Price Quote

 

Your data can be exported and sent to our partner accounting firm for a free tax preparation price
quote, using the appropriate option in the lower right corner of the Taxes screen. Please see the
instructions displayed on the Taxes screen to make sure your entries are complete and accurate
prior to using this option. You will be asked to confirm that you have reviewed your data in this
manner prior to the data actually be exported and sent.

 

6.11.5 Exporting Data to TurboTax or TaxCut

 

Your data can be exported to a ".txf" file for importing into popular tax preparation software including
TurboTax and TaxCut, using the appropriate option in the lower right corner of the Taxes screen.
Please see the instructions displayed on the Taxes screen to make sure your entries are complete
and accurate prior to using this option.

 

Exporting in the ".txf" format currently includes / excludes the following types of information. Most of
the exclusions are due to limitations in the TXF specification that do not allow the inclusion of all
fields necessary to fill out your tax forms.

 

Included
Product sales and sales of supplies from the Sales screen (Schedule C - Line 1)
Income entries from the Income / Expenses screen (Schedule C - Line 1)
Product Cost of Goods Sold (Schedule C - Lines 4 and 42)
Expense entries from the Income / Expenses screen (Schedule C - Part II and Part V)
Home office expenses (Schedule C - Line 30)

Excluded
Product purchases and personal use (Schedule C - Line 36)
Car and truck expenses (Schedule C - Line 9)

 

6.12 Miscellaneous

6.12.1 Drop Ships

 

Sales transactions in which the product is drop-shipped to your host or customer, directly from your
parent company, need not be shown as a sales transaction unless you personally receive
payment for or make payment for the products that are purchased. If the money never passes
through your hands you can simply record the income you receive from your parent company as a
result of the transaction using the Income screen. If you’d like to have a record of what was
purchased and by whom, check the "Commission only" checkbox on the Sales screen when you
record the sale. This will give you a filterable, sales record without impacting your financial records
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6.12.2 Free Products

 

Sales

"Free" products you give away at no cost should be entered on the Sales screen or using the
Withdrawal option on the Samples menu. When entering free products on the Sales screen,
first select the product then enter a "0" in the Unit Price box for that line item.

Purchases

There is nothing special you need to do when you receive free products from your company.
Simply enter a purchase that includes free products in the same manner you would enter any
other purchase.

6.12.3 Obsolete Products

There is nothing you need to do when a product must be disposed of because it is obsolete, whether
or not you receive replacement product from your company. The impact of this event, if any, will be
accounted for when you add up your ending inventory on the Taxes screen at the end of the year.

6.12.4 Product Exchanges

 

If a customer wishes to exchange a product just edit the original Sales entry for that item and make
the appropriate change.

6.12.5 Product Returns

 

How you handle a product return depends on whether or not you have already been paid for the
product as follows:

 

If you have not yet been paid for the product

Just delete the Sales entry for that item.

If you have already been paid for the product

Leave the original Sales entry intact and unmodified.
Record an Expense transaction on the Income / Expenses screen using the "Returns"
category for the amount refunded to your customer.



Part

VII

Reports
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7 Reports

7.1 Printed Reports

 

All of the summary and historical information available throughout the program, is also available for
full-page preview and printing from the Reports screen. In addition, this screen offers numerous
reports not accessible from other parts of the program, as described below.
 

 

Contacts

Contacts (half-page): an alphabetical listing of all of the selected address records, displayed in
an 8 ½" x 5 ½" (personal organizer) format.
Contacts (full-page): same as above in an 8 ½" x 11" (landscape) format.
Contacts (notes): complete listing information for all of the filtered address records, displayed in
an 8 ½" x 11" (portrait) format.
Rank and Process: an alphabetical listing of all currently filtered contact names, showing each
person’s rank and a list of the process steps they have completed.
Team (genealogy): a hierarchical tree diagram of all of the selected downline listings.
Team (ID numbers): an alphabetical listing of downline names and I.D. numbers for the current
business.
Contacts (custom): this report option allows you to create and save custom contact reports by
selecting from any of your contact fields.

 

Financial

Profit / Loss: a conventionally formatted statement of income, expenses, gross margin and pre-
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tax income..
Balance Sheet:  (Full-Inventory Edition) a statement of assets and liabilities based partly on
entries made throughout the program and partly on entries made in the Balance Sheet
Settings window.
Income Tax Report: an IRS-formatted statement containing exactly the numbers you need to
fill out Federal Tax Schedule C. In general, the recommended way to print this report is from the 
Taxes screen. If you need to use a time period that's different than a calendar year (e.g. July 1
2007 through June 30 2008), set the Current Time Period to the desired date range, then print
the report using the "Income Tax Report" option on the Reports screen.
Invoices: an index of all invoices created during the Current Time Period.
Purchase Orders: an index of all purchase orders created during the Current Time Period.
Checking: a history of all checking account activity during the Current Time Period.
Credit Card: a history of all credit card account activity during the Current Time Period.
Cash: a history of all cash account activity during the Current Time Period.
Event Summary: a summary of activity for a selected event including profits.
Host Summary: a summary of activity for a selected event. not including profits.
Reorder Summary: a summary of reorder activity during the Current Time Period. A reorder
sale is any sale for which the Reorder checkbox on the Sales screen was checked when the
sale was recorded. Freight and tax will be included unless the option to exclude them has been
selected.
Monthly Summary: a summary of financial activity for any selected month. Freight and tax will
be included unless the option to exclude them has been selected.
Yearly Summary: a summary of financial activity for any selected year. Freight and tax will be
included unless the option to exclude them has been selected.
Income: a summary or history of your income entries for the Current Time Period.
Expenses: a summary or history of your expense entries for the Current Time Period.
Sales: a summary or history of your sales entries, excluding all freight and tax, for the Current
Time Period
Purchases: a summary or history of your purchase entries, excluding all freight and tax, for the
Current Time Period.
Samples: a summary or history of your sample entries, excluding all freight and tax, for the
Current Time Period.
Personal Use: a summary or history of your personal use entries, excluding all freight and tax,
for the Current Time Period.
Loans: a summary or history of your borrow and loan entries, excluding all freight and tax, for
the Current Time Period.
Trades: a summary or history of your trade entries, excluding all freight and tax, for the Current
Time Period.
Inventory:  (Full-Inventory Edition) a summary or history of inventory transactions, excluding all
freight and tax.
Backlog:  (Full-Inventory Edition) a summary or history of your current inventory backlog.
Inventory Adjustments:  (Full-Inventory Edition) a summary or history addition and withdrawal
adjustments for the Current Time Period.
Balance Dues: a history of all invoices showing a balance due, along with contact and credit
card information.
Discounts and Credits: a history of all invoices where a Discount or Credit was entered.
Product Profitability: a profitability analysis for selected products.
Client Profitability: a profitability analysis for selected clients.
Event Profitability: a profitability comparison of selected Events.
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7.2 Report Options

 

 

 

Page and Font formatting are available for all reports via the Options button on the Reports screen.
This button displays the Report Options window allowing you additional options as follows:
 

Include ID numbers in Team Hierarchy Instructs the program to include your team members’
ID numbers, as entered on the Contacts screen,
when previewing or printing a Team Hierarchy
report.

Add back Discounts in determining
Host Credit Due

Instructs the program to add back the value of all 
Discounts entered on the Sales screen when
calculating the Host Credit Due in the Event
Summary and Host Summary reports.

Add back Credits in determining Host
Credit Due

Instructs the program to add back the value of all 
Credits entered on the Sales screen when
calculating the Host Credit Due in the Event
Summary and Host Summary reports.

Use absolute percentage in
determining Host Credit Due

Instructs the program to base the Host Credit Due
on the exact result of multiplying the Host Credit
Percent by the Total Retail in the Event Summary
and Host Summary reports. If this option is not
selected, the Total Retail is rounded down to the
next $100 increment before being multiplied by the 
Host Credit Percent to determine the Host Credit
Due.

 
 

Replace Customer with Notes on
Sales / Purchase …

Instructs the program to use the Notes field instead
of the Customer field on Sales and Purchase
Histories.
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Replace Comment with Event
Description …

Instructs the program to use the Event Description
instead of the PO or Invoice Comment on Invoice
and PO reports.

Exclude Freight and Tax in… Instructs the program to exclude the value of Freight
and Tax in preparing the listed reports.

Replace supporting entries with Tax
fields…

Instructs the program to use the Tax fields instead of
the Travel, Meals, Entertainment and Mileage
supporting entries in the Expense History report (this
option is only available if you have elected to have
one or both of the tax columns visible on the Income
and Expenses screens - see Settings Menu -
Preferences ).

7.3 Filtering Reports

Many of the reports available on the Reports screen can be filtered based on one or more of the
report's fields. Filter selection boxes (if applicable) are automatically displayed whenever you click on
either the Preview or Print button at the bottom of the Reports screen. Many reports can also be
sorted on up to three fields by clicking on the Sort button in the filter window.

 

Filter settings only affect the very next Preview or Print operation. You can create one or more filter
"templates" using the Save option on the File menu in the report filter window. Saved templates can
be recalled using the Open option on the File menu. Saving a filter template saves the first 50
selections in each of the "Filter" selection boxes.
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To print a filtered report after previewing it, use the Print button at the bottom of the Preview window.
Closing the Preview window and then clicking on Print will require you to re-select your filter
settings.

 

The financial filter window contains the following options:

 

Report Heading Reflects the report heading for the report being created. Choose to use
the default heading ("Use default"), which automatically reflects the filter
settings you select, or create your own heading using the Allow
editing option.
 

Report Dates A filter allowing you to select whether to view all records regardless of
date or to view only records within a specific time period. The filtering
time period defaults to the Current Time Period you have set at the
top of the main screen. Dates can be changed by typing, using your up
and down arrow keys or using the pop-up calendar.
 

Filter by Customer A filter allowing you to limit the report to transactions involving one or
more of your customers. Right clicking allows you to select or deselect
all of the items in the Filter by customer selection box. Clicking on the
ellipsis (…) button to the right of the Filter by customer selection box
allows you to select contacts directly from the main Contacts window.
Clicking on the Filter button to the right of the Filter by customer
checkbox, allows you to Filter, Search or Select which contacts
appear in the Filter by customer selection box. (Note: Contact Filter,
Search and Select results are not saved when you save your filtering
conditions using the Save option on the File menu in the Filter by
customer window. The list of contact names always includes all of your
contact listings each time the filtering window is opened).
 

Filter by Product A filter allowing you to limit the report to transactions involving one or
more products. Right clicking allows you to select or deselect all of the
items in the Filter by product selection box. Clicking on the ellipsis
(…) button to the right of the Filter by product selection box allows you
to select products directly from the main Products window. Holding
down your CTRL key while clicking with your mouse in the Products
window allows you to select more than one product at a time.
 

Filter by Event A filter allowing you to limit the report to transactions involving one or
more Events. Right clicking allows you to select or deselect all of the
items in the Filter by Event selection box. Clicking on the ellipsis (…)
button to the right of the Filter by Event selection box allows you to
select events directly from the main Events window. Holding down your
CTRL key while clicking with your mouse in the Events window allows
you to select more than one Event at a time.
 

Filter by Category A filter allowing you to limit the report to transactions involving one or
more categories (e.g. Income or Expense categories like
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"Commissions" or "*Office Expenses"). Right clicking allows you to
select or deselect all of the items in the Filter by category selection
box.
 

Filter by Method… A filter allowing you to limit the report to transactions involving one or
more methods of payment. Right clicking allows you to select or
deselect all of the items in the Filter by method of payment selection
box.
 

Show Reorders only An option to limit the report to transactions where the Reorder
checkbox on the Sales screen was checked when the transaction was
recorded.
 

Show Balance Dues
…

An option to limit the report to transactions where full or partial payment
is still due.
 

Show Not Delivered
…

An option to limit the report to transactions where the Del checkbox on
the Sales screen or the Rcv box on the Purchases screen was not
checked when the transaction was recorded.
 

Show Not Returned … An option to limit the report to Loan and Borrow transactions where
the product loaned or borrowed has not been marked as returned.
 

Show zero dollar
Sales…

An option to limit the Sales report to line items where the price was set
to zero dollars.
 

Order type A filter allowing you to distinguish between Inside and Outside Event
sales
 

Taxability An option to limit the report based on whether or not an item was set as
taxable at the time the entry was recorded.

 

Direct Update credit An option to limit the report based on whether or not a Sales
transaction reflects an imported "credit" brought in using the Update
Direct function on the File menu (only visible for companies that
support Direct Updating).

7.4 Sorting Reports

 

Many of the reports available on the Reports screen can be sorted on up to three fields prior to
previewing or printing. If a report is sortable, then clicking on Preview or Print will either display the
Sort window directly or there will be a Sort button available in the report filtering window.

 

The Sort window allows you to select up to three fields for sorting in either ascending or descending
order. The sequence of the fields selected in the Sort window is the sequence in which the report will
be sorted. The first field selected will be the overriding sort field. Viewing the report it should be
obvious that this was the field that the report was sorted on. Selecting a second sort field will cause
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the report to be sorted by that field only where there are records with identical values in the first sort
order field. Selecting a second sort field will not disrupt the sort order based on the first field.

 

All of the "spreadsheet" type displays throughout the program can also be sorted prior to printing by
clicking directly on any of the column headings in the display. The program will remember the last
sort order of each display and will automatically sort the window that way the next time it is opened.

7.5 Custom Contact Reports

 

This option allows you to create and save custom contact reports. Clicking on the Contacts
(custom) report option displays the Contact Custom Report window.
 

 

Clicking on any of the column headings in this window allows you to select any of your contact
database fields to be included in the report. Selecting a field will also cause the display to be filled in
with entries from your contact database. Fields in the report can be resized using your mouse by
hovering over the line between two fields in the gray column heading area. Page and font formatting
are also available via the Page and Font buttons in this window.

 

Report definitions can be saved for reuse using the Save option on the File menu. You can also
Open or Delete saved reports using the respective options on the File menu.

 

Before previewing or printing a custom report you can use the Filter button in the Custom Contact
Report window to apply filter, search and select conditions that will determine which listings get
printed in the report



Consultant Front Office Version 11182

© 2011 MLM Software Solutions, Inc.

7.6 Profit Loss Report

 

The Profit / Loss report is an income statement that gives you a snapshot of how your business is
doing from a financial standpoint. The following descriptions explain how  the numbers in this report
are calculated.

 
 

Sales The sum of all sales entries with the exception of Supplies. This total
includes any freight and tax that were entered as part of your sales
transactions.
 

Other Income The sum of all income entries plus entries made in the Supplies field on
the Edit Sales screen.
 

Purchases The sum of all purchase entries with the exception of Supplies. This total
includes freight and tax that were entered as part of your purchase
transactions.
 

Operating
Expenses

The sum of all expense entries plus entries made in the Supplies field on
the Edit Purchases screen.
 

Gross Margin The result of subtracting Purchases from Sales and then dividing by Sales
. Gross Margin = (Sales – Purchases) / Sales

 

Upgrading From a Previous Version

If you have used this program to manage your business  in previous years, you may notice that the
"Operating Expenses" entry no longer exactly matches the earlier value. This is because vehicle
expenses are no longer included in this report.

 

7.7 Balance Sheet Report

 

All of the values in the Balance Sheet report are governed by the Current Time Period
setting at the top of the screen. The following descriptions explain how some of the numbers on
this report are calculated.

 

Cash, Checking,
Credit

The current balances of your Cash, Checking and Credit accounts.
Positive balances are shown in the Assets column and negative
balances in the Liabilities column.

Receivables The sum of all outstanding balances on sales invoices.

Payables The sum of all outstanding balances on purchase orders.
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The remaining items on the Balance Sheet report are based on the entries you make in the Balance
Sheet Settings window.

7.8 Income Tax Report

The Income Tax Report is a Schedule-C formatted document containing everything you need to fill
out your business tax forms. When printed from the Reports screen, all of the values in the Income
Tax Report are governed by the Current Time Period. When printed from the Taxes screen, the
year selected at the top of the screen governs the values that appear in the report.

 

The following descriptions explain how some of the numbers on this report are calculated.

 

Line 1: Gross Receipts The sum of all Income and Sales entries including Supplies,
Freight and Tax for the specified time period. If you pay sales
or VAT tax to your Board of Equalization or other tax agency,
make sure that you have entered all of your tax payments on
the Expenses screen prior to printing your final tax report. If
you have any unpaid balances (Bal Due) on the Sales
screen, please talk to your tax advisor about how these
balances should be accounted for. The correct way to handle
these balances will depend on the method of accounting
(Cash or Accrual) being used for your business.
 

Line 4: Cost of Goods Sold Copied from Line 42: Cost of Goods Sold, this number
represents the cost of all of the products you purchased during
the specified time period that are not still on your shelf and
that were not used for your own personal use.
 

Line 6: Other Income Specific types of income that should not be relevant to your
business. This field is always set to zero.
 

Line 9: Car Expenses The sum of all vehicle deductions that were entered on the 
Vehicles screen for the specified time period.

 

Line 22: Supplies

 

 

 

Line 30: Home Office

The sum of all expense entries entered using the "*Supplies"
expense category PLUS the value of all Supplies entered on
the Purchases screen.

 

The prorated sum of all home office deductions that were
entered on the Home Office screen for the specified time
period. This value may be less than you expect if your home
office deduction is limited due by the amount of income earned
in your business.

 

Line 35: Beginning Inventory The value of your inventory at the beginning of the year for
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which the report is being printed (or the value at the beginning
of the Current Time Period if printing from the Reports screen).
 

LLine 36: Purchases less personal
use

The sum of all Purchases entries including Freight and Tax
but not Supplies, minus the sum of all Personal Use entries.
 

Line 39: Other Costs This value is always set to zero.
 

Line 41: Ending Inventory The value of your inventory at the end of the year for which the
report is being printed (or the value  at the end of the Current
Time Period if printing from the Reports screen).

 

Upgrading From a Previous Version

If you have used this program to prepare your business taxes in previous years, you will notice that
the values in the Income Tax report no longer exactly match the earlier values. This is primarily
because tax and freight payments that were previously split up between product purchases and
business supplies (aka Bus Items) are now added in their entirety to line 36 (Purchases less personal
use). This means that some tax and freight payments that used to show up as an expense in Part V
now show up in Part III as part of your Cost of Goods Sold. This change was made to make it easier
to verify the completeness and accuracy of your purchase entries, by simply comparing your entries
on the Purchases screen with the paperwork you receive from your company when you purchase
products.

7.9 Sales Tax Report

The Sales Tax Report contains information to assist you in paying sales or VAT taxes to your state
Board of Equalization or other tax agency. If your state or province does not charge tax on product
sales or if you pay this tax when you purchase your products, you will probably not need to use this
report. All of the values in the Sales Tax report are governed by the dates at the top of the Taxes
screen. The following descriptions explain how some of the numbers on this report are calculated.

 

Taxable Sales The sum of all Sales entries with the exception of Supplies and Tax
entries during the specified time period.

Taxable Freight The sum of all Freight entries made on the Edit Sales screen during the
specified time period, assuming you have instructed the program to
charge tax on Freight for product sales. Tthis line will not appear on the
report (please see Setting Tax Rates) if tax is not being charged on
freight.

 

Samples / Personal
Use

 

Basic, Standard and Professional: Estimate the cost of your Personal
Use and Sample usage. If you have used either or both of these menu
options to track the quantity of product used for these purposes you can
multiply the quantity times your typical cost to determine the total
amount.
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Full-Inventory Edition: The sum of the inventory values for all withdrawals
made in the Personal Use or Samples windows during the specified
time period.

Sales Tax Owed The result of multiplying your Taxable Total by the current sales tax
rate setting which is also shown in this report under the Sales Tax Rate
heading.

Purchase Tax Paid The sum of all of the tax entries that were entered on the Purchases
screen during the specified time period.

Balance / Refund
Due

The result of subtracting Purchase Tax Paid from Sales Tax Owed.

Total Sales The sum of all of your Sales  during the specified time period excluding
Freight and Tax.

 

 

The Sales Tax Owed can be different from the Purchase Tax Paid for the following reasons:
You will typically pay tax on the retail price for all of the taxable products you purchase, but the
program will calculate the tax you owe on Personal Use and Sample products based on their cost.
Whether or not this is correct for your business depends on the arrangements your company has
made with your particular state with respect to sales tax, if such an arrangement exists.
You did not collect the right amount of tax from your customers. This can happen if the tax
settings in place when some or all of your Sales were entered did not accurately reflect the way
your company charges tax when you purchase products.
The taxability setting for some of the products in the Products window did not accurately reflect
what your company charges you tax on at the time some or all of your Sales were entered.

7.10 Event and Host Summary Reports

 

The Event Summary report is a comprehensive summary of all activities that were linked to a
specific event at the time they were entered and is not governed by the Current Time Period
setting at the top of the screen. The following descriptions explain how some of the numbers on
this report are calculated.

 

 

Total Retail The retail total from all invoices that have been linked to this Event.
 

Retail COGS Basic, Standard and Professional Editions: The sum of all product
purchases that were linked to this Event when they were entered.

 

Full-Inventory Edition:The value (cost) of the items removed from your
inventory to fill orders for this Event. Inventory values are determined at
the time an item gets added to your inventory.
 

Event Income,
Expenses

The sum of all event entries made on the Income and Expenses
screen respectively.
 

Host Credit Basis This entry will be the same as the Total Retail shown in the Event
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Summary and Host Summary reports, unless you have selected
either the Include Discounts in determining Host Credit Due or
Include Credits in determining Host Credit Due report options.
These options are accessible via the Options button on the Reports
screen. Selecting either or both of these options will increase the
amount shown in the Host Credit Basis entry.
 

Host Credit Due The product of the Host Credit Percent and the Host Credit Basis for
this Event. If the option to Use absolute percentage in determining
Host Credit Due is selected in the Report Options window, then this
entry will be the exact result of multiplying these two values together. If
this option is not selected, then the Host Credit Basis will be rounded
down to the next $100 increment before being multiplied by the Host
Credit Percent to determine the Host Credit Due.
 

Inside Orders The number of event invoices with the Inside Order box on the Sales
screen checked when they were recorded.
 

Outside Orders The number of event invoices with the Inside Order box on the Sales
screen not checked when they were recorded.

 

Tip: The report Options that read "Include Discounts in determining Host Credit Due"  and "Include
Credits in determining Host Credit Due" will increase Event Sales in the Event Summary and
Host Summary reports by the amount of Discounts and Credits entered when the event’s
sales were entered. To exclude Discounts and Credits from the Event Sales totals in these
reports, leave this option unchecked.

7.11 Monthly Summary Report

 

The Monthly Summary report is a Profit / Loss statement for your business for the selected month.
The following descriptions explain how some of the numbers on this report are calculated. This report
includes freight and tax entries unless the option to exclude them has been selected using the 
Options button on the Reports screen.

 

 

Event Sales The sum of all sales for the selected month, for which an event was
selected in the Event box on the Edit Sales screen at the time the sale
was entered.
 

Reorder Sales The sum of all sales for the selected month, for which the Reorder
checkbox was checked on the Edit Sales screen at the time the sale was
entered.
 

Other Sales The sum of all sales for the selected month, for which no event was
selected in the Event box on the Edit Sales screen and the Reorder
checkbox was not checked at the time the sale was entered.
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Purchases The sum of all purchase entries for the selected month. This entry
includes the value of freight and tax entered on the Purchases screen.
 

Income The sum of all Income entries for the selected month.
 

Expenses The sum of all Expense entries for the selected month.
 

Net Profit or Loss Event Sales + Reorder Sales + Other Sales + Income – Cost of
Goods Sold – Expenses

7.12 Yearly Summary Report

 

The Monthly Summary report is a Profit / Loss statement for your business for the selected month.
The following descriptions explain how some of the numbers on this report are calculated. This report
includes freight and tax entries unless the option to exclude them has been selected using the 
Options button on the Reports screen.

 

Sales The sum of all Sales entries for the selected year.
 

Income The sum of all Income entries for the selected year.
 

Expenses The sum of all Expense entries for the selected year.
 

Profit Sales + Income - Cost of Goods Sold – Expenses
 

Events The total number of Events for the selected year.



Part
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8 Menu Bar

8.1 File

8.1.1 New Business

If the number of existing businesses is two or less, this option displays the Business Setup window
and prompts you to enter a name for the new business. If the maximum of three businesses already
exist the New Business menu option will be disabled.

8.1.2 Change Business

 

This option displays the Business Selection window and prompts you to select a business to open.

8.1.3 Rename Business

This option displays the Business Name Change window and prompts you to enter a new name for
the currently active business.
 

8.1.4 Backup

 

This option displays the Data Backup window allowing you to back up all of the business information
entered into the program.
 

 

Backing up your data allows you to rebuild your records in the event that your hard drive becomes
damaged or non-operational. The File Backup option backs up data for all of the businesses you're
currently tracking, no matter which business is currently selected. Checking the box that reads
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"Back up email and letters" may significantly increase the size of the backup file and the time it
takes to complete the backup operation.

To back up all of your business records for all of your active businesses just do this:
1. Click on the ellipsis (...) button to browse for a folder and select a location where the backup file

will be created.
2. Check or uncheck the Back up email and letters checkbox.
3. Click on the Backup button to begin the backup process.
4. Observe the confirmation window to ensure that the backup file was created successfully and that

you know the location it was saved to.

 

IMPORTANT: It is strongly recommended that you back up to an external hard drive, USB memory
stick or some other location that is not on your main hard drive, so that the backup file will not be
compromised in the event of a virus or hard drive malfunction. To have the program create backup files
for you automatically the first time it’s opened each day click on the Auto Backup Path option on
the File menu.
 

Tip:  Backup files are always named according to the following format: "emxxyyzz.ezb" where
"xxyyzz" is the month, day and year the backup file was created.

 

Backing up to a CD: USB memory sticks "(jump" drives) are usually the easiest way to back up
your data. As of this writing, Windows does not yet natively allow programs to write information
directly to a CD-R or CD-RW. If you try to back up directly to a CD you will encounter an error
(usually Error 52) and the backup process will be terminated. If you want to store your backup files on
a CD-R or CD-RW, select a Backup Folder on your computer’s hard drive for the backup operation.
Then use the CD-writing software that came with your CD drive to copy the backup file onto the CD.

8.1.5 Restore

This option displays the Data Restore window allowing you to reset your business records to a
specific date and time using a backup file generated by the program. Restoring data with this
function completely overwrites all entries in the program.
 

 

Since the restore files are only current up to the date of your last backup, the restoring process
results in the loss of all records entered since your last backup. If in doubt, perform a new
backup prior to restoring your data, to ensure that your current state can be resumed if
necessary.
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To reset your business records using an Consultant Front Office backup file, just do this:
1. Click on the ellipsis (...) button and select the backup file you wish to restore data from. Backup

files from some older versions of the program have a "zip" extension. To locate these files make
sure you select the "Version 3, 4, 5 (*.zip)" option from the Files of Type selection box in the
Open window after clicking on the ellipsis.

2. Check or uncheck the Restore email and letters checkbox.
3. Check or uncheck the Restore program settings checkbox. In general you will want to select

this option when restoring your data.
4. Click on Restore to finish the restoring process.
5. Click on OK when the program informs you that the data has been successfully restored.

8.1.6 Verify Backup

 

This option allows you to test a backup file created by the program to make sure that the file will be
usable to restore your data. The program verifies the integrity of backup files when they are created
but it’s highly recommended that you use this function to retest backup files prior to repairing your
computer or reformatting your computer’s hard drive.

8.1.7 Auto Backup Path

 

This option allows you to specify a path for the program to automatically back up your data to the first
time the program is opened each day.
 

 

This path should not be on the same hard drive where the program is installed. If you have more than
one physical hard drive set the path to a location on the second drive. If you do not have a second
hard drive, we recommend that you purchase an external hard drive or a USB memory stick and set
the Auto Backup Path option to a location on either of those devices.

Since a new auto backup file will be created each day when the program is first opened, you may
occasionally have to delete some of the older backup files to make room for newer ones. Consultant
Front Office backup files are named based on the date they get created so it’s easy to tell which files
are the oldest just by looking at the files on the stick.

8.1.8 Import - Contacts

 

This option allows you to import contact information from any comma-delimited (.txt / .csv) or tab-
delimited (.tab) file. All imported listings are automatically affiliated with the business you currently
have open and are assigned to the Import group for easy identification. For additional information on
importing please see Importing Contacts .
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8.1.9 Import - Content

 

This option allows you to import emails, letters and schedules packaged together according to the
specifications contained in our "Data Exchange Interface User Guide". Importing content into the
program gives you instant access to a wide variety of marketing and follow-up materials. Content
packages are available for purchase. They can also be created by the company you distribute
products for. Having your company prepare a content package for the program allows them to specify
recommended procedures for activities such as customer follow-up, host coaching and new recruit
training, while simultaneously equipping you with polished, ready-to-go marketing materials.

 

Content package importing can be initiated by:
"Opening" a content bundle file (.ezp) from the Internet
Double clicking on a content bundle file (.ezp)
Using the Browse button in the Import Content window to locate a content bundle file (.ezp)
Using the Import option on the File menu in the Email window.

Any of these operations will open the Import Content window and enter the path to the selected file
in the box provided. To finish, just click on OK.

If the OK button is not highlighted then  the path is not valid. Use the ellipsis (...) button at the end of
the box to browse and locate a valid content (.ezp) file.

8.1.10 Export - Contacts

  

This option allows you to export contact information into a comma-delimited (.txt / .csv) file. Clicking
on this menu option displays the Save As window, allowing you to specify a destination and filename
for exporting of contact listings. Exporting automatically reflects the results of your most recent 
Filter, Search and Select operations.

8.1.11 Export - Email List

 
  

This option allows you to export names and email addresses into a comma-delimited (.txt / .csv) file.
Clicking on this menu option displays the Save As window, allowing you to specify a destination and
filename for exporting of contact listings. Exporting automatically reflects the results of your most
recent Filter, Search and Select operations.
 

This option differs from the Export – Contacts option in that it exports only email address
information. Each entry in the export file contains the following information:
 

"First Name Last Name" <email address>
 

This format is ideal for uploading to online systems such as eCard, and results in recipients receiving
emails addressed to them by name instead of by email address.

8.1.12 Export - iCentris
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This option allows you to export contact information into a comma-delimited (.csv) file that is
compatible with the iCentris importing function. Clicking on this menu option displays the Save As
window, allowing you to specify a destination and filename for exporting of contact listings. Exporting
automatically reflects the results of your most recent Filter, Search and Select operations.

8.1.13 Update Custom

 

This option displays the Update Custom window allowing you to specify the path for a custom
update file. This feature can be used to automatically update your product information when new
products are introduced or when pricing changes are made to existing products. The Update
Custom window can also be opened by double clicking on a custom update (.ezc) file.

When the Update button is clicked, the program will first allow you to specify whether you would like
all new products to be set as taxable. The taxability setting for each product can be changed after
updating using the Product option on the Categories menu. Information in the custom update file will
then be compared with information in the product file already on your computer.

During updating, if a product item number from the update file is not found in the product file on your
computer, that product will be added to your computer’s product file. If the same product item number
is found in both files, pricing information from the custom update file will be used to overwrite the
pricing information on your computer.

Custom update files are only available from  MLM Software Solutions, Inc. If you would like to know if
an updated file exists for your company please click on the Support option on the Help menu and
submit a support request ticket.

8.1.14 Data Exchange - Import

 

This option displays the Data Exchange Import window allowing you to specify preferences and
initiate importing of product, purchase, sale, prospect and team information, depending on which of
these options have been implemented by your company.
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Note: In general, you should not need to click  on this menu option since opening or double click ing
on a data exchange (.ezd)  file will automatically open the Data Exchange Import window for you.

 

Availability

Data exchange importing allows you to update your product, team, purchase, sale, income and
prospect information using files downloaded from your company's website. This feature will only be
available if the company you distribute products for has implemented the programs "Data Exchange
Interface". If you would like MLM Software Solutions to contact your company regarding this
capability, please send us an email at service@mlmsoftwaresolutions.com with the name and
contact information of the person you would like us to contact.

 

ReadMe File

If your company has implemented the data exchange capability and you are able to click on the Data
Exchange - Import menu option,  then you can  find company-specific instructions for importing data
from your company's website using the ReadMe File option on the Help menu. Those instructions
are designed to be used in conjunction with this Help topic to cover all of the steps and options
available when importing data.

 

Importing

You will generally begin the importing process by logging into your company's website and clicking

mailto:service@mlmsoftwaresolutions.com
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on a link to download a file. Once you have initiated the downloading process on your company's
website, here's all you need to do to import the information in the file into your program:

 
1. After clicking to download the file from your company's website, you will usually be presented with

a choice of either saving or opening / running the file. In most cases you should be able to select 
Open or Run and have the program take over from there. If these options are not available or don't
activate the program's data exchange window, then you will need to save the file to your Windows
Desktop, click on the Data Exchange - Import option on the File menu and then locate the file
you just downloaded on your Windows Desktop.
 

2. With the Data Exchange Import window now open, either by "opening" a file from your
company's website or by saving it and then using the Data Exchange - Import option on the File
menu to locate it, you are now ready to set your import options and import the data. You will only
need to configure the Data Exchange Import window one time as it will remember your settings
each time after that. The following is an explanation of each of the window's importing options:
 
Update products and packages  – instructs the program to update your product listing using the
data in the update (ezd) file, by adding new products and adjusting the pricing for existing ones
 
Update orders - instructs the program to update your purchase history using the data in the update
(.ezd) file. This process checks to make sure that a purchase has not already been imported
before processing it so purchases will not be duplicated.
 
Update income – instructs the program to update your business income using the data in the
update (ezd) file.
 
Update team info for ID# - instructs the program to update your downline information using the
data in the update (.ezd) file. Updating your team adds and removes members as required.
Members are removed from your team by resetting their primary Group from Downline to
Inactive. Attempting to update team information using an ezd file from another consultant (e.g.
your spouse) will result in a warning intended to prevent you from inadvertently overwriting your
team information with someone else’s. If you are sharing business records with your spouse and
wish to import his or her financial information, make sure that you uncheck the Update team info
for ID# checkbox before clicking on Update.
 
Change product status – selecting the first option instructs the program to set the "Active" status
of all products based on the information in the update (.ezd) file. Selecting the second option
instructs the program to leave the "Active" status of products which are already in your product
listing unchanged.
 
Product Taxability - instructs the program as to how to handle the taxability setting for products
that are added during the update process. Selecting the third option allows you to set taxability
individually for each new product. Taxability settings can also be easily adjusted once updating is
complete using the Product option on the Categories menu.
 
Notify me if a team member becomes inactive - instructs the program to prompt you each time a
downline member is switched over to the Inactive primary Group category.
 

Selecting Sales and Purchases to Import

If the download file contains product sales, you will be presented with a window entitled Select Sales
For Importing. This window lists all of the sales in the download file for which there is no "perfect



Consultant Front Office Version 11196

© 2011 MLM Software Solutions, Inc.

match" in your program. If your program contains a possible match (same amount and approximately
the same date), then information for that matching order will be displayed adjacent to the import
order. A column will be displayed at the right of this window allowing you to select an Event to link
each imported sale  to. If the download file contains Event information this information will be selected
automatically. You will also be able to select a payment method for each order that you are
responsible for collecting payment on. At the far right of each line in this window is an "Import"
checkbox that is unchecked by default. To import an order, check the box. To skip an order, leave the
box unchecked. There's an "All" button at the top of the "Import" column that allows you to quickly
select all of the listed orders. This button changes to "None" after being clicked allowing you to de-
select all listed orders.

 

 

 

If the download file contains information about product purchases, you will also be presented with a
window entitled Select Purchases For Importing. This window behaves exactly the same as the
window for selecting sales described immediately above. If you selected Event information for an order
in the previous window and there's a matching order in this window, the Event information will be
selected automatically.

8.1.15 Data Exchange - Summary

This options displays the results of your last Data Exchange import operation. Data Exchange
Summaries are overwritten each time you perform a new import operation so you will need to save a
summary manually if you would like to have it to refer to in the future.

8.1.16 Delete - Business

 

This option allows you to delete the currently active business. Since deleting a business
completely eliminates the associated data files from your hard drive, it's strongly
recommended that you first back up these data files using the Backup option on the File
menu. Consultant Front Office will prompt you to perform a backup prior to executing the Delete -
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Business request.

8.1.17 Delete - Contacts

 

This option allows you to delete all listings currently stored in your Contacts database. Since
deleting these listings completely eliminates the associated data files from your hard drive, it's
strongly recommended that you first back up these data files using the Backup option on the
File menu. Consultant Front Office will prompt you to perform a backup prior to executing the Delete
- Contacts request.

8.1.18 Delete - Calendar

 

This option allows you to selectively delete from your Calendar all non-recurring appointments prior to
a specified date. Using this feature to clean out old appointments will improve program performance
and shorten the time it takes to synchronize with a Palm handheld organizer.

Checking the "Include Recurring Appointments" checkbox causes the program to delete all instances
of recurring appointments that occur prior to the specified date. Instances of recurring appointments
that fall on or after the specified date will not be deleted.

Since deleting appointments complete eliminates the associated data from your hard drive, it’s

strongly recommended that you first back up your data using the Backup option on the File
menu. Consultant Front Office will prompt you to perform a backup prior to executing the Delete –
Calendar request.

8.1.19 Delete - Memos

 

This option allows you to delete all of your Memos. Since deleting these records completely
eliminates the associated data files from your hard drive, it is strongly recommended that
you first back up these data files using the Backup option on the File menu. Consultant Front
Office will prompt you to perform a backup prior to executing the Delete - Memos request.

8.1.20 Delete - Tasks

 

This option allows you to delete all of your Tasks list entries. Since deleting these entries
completely eliminates the associated data files from your hard drive, it’s strongly
recommended that you first back up these data files using the Backup option on the File
menu. Consultant Front Office will prompt you to perform a backup prior to executing the Delete -
Tasks request.

8.1.21 Exit

 

Ends the program. Since Consultant Front Office continuously saves new entries and changes to
existing entries as they're made, there's no need to save before exiting.
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8.2 Categories

8.2.1 Income

 
 

 

This option displays the Edit Categories window, allowing you make changes to your list of
categories and to records you have saved using those categories. Here is a brief description of the
options available in this window:

 
Add:  Allows you to add new Income categories.
Rename:  Allows you to rename existing categories and have all of the records associated with
those categories changed to the new name.
Move:  Allows you to move records from one Income category to another.
Delete:  Allows you to delete an existing Income category. Any records that use  the deleted
category will be moved into the "Unfiled" category. If you would like these records in a different
category it's usually best to change them over to the new category first, using the Move function,
so that they don't end up in "Unfiled" when the original category is deleted.

Note: Not all Income categories can be renamed and deleted. If a category does not show up in the
selection box for either of these two functions then it is a protected category that the program
requires in order to function properly.

8.2.2 Expenses
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This option displays the Edit Categories window, allowing you make changes to your list of
categories and to records you have saved using those categories. Here is a brief description of the
options available in this window:

 
Add:  Allows you to add new Expense categories.
Rename:  Allows you to rename existing categories and have all of the records associated with
those categories changed to the new name.
Move:  Allows you to move records from one Expense category to another.
Delete:  Allows you to delete an existing Expense category. Any records that use the deleted
category will be moved into the "Unfiled" category. If you would like these records in a different
category it's usually best to change them over to the new category first, using the Move function,
so that they don't end up in "Unfiled" when the original category is deleted.

Note: Not all Expense categories can be renamed and deleted. If a category does not show up in the
selection box for either of these two functions then it is a protected category that the program
requires in order to function properly.

8.2.3 Products
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This option displays the Products window, allowing you to add new products and to edit or delete
existing ones.

8.2.4 Events

 

 

 

This option displays the Events window allowing you to add new events and to edit or delete existing
ones. Events added using this feature can be selected in the Event boxes on the main financial
screens and in numerous other locations throughout the program.



Menu Bar 201

© 2011 MLM Software Solutions, Inc.

8.2.5 Contacts

 
 

 
 

This option displays the Edit Categories window, allowing you make changes to your list of
categories and to records you have saved using those categories. Here is a brief description of the
options available in this window:

 
Add:  Allows you to add new Contact groups
Rename:  Allows you to rename existing groups and have all of the records associated with those
groups changed to the new name.
Move:  Allows you to move records from one Contact group to another.
Delete:  Allows you to delete an existing Contact group. Any contacts in that group will be moved
into the "Unfiled" group.  If you would like these contacts in a different group  it's usually best to
change them over to the new group  first, using the Move function, so that they don't end up in
"Unfiled" when the original group is deleted.

Note: Not all Contact groups can be renamed and deleted. If a group  does not show up in the
selection box for either of these two functions then it is a protected group  that the program requires
in order to function properly.

8.2.6 Calendar / Tasks

 
 



Consultant Front Office Version 11202

© 2011 MLM Software Solutions, Inc.

 

This option displays the Edit Categories window, allowing you make changes to your list of
categories and to records you have saved using those categories. Here is a brief description of the
options available in this window:

 
Add:  Allows you to add new Calendar / Task categories.
Rename:  Allows you to rename existing categories and have all of the records associated with
those categories changed to the new name.
Move:  Allows you to move records from one Calendar / Task category to another.
Delete:  Allows you to delete an existing Calendar / Task category. Any records that use the
deleted category will be moved into the "Unfiled" category. If you would like these records in a
different category it's usually best to change them over to the new category first, using the Move
function, so that they don't end up in "Unfiled" when the original category is deleted.

Note: Not all Calendar / Task categories can be renamed and deleted. If a category does not show up
in the selection box for either of these two functions then it is a protected category that the program
requires in order to function properly.

8.2.7 Memos

 

This option displays the Memo Categories window, and prompts you to enter a new Memo category
to be saved, or select an existing one to be deleted. Memo categories appear in the Filter box in the
Memos window..

8.3 Settings

8.3.1 Password
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This option displays the Password setup window, where you can specify whether or not the program
should be password protected and what password to use.

8.3.2 Owner Information

 

This option displays the Owner Information window allowing you to view and edit your personal
information, which is used for some reports and when creating invoices.
 

 

The company name you enter in this window should be your own personal company name, if you
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have one. You can also use the Title / Company field to enter "Independent Consultant" or some
other title that you would like to have appear on your invoices. To specify which entries from the 
Owner Information window are included on your invoices, click on the Invoices button on the Sales
screen, then click on Settings.

The name you enter in the Owner Information window is also the name that will be assigned to the
topmost member in the team views and reports.

Each active business has its own, unique Owner Information.

8.3.3 Preferences

 

This option displays the Preferences window allowing you to activate optional program features as
described below.

 

General
 

 
1. Start program on _______ - allows you to specify which main screen the program should go to at

startup.
2. Show confirmation window for _____ seconds – causes the program to display a window for the

specified amount of time confirming when transactions are recorded.
3. Automatically complete typing - causes the program to anticipate keyboard entries based on

previous input.
4. Show Tasks list notification at startup – causes the program to display a pop-up notice at startup

if you have Tasks tasks that are due
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5. Display backup prompt when closing – causes the program to ask you if you want to back up
your data every time the program is closed.

6. Include email and letters in auto backups – causes the program to include all of your saved and
sent emails when performing an auto backup at program startup

7. Check for scheduled emails – causes the program to check its list of scheduled emails at
program startup and send any that have come due

8. Check for program updates at Startup – causes the program to automatically check for program
updates each time it is started

9. Enter completed tasks in Contact Notes – causes the program to enter Task descriptions into a
contact’s Notes field whenever a task involving that contact is marked as completed.

10.Enter phone calls in Contact Notes – causes the program to enter the current date and the phone
number dialed into a contact’s Notes whenever you use the Auto Dialer to dial a contact’s phone
number.

11.Enter email subject in Contact Notes – causes the program to enter the email Subject into a
contact’s Notes whenever you send an email to a recipient selected using the Contacts button in
the Email window.

12.Enter letters printed into Contact Notes – causes the program to enter the current date and
"Letter printed" into a contact’s Notes whenever you print a letter with that contact selected using
the Select Recipients option on the File menu in the Letters window.

13.Enter appointments in Contact Notes – causes the program to enter the Appointment messages
into a contact’s Notes whenever an appointment involving that contact has been completed.

14.Enter labels in Contact Notes – causes the program to enter "Label printed" into a contact’s
Notes whenever a label is printed for that contact.

15.Screen Color - allows you to change the background color of the program’s primary screens.

 
 
Financial
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1. Check for duplicate Income and Expenses - causes the program to warn you if an Income or

Expense transaction you're entering has already been recorded.
2. Check for duplicate product transactions – causes the program to warn you if a Purchase, Sale,

Sample, Personal Use, Loan or Trade transaction you’re entering has already been recorded.
3. Require supporting entries for Expenses - forces you to enter supporting information for Travel,

Meals, Entertainment and Mileage expenses. If you already keep good written records indicating
the people, place and purpose associated with these deductions, you may be able to un-check
this box, to avoid having to re-enter the information when you record the deduction for financial
purposes.

4. Require purchases to be before withdrawals - causes the program to ensure that inventory is not
withdrawn before the date it was purchased. Un-checking this option simplifies inventory
management and does not compromise financial accuracy.

5. Always round up on purchases and sales – causes the program to always round discount, tax and
freight values up on these two screens, instead of rounding up or down based on a midpoint. Try
selecting this option if your percentage discount, or automatically entered tax or freight values, are
sometimes 0.01 less than shown on your purchase receipt.

6. Show warning when product is back logged - causes a message box to be displayed anytime you
record a product withdrawal for which there is insufficient inventory.

7. Show warning for minimum inventory levels - causes a message box to be displayed anytime you
record a product withdrawal that causes the inventory level of one or more products to fall below
your specified minimum level. A "minimum level" warning will not be displayed if a "backlog"
notice has already been shown. If the withdrawal transaction results in a product being
backlogged and if the option to "Show warning when product is backlogged" is selected, the
program will

8. Deposit Cash payments into Cash account - causes the program to automatically deposit all
payments you receive via cash (Income and Sales), into your Cash account.
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9. Deposit Cash payments into Check ing account – causes the program to automatically deposit all
payments you receive via cash (Income and Sales), into your Checking account.

10.Deposit Check payments into Check ing account – causes the program to automatically deposit
all payments you receive via check (Income and Sales), into your Checking account.

11.Deposit Credit / Debit payments into Check ing account - causes the program to automatically
deposit all payments you receive via credit or debit card (Income and Sales), into your Checking
account.

12.Deposit Electronic payments into Check ing account - causes the program to automatically
deposit all payments you receive electronically (Income and Sales) into your Checking account.

 

Regional
 

 
1. Switch postal code and city in labels and reports - reverses the printed positions of the City and

Zip fields, and eliminates the State field, in labels and address book reports.
2. Show Tax 1 column on Income and Expenses screens - instructs the program to display a column

for entering tax on the Income / Expenses screen. Tax entered  in this manner will be included in
the Sales Tax Summary report for the first tax rate entered into the program. This option will only
be available if you have previously indicated that your state, province or country charges sales tax
using the Settings button on the Edit Sales or Edit Purchases (full-inventory edition) screen.

3. Show Tax 2 column on Income and Expenses screens - instructs the program to display a column
for entering tax on the Income and Expenses screens. Tax recorded in this manner will be
included in the Sales Tax Summary report for the second tax rate entered into the program. This
option will only be available if you have previously indicated that your state, province or country
charges sales tax using the Settings button on the Edit Sales or Edit Purchases (full-inventory
edition) screen.
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8.4 Accounts

8.4.1 Cash

 
 

 

This option displays the Cash account register window showing all payments you made and received
in cash. The display can show all entries regardless of when they were entered or it can be limited to
the Current Time Period depending on the status of the checkbox at the top of the window.

This register also includes Cash payments you received that were entered with the "Deposit Cash
payments into Cash account" auto-deposit option selected in the Preferences window..

8.4.2 Checking
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This option displays the Checking account register window showing all payments you made and
received through your checking account. The display can show all entries regardless of when they
were entered or it can be limited to the Current Time Period depending on the status of the
checkbox at the top of the window.

This register also includes Cash, Check, Credit and / or Electronic payments you received that
were entered with their respective auto-deposit options selected in the Preferences window..

8.4.3 Credit Card

 



Consultant Front Office Version 11210

© 2011 MLM Software Solutions, Inc.

 

This option displays the Credit account register window showing all payments you made and
received using credit. The display can show all entries regardless of when they were entered or it can
be limited to the Current Time Period depending on the status of the checkbox at the top of the
window.

8.5 Samples

8.5.1 Summary

 

This option displays the Sample Summary window showing the quantity and value of products used
for promotional use. In the Basic, Standard and Professional editions, the value shown will be the
retail value of the products since the program does not know what you actually paid for each product.
In the "full-inventory" edition, the value will be your actual cost as recorded on the Purchases screen.
 

 

The display can show all entries regardless of when they were entered or it can be limited to the 
Current Time Period depending on the status of the checkbox at the top of the window.

8.5.2 Edit

 

This option displays the Edit Samples window showing an historical account of all samples
transactions.
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The display can show all entries regardless of when they were entered or it can be limited to the 
Current Time Period depending on the status of the checkbox at the top of the window. Clicking on
any entry, or on the numbered button at the start of each row, displays the Edit window allowing you
to modify or delete the selected record.

8.5.3 Withdrawals

This option displays the Samples window allowing you to create a record of product(s) used for a
promotional purpose.
 

 

To record a Samples record, just do the following:
.2.Click on the button at the right side of the Date box and select the date you used the

product(s). Dates can also be entered by typing directly into the box or using the Up and
Down arrow keys or the PgUp and PgDn keys to scroll one day or one week at a time
respectively.

.3.If the Sample occurred in connection with an Event, select the Event using the Event
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selection boxes or using the ellipsis (…) button to the right of the Event selection boxes.
The withdrawal will then be included in the Event Summary report on the Reports
screen. New events can be added using the ellipsis (…) button to the right of the Event
selection boxes.

.4.Select the product(s) you used by Item # or Description and adjust the quantity, then
click on Save to save the transaction.

Unlike personal use, the value of product(s) withdrawn for sample purposes is included in the Cost of
Goods Sold and hence is allowed as a deduction against income.

Full-Inventory Edition: Sample withdrawals are automatically removed from your existing inventory.
Withdrawals that are placed on backlog due to insufficient inventory will show a zero (0.00) Value
until the backlog is filled by a subsequent purchase.

8.6 Personal Use

8.6.1 Summary

 

This option displays the Personal Use Summary window showing the quantity and value of products
withdrawn for personal use purposes.
 

 

The display can show all entries regardless of when they were entered or it can be limited to the 
Current Time Period depending on the status of the checkbox at the top of the window.

 

 

8.6.2 Edit

 

This option displays the Edit Personal Use window showing an historical account of each personal
use transaction.
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The display can show all entries regardless of when they were entered or it can be limited to the 
Current Time Period depending on the status of the checkbox at the top of the window. Clicking on
any entry, or on the numbered button at the start of each row, displays the Edit window allowing you
to modify or delete the selected record.

8.6.3 Withdrawals

 

This option displays the Personal Use window allowing you to create a record of products used for
your own personal use.
 

 

To enter a Personal Use record just do the following:
1. Click on the button at the right side of the Date box and select the date you used the product(s).

Dates can also be entered by typing directly into the box or using the Up and Down arrow keys
or the PgUp and PgDn keys to scroll one day or one week at a time respectively.

2. If the Personal Use occurred in connection with an Event, select the Event using the Event
selection boxes or using the ellipsis (…) button to the right of the Event selection boxes. The
withdrawal will then be included in the Event Summary report on the Reports screen. New
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events can be added using the ellipsis (…) button to the right of the Event selection boxes.
3. Select the product(s) you used by Item # or Description and adjust the quantity, then click on

Save to save the transaction.

Unlike promotional samples, the cost of product withdrawn for personal use is not included in the
Cost of Goods Sold and hence is not allowed as a deduction against income. Personal Use
withdrawals are automatically removed from your existing inventory. Withdrawals that are placed on
backlog due to insufficient inventory will show a zero (0.00) Value until the backlog is filled by a
subsequent purchase.

8.7 Loans

8.7.1 Summary

 

This option displays the Loans summary window showing the quantity and value of products used  for
loan purposes. In the Basic, Standard and Professional editions, the value shown will be the retail
value of the products since the program does not know what you actually paid for each product. In the
"full-inventory" edition, the value will be your actual cost as recorded on the Purchases screen.
 

 

The display can show all entries regardless of when they were entered or it can be limited to the 
Current Time Period, depending on the status of the "Only show records within the Current Time
Period" checkbox at the top of the window.

8.7.2 Edit

 

This option displays the Edit Loans window showing an historical account of all Borrow and Loan
transactions.
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The display can show all entries regardless of when they were entered or it can be limited to the 
Current Time Period, depending on the status of the "Only show records within the Current Time
Period" checkbox at the top of the window.

Double clicking on any entry displays the Edit window allowing you to modify or delete the selected
record.

8.7.3 Borrow

This option displays the Borrowed Products window allowing you to create a record of product(s)
you borrowed from someone else.
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To create a Borrowed Products record, just do the following:
1. Click on the button at the right side of the Date box and select the date you borrowed the product

(s). Dates can also be entered by typing directly into the box or using the Up and Down arrow
keys or the PgUp and PgDn keys to scroll one day or one week at a time respectively.

2. Select the contact’s name from your list of contacts by clicking on the button at the right side of
the Customer box. Names can also be selected by typing directly into the box or using the Up
and Down arrow keys and the PgUp and PgDn keys to scroll one name or several names at a
time respectively.

3. If the borrow occurred in connection with an Event, select the Event using the Event selection
boxes or using the ellipsis (…) button to the right of the Event selection boxes. The borrow will
then be included in the Event Summary report on the Reports screen.

4. The Follow-Up Task boxes allow you to set a follow-up task to remind you about the borrowed
product. Tasks entered from this window will appear on the Tasks screen just as if they were
entered directly on that screen.

5. Select the borrowed product(s) by Item # or Description and adjust the quantity, then click on
Record to save the transaction.

 

Product that is borrowed is added to your inventory. Use the Edit option on the Loans menu to edit
records that have already been recorded and to remove borrowed product(s) from inventory. Borrowed
Products are ignored for income tax purposes and have no impact on the total value of your inventory.

8.7.4 Loans

 

This option displays the Loaned Products window allowing you to create a record of product(s) you
loaned to someone else.
 

 

To create a Loaned Products record, just do the following:
1. Click on the button at the right side of the Date box and select the date you loaned the product



Menu Bar 217

© 2011 MLM Software Solutions, Inc.

(s). Dates can also be entered by typing directly into the box or using the Up and Down arrow
keys or the PgUp and PgDn keys to scroll one day or one week at a time respectively.

2. Select the customer’s name from your list of contacts by clicking on the button at the right side of
the Customer box. Names can also be selected by typing directly into the box or using the Up
and Down arrow keys and the PgUp and PgDn keys to scroll one name or several names at a
time respectively.

3. If the loan occurred in connection with an Event select the Event using the Event selection boxes
or using the ellipsis (…) button to the right of the Event selection boxes. The loan will then be
included in the Event Summary report on the Reports screen. New events can be added using
the ellipsis (…) button to the right of the Event selection boxes.

4. The Follow-Up Task boxes allow you to set a follow-up task to remind you about the product
loan. Tasks entered from this window will appear on the Tasks screen just as if they were entered
directly on that screen.

5. Select the loaned product(s) by Item # or Description and adjust the quantity, then click on
Record to save the transaction.

 

Full-Inventory Edition: Product that is loaned out is withdrawn from your inventory (or placed on
backlog). Use the Edit option on the Loans menu to edit records that have already been recorded
and to return loaned product(s) to inventory. Loaned Products are ignored for income tax purposes
and have no impact on your Cost of Goods Sold.

8.8 Trades

8.8.1 Summary

 

This option displays the Trades summary window showing the quantity and value of products traded
(given and received).
 

 

The display can show all entries regardless of when they were entered or it can be limited to the 
Current Time Period, depending on the status of the Impose Current Time Period setting available
via the right-click menu. If you have received more of a particular product than you have traded away
then that product will be shown in black. If you have given away more than you have received it will be
shown in red.
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8.8.2 Edit

 

This option displays the Edit Trades window showing an historical account of all Trade transactions.
 

 

The display can show all entries regardless of when they were entered or it can be limited to the 
Current Time Period, depending on the status of the "Only

Double clicking on any entry displays the Product Trades window allowing you to modify or delete
the selected record

8.8.3 Record

 

This option displays the Product Trades window allowing you to create a record of product(s) you
traded with someone else.
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To create a Product Trade record, just do the following:
1. Click on the button at the right side of the Date box and select the date you traded the product(s).

Dates can also be entered by typing directly into the box or using the Up and Down arrow keys
or the PgUp and PgDn keys to scroll one day or one week at a time respectively.

2. Select the contact’s name from your list of contacts by clicking on the button at the right side of
the Customer box. Names can also be selected by typing directly into the box or using the Up
and Down arrow keys and the PgUp and PgDn keys to scroll one name or several names at a
time respectively.

3. If the trade occurred in connection with an Event, select the Event using the Event selection
boxes or using the ellipsis (…) button to the right of the Event selection boxes. The trade will then
be included in the Event Summary report on the Reports screen.

4. Enter a Note if you choose regarding the trade.
5. Select the product(s) you gave and received by Item # or Description and adjust the quantities

as appropriate.
6. Click on Record to save the transaction.

8.9 Help

8.9.1 Setup Wizard

 

This option displays the Purchase Settings (full-inventory edition only) and Sales Settings windows,
allowing you to configure the program in accordance with your specific business needs. Also displays
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the Preferences window. All of these windows and settings are available individually using the
Settings buttons on the Purchases and Sales screens and the Preferences option on the Settings
menu.

8.9.2 ReadMe File

 

This option displays a text document providing company-specific instructions for entering purchases
and sales. This option will not be visible if a company-specific file does not yet exist for your
company.

8.9.3 Help Topics

 

This option displays the Help Table of Contents. The easiest way to locate the Help Topic you are

looking for is usually to use the Help  buttons found throughout the program.

8.9.4 Training

 

This option starts your Internet browser and opens the training page on our website. The training page
has information on the various training options we make available as well as instructions explaining
how to submit a technical support request ticket.

8.9.5 Support

 

This option starts your Internet browser and opens our Support Center website. The Support Center
contains various support resources including our searchable Knowledgebase and a support ticket
system that allows you to submit support request tickets and  view your previously-submitted tickets.

 

Submitting a ticket requires that you first register with our system. To do this, click on Register in
the upper left corner of the Support Center home page and  fill out the short registration form, using
the same email address you used when you purchased the software. The password you enter can be
any password of your choosing.

 

If you have difficulty logging in after registering, please click on the "Need help logging in" link located
immediately below the Login button, for help in resolving your login problem.

 

To view our current support policy and determine whether you are eligible for free technical support
just click on the "Submit a Ticket" icon on the home page of our Support Center. Our current support
policy will be displayed on the page immediately following.

8.9.6 Release Notes

This option opens your web browser to a page on our website containing a list of the changes made in
the program each time it has been updated.
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8.9.7 Updates

 

This option checks for a newer program update and if found, prompts you to download and install it. If
you are an AOL user or if you experience difficulty using this function, try clicking on the Updates
Link option on the Help menu instead. This link takes you directly to the "Updates" page on our
website where you can download the latest program update manually instead. You can verify that an
update has been correctly installed by clicking on the About option on the Help menu and checking
the "Program Version" number.

 

Tip: If an update appears to install correctly but the version number in your program does not get
updated, the update may be getting applied to a second installation of the program on your
computer. If this occurs, try searching your computer’s hard drive for the file "CFO_v11.exe". If
more than one of these files is found, rename or delete the one that is not in the folder containing
your data, so that program updates do not "find" it when they are installed. If you accepted the
default location during program installation, you will want to keep the copy of CFO_v11.exe
which is in the folder: C:\Program Files\CFO11.

 

Please Note: These updates are "program updates" that fix bugs in the software and add
capabilities. These updates do not update the product information in your software. Whenever new
product information is available, MLM Software Solutions will contact you by email with instructions
for updating your product listing, using the Update Custom option on the File menu.

 

8.9.8 Updates Link

 

This option starts your Internet browser and opens the "Updates"  page on our website. This page
contains  links for downloading and installing the latest program update. This option can be used
whenever you experience problems using  the Updates option on the Help menu.

 

Please Note: These updates are "program updates" that fix bugs in the software and add
capabilities. These updates do not update the product information in your software. Whenever new
product information is available, MLM Software Solutions will contact you by email with instructions
for updating your product listing, using the Update Custom option on the File menu.

 

8.9.9 Ordering Info OR Program Comparison

 

This option displays a feature comparison of the Basic, Standard, Professional and Professional (full-
Inventory) editions of the program. If you’re having trouble deciding which program is right for you this
document should help. It includes pricing information and a list of the significant feature differences
between the various programs.

 

Once you've made up your mind which edition is right for you click on the Purchase option on the
Help menu for information on placing an order.
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8.9.10 Purchase OR Upgrade

 

 

 

This menu option displays the Program Licensing window allowing you to:
Purchase a license for the software
Request a licensing Key Code
License your installation by entering a  Key Code

Purchasing a License

To purchase a license for the software, please click on the Purchase option on the Help menu,
then click on the link that reads "Purchase a License" to go directly to our online ordering page.
To compare the various program editions prior to purchasing, please click on the Ordering Info
link on the Help menu in the program.

Requesting a Key Code to License a Demo Program

After submitting your order, click again on the Purchase option on the Help menu, then click
on the link that reads "Obtain a Key Code". This will take you to an online form where you can
submit your Key Code request. Key Code requests are responded to by live human beings in
as timely a manner as possible so please have patience if we don't respond immediately.

 

Entering a Key Code to License a Demo Program

Once we have responded with the correct Key Code for your installation, click again on the 
Purchase option on the Help menu, copy (CTRL C) and paste (CTRL V) the Key Code we sent
you into the Key Code box and click on OK. The program should respond with
"Congratulations" and a confirmation of your licensing level.
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Note: Reg Codes and their corresponding Key Codes change each time the program is
installed.  If you are installing from a CD, you will generally not need a Key Code, but if you are
installing on multiple computers using the downloaded demo, or if you reinstall the program
using the downloaded demo, you will need to request a new Key Code for each installation.

 

8.9.11 About

 

Displays the program’s About window and copyright notice.
 

 

The About window includes the program's full version number, your current licensing level, Palm
Sync Module licensing information and custom edition information if a custom edition has been
installed.
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9 Troubleshooting

9.1 Using Help

 

There are several ways to access online Help. The best method is to click on any of the Help  
buttons that can be found throughout the program. This will bring up context-sensitive help that is
specific to the area of the program you are working in. Context-sensitive help can also be accessed
at any time by pressing your F1 key. You can also activate Help by clicking on the Help Topics
option on the Help menu or by clicking on the yellow question mark just above the left side of the
main program toolbar.

 

The Help system has three views. The Contents organizes the help information according to the
different screens in the program. The Index and Search tabs allow you to search the Help system
for keywords or phrases pertaining to a specific topic.

 

Please remember that our website and online Knowledgebase have additional information that may be
helpful. To access the Training page on our website, click on the Training option on the Help menu.
To check our Knowledgebase or submit a support request ticket, click on the Support option on the
Help menu.

9.2 Training

Please click on the Training option on the Help menu to visit our online Training center. This page is
updated regularly whenever new training options become available.

9.3 Technical Support

Please click on the Support option on the Help menu for technical support assistance. This will
open your web browser to our online Support Center where you can submit tickets and view our
responses. You will need to register and log in, using your email address and a password of your
choosing, prior to submitting your first ticket.
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10 Purchasing and Upgrading

10.1 Feature Comparison

 

This option displays a feature comparison of the Basic, Standard, Professional and Professional (full-
Inventory) editions of the program. If you’re having trouble deciding which program is right for you this
document should help. It includes pricing information and a list of the significant feature differences
between the various programs.

 

Once you've made up your mind which edition is right for you click on the Purchase option on the
Help menu for information on placing an order.

10.2 Purchasing a License

 

 

 

This menu option displays the Program Licensing window allowing you to:
Purchase a license for the software
Request a licensing Key Code
License your installation by entering a  Key Code

Purchasing a License

To purchase a license for the software, please click on the Purchase option on the Help menu,
then click on the link that reads "Purchase a License" to go directly to our online ordering page.
To compare the various program editions prior to purchasing, please click on the Ordering Info
link on the Help menu in the program.
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Requesting a Key Code to License a Demo Program

After submitting your order, click again on the Purchase option on the Help menu, then click
on the link that reads "Obtain a Key Code". This will take you to an online form where you can
submit your Key Code request. Key Code requests are responded to by live human beings in
as timely a manner as possible so please have patience if we don't respond immediately.

 

Entering a Key Code to License a Demo Program

Once we have responded with the correct Key Code for your installation, click again on the 
Purchase option on the Help menu, copy (CTRL C) and paste (CTRL V) the Key Code we sent
you into the Key Code box and click on OK. The program should respond with
"Congratulations" and a confirmation of your licensing level.

Note: Reg Codes and their corresponding Key Codes change each time the program is
installed.  If you are installing from a CD, you will generally not need a Key Code, but if you are
installing on multiple computers using the downloaded demo, or if you reinstall the program
using the downloaded demo, you will need to request a new Key Code for each installation.
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